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Chapter 1lintroduction

1.1 Introduction

Congratulations on your purchase of this outstanding product: M2M Cellular Gateway. For M2M (Machine-to-
Machine) applications, AMIT M2M Cellular Gateway is absolutely the right choice. With built-in world-
class3G/4G/5G module(*!), you just need to insert SIM card from local mobile carrier to get to Internet. The
redundant SIM design provides a more reliable WAN connection for critical applications.By VPN tunneling
technology, remote sites easily become a part of Intranet, and all data are transmitted in a secure (256-bit AES
encryption) link

Main Features:

Compact design: Built-in LTE and configurable Ethernet WAN/LAN can provide Ethernet machine easy
connection to internet/intranet by LTE or high reliable fail-over wired/LTE connection.

High Speed: Built-inGiga LAN and 3G/4G/5G can provide high bandwidth application requirement.
Dual SIM: Embedded 3G/4G/5G with configurable dual-SIM achieve location free multi-ISP fail-over
requirement.

Versatile Cellular: Preferred service selection can simplify uplink setting; toolkit function of data usage
can control budget; configurable SMS command is useful and efficient for remote administration.
Complete Network: Built-in NAT/Port Forward/Routing/IPv6 are compatible to existing IP network.
Highly Security: Various VPN protocol & scenario can setup secure intranet; built-in Firewall & IPS
prevent malicious attacks; ACL & Authentication by MAC /User enhances secure access.

Flexible Administration: Web Ul is used for basic setting; programmable CLI and Command Script is
used for advanced configuration; system can be managed by NMS based on SNMP or TR-069.

Smart Event Handing: Mechanism to manage action for pre-defined events by administrator. Events
can be triggered or notified based on System/Interface status change, SMS, SNMP trap, or e-mail.
Expandable Design: Reserved USB together with SDK can expand design easily for special application
demand.

Before you install and use this product, please read this manual in detail for fully exploiting the functions of
this product.

1IDG500-0GTO1 for Terminal Block, and IDG500-0G501 for DC Jack.
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1.2 Contents List

1.2.1 Package Contents
#Standard Package

_ltems ______ Descripton _____________ Contents ______ Quantity

. gl
2 Cellular Antenna _ 4pcs
3 RJ45 Cable w:": 1pcs
o Tk E
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1.3 Hardware Configuration

1.3.1 IDG500-0GTO1 Variant

> Left View

LAN1/W LAN2 PWR/G 5GAnten
AN ND na

> RightView

Reset Button

5GAntenn SIM-A SIM-B 5GAntenn
a a

5GAntenn
a

s%Reset Button
The RESET button provides user with a quick and easy way to restore the default setting. Press the RESET
button continuously for 10 ~ 15 seconds, and then release it. The device will restore to factory default settings.
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1.3.2 IDG500-0G501 Variant

> Left View

LAN1/W LAN2 5GAnten PWR
AN na

> RightView

Reset Button

5GAntenn SIM-A SIM-B 5GAntenn
a a

5GAntenn
a

s%Reset Button
The RESET button provides user with a quick and easy way to restore the default setting. Press the RESET
button continuously for 10 ~ 15 seconds, and then release it. The device will restore to factory default settings.
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1.4 LED Indication

=l ahilic
-Em - M2M Cellular Gateway

Blue in flash (per second): Device works normally.
Red in very fast flash: Device is in Recovery Mode or abnormal.

Green:
Off: Host disconnected.

:Z::E:‘ gz::ér?lue or Green On: Ethernet connection established.
Green in Flash: Data packet transferred via Ethernet.
Note: If you encountered the abnormal situation, even power OFF / ON the device, there might be
something wrong during the device boot up session and it was damaged. You need to call for RMA
service to recover it.
When LED : 5G/4G LTE Signal Strength Uplink Type
Blue : Module is in 5G Mode
Red: Module isin 4G LTE Mode
Green :Ethernet Port
Behavior of Blue LED (5G connection):
WAN Uplink Red or e Dark: SIM doesn’t detect
Status Blue o Flash (Fast):Weak Signal, RSRP < -104 dbm

¢ Flash (Slow, per 1.5~2 second):Middle Signal, RSRP = -104~ -93 dbm

e Steady On:Strong Signal, RSRP =<- 92 dbm
Behavior of Red LED (4G connection):

e Dark: SIM doesn’t detect

o Flash (Fast):Weak Signal, RSCP < -102 dbm

o Flash (Slow, per 1.5~2 second):Middle Signal, RSCP = -102 ~ -91 dbm

e Steady On:Strong Signal, RSCP =<- 90 dbm

10
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1.5 Installation& MaintenanceNotice

1.5.1 SYSTEM REQUIREMENTS

Network Requirements .

An Gigabit Ethernet RJ45cable or DSL modem
3G/4G/5G cellular service subscription
10/100/1000 Ethernet adapter on PC

Computer with the following:

Windows®, Macintosh, or Linux-based operating

system
e Aninstalled Ethernet adapter
Browser Requirements:
. Internet Explorer 6.0 or higher
e  Chrome 2.0 or higher
e  Firefox 3.0 or higher
e  Safari 3.0 or higher

Web-based Configuration Utility Requirements

1.5.2 WARNING

4 :

~

Only use the power adapter that comes with the
package. Using a different voltage rating power
adaptor is dangerous and may damage the product.
® Do not open or repair the case yourself. If the
Attention product is too hot, turn off the power immediately
and have it repaired at a qualified service center.

® Place the product on a stable surface and avoid

using this product and all accessories outdoors.

\_ J

11
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Federal Communication Commission Interference Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee
that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct
the interference by one of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from thattowhich the receiver isconnected.
- Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could void the

user's authority to operate this equipment.
This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

FOR PORTABLE DEVICE USAGE (<20m from body/SAR needed)

Radiation Exposure Statement:

The product comply with the FCC portable RF exposure limit set forth for an uncontrolled environment and are safe for
intended operation as described in this manual. The further RF exposure reduction can be achieved if the product can be
kept as far as possible from the user body or set the device to lower output power if such function is available.

FOR MOBILE DEVICE USAGE (>20cm/low power)

Radiation Exposure Statement:
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20cm between the radiator & your body.

FOR COUNTRY CODE SELECTION USAGE (WLAN DEVICES)

Note: The country code selection is for non-US model only and is not available to all US model. Per FCC regulation, all
WiFi product marketed in US must fixed to US operation channels only.

12
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1.5.3 HOT SURFACE CAUTION

Burn hazard.

Hot surface inside.

Allow to cool before
servicing.

CAUTION: The surface temperature for the metallic enclosure can be very high!
Especially after operating for a long time, installed at a closed cabinet
without air conditioning support, or in a high ambient temperature
space.

DO NOT touch the hot surface with your fingers while servicing!!

13
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1.5.4 Product Information for CE RED Requirements

The following product information is required to be presented in product User Manual for latest CE RED

requirements.2

(1) Frequency Band & Maximum Power
1.a Frequency Band for Cellular Connection (for ME3630 E1C version)®

Band number

Operating Frequency

Max output power

LTE FDD BAND 1

Uplink:1920-1980 MHz
Downlink:2110-2170 MHz

LTE FDD BAND 3

Uplink:1710-1785 MHz
Downlink:1805-1880 MHz

LTE FDD BAND 7

Uplink:2500-2570 MHz

Downlink:1805-1880 MHz

+
Downlink:2620-2690 MHz 23 £2.7dBm
LTE FDD BAND 8 Uplink:880-915 MHz
Downlink:925-960 MHz
LTE FDD BAND 20 Uplink:832-862 MHz
Downlink:791-821 MHz
WCDMA BAND 1 Uplink:1920-1980 MHz
Downlink:2110-2170 MHz
24 +1/-3 dB
WCDMA BAND 8 Uplink:880-915 MHz /-3 dBm
Downlink:925-960 MHz
E-GSM Uplink:880-915 MHz
+
Downlink:925-960 MHz 33 £2dBm
DCS Uplink:1710-1785 MHz 30 +24Bm

1.b Frequency Band for Cellular Connection (for EC25-E version)

Band number

Operating Frequency

Max output power

LTE FDD BAND 1

Uplink:1920-1980 MHz

Downlink:2110-2170 MHz 231 dBm
AR | pownlink975.960 mHe 232 dBim
LTE FDD BAND 20 Uplink:832-862 MHz 23.5dBm

2 The information presented in this section is ONLY valid for the EU/EFTA regional version.For those non-CE/EFTA versions, please
refer to the corresponding product specification.

3There can be different cellular module intrgrated in the device for EU/EFTA regional version. Refer to the cellular module identifier
printed on the device label for the purchased device.

14
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Downlink:791-821 MHz
LTE FDD BAND 38 Uplink:  2570-2620 MHz

Downlink: 2570-2620 MHz 21.7 dBm
LTE FDD BAND 40 Uplink:  2300-2400 MHz

Downlink: 2300-2400 MHz 21.5 dBm
WCDMA BAND 1 Uplink:1920-1980 MHz

Downlink:2110-2170 MHz
WCDMA BAND 8 Uplink:880-915 MHz 23.3 dBm

Downlink:925-960 MHz
E-GSM Uplink:880-915 MHz

Downlink:925-960 MHz 32.9 dBm
DCS Uplink:1710-1785 MHz

Downlink:1805-1880 MHz 29.9 dBm

(2) DoC Information
You can get the DoC information of this product from the following URL:
http://www.amitwireless.com/products-doc/

(3) RF Exposure Statements
The antenna of the product, under normal use condition, is at least 20 cm away from the body of user.

(4) Unit Mounting Notice
The product is suitable for mounting at heights <= 2m (approx. 6 ft), or in a cabinet.
Ensure the unit is fixed tightly to reduce the likelyhood of injury due to exposure to mechanical hazards if
dropped.

(5) Manufacture Information

Manufacture Name: AMIT Wireless Inc.
Manufacture Address: No. 28, Lane 31, Sec. 1, Huandong Rd., Xinshi Dist., Tainan 74146, Taiwan (R.0.C.)

15
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1.6 Hardware Installation

This chapter describes how to install and configure the hardware

1.6.1Mount the Unit

ThelDG500 series products can be placed on a desktop, or mounted on the wall.

1.6.2Insert the SIM Card

WARNING: BEFORE INSERTING OR CHANGING THE SIM CARD, PLEASE MAKE SURE THE
GATEWAY IS POWERED OFF.

The SIM card slots are located at the right side of IDG500series housing in order to protect the SIM card. You
need to unscrew and remove the outer SIM card cover before installing or removing the SIM card. Please
follow the instructions to insert or eject a SIM card. After SIM card is well placed, screw back the outer SIM
card cover.

Step 1: Step 2: Step 3:

Loosen the screws as Push the SIM card Push the inserted SIM card
below and remove the into the slot A (SIM- again to eject it from the
SIM cover. A) or slot B (SIM-B). SIM slot.

16
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1.6.3 Install the External Antenna

As illustrated in Section 1.3, there are several SMA antenna Jacks for you to install the required antennas for
the RF signal transmission and receiving. You may have to purchase required RF cables and antennas

separately for a specific project or installation site to get excellent RF performance.

Since there is limited spacing for allocating all SMA antenna Jacks around the enclosure, the separation among
SMA Jacks (or direct-attached antennas) could be not the optimized arrangement. It is very likely to get
degraded RF performance at specific circumstances. It depends heavily on the environment.

However, there are well-known rules of thumb for solving the antenna separation issue.

1: The horizontal distance between antennas should be greater than 1/4 of its wavelength, and there will be
best separation at 1/2 of its wavelength.

2. If multiple frequency antennas are near each other, then use spacing distance of the lower frequency
antenna, or even better try to satisfy the rule for both frequencies.

Wavelength Table for Major RF Category

RF Category Frequency Wavelength 1/2 Wave Len.gth 1/4 Wave Len.gth

(Best Separation) (Good Separation)
WiFi 802.11 5.8GHz 5.2cm 2.6cm 1.3cm
WiFi 802.11 2.4GHz 12.5cm 6.2cm 3.1cm
Celllular LTE 2600MHz 11.5cm 5.8cm 2.9cm
Cellular LTE 2100MHz 14.3cm 7.1cm 3.7cm
Cellular LTE 900MHz 33.3cm 16.6cm 8.3cm
Cellular LTE 700MHz 42.8cm 21.4cm 10.7cm
GPS 1.57GHz 19.0cm 9.5cm 4.7cm

For example, if you have a 900MHz LTE antenna and a WiFi 2.4GHz antenna, you would want them to be
separated by at least 8.3cm to get good antenna separation.

So, it is recommended to use some external RF cables to extend and separate the adjacent antennas and get
better antenna separation and RF performance, if required.

17
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1.6.4Connecting to the Network or a Host

The IDG500-0Gx01 series productsprovide two RJ45 port to connect 10/100/1000Mbps Ethernet. It can auto
detect the transmission speed on the network and configure itself automatically. Connect one Ethernet cable
to the RJ45 port (LAN) of the device and plug another end of the Ethernet cable into your computer’s network
port. In this way, you can use the RJ45 Ethernet cable to connect the device to the host PC’s Ethernet port for
configuring the device.

1.6.5 Setup by Configuring WEB Ul

You can browse web Ul to configure the device.

Type in the IP Address (http://192.168.123.254)"

€ Windows Internet Explorer

() [e] 19216812325 - x|

When you see the login page, enter the user name and password and then click ‘Login’ button.
The default setting for both username and password is ‘admin’.

Welcome to the device's configuration Ul.
Enter your Username & Password, then
click "Login'.

Username

Password
|
[—

For the security consideration, you will be asked to change the login password while the first
time login to the device.

4 The default LAN IP address of this gateway is 192.168.123.254. If you change it, you need to login by using
the new IP address.
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Change Password

For security consideration, you are being asked to change the password
while the first time login to the device.

Enter the new password below.

(NOTE: The password must be at least 10 characters long, and must contain at
least 1 English letter and 1 number. The password cannot be the same as the
login account.)

New Password:

MNew Password Confirmation:

T < =)
'_ 1

After that, you will be asked to login again with the new password.

Note 1: Keep the login password properly for further device configuration.

Note 2: If, someday, you lose or forget the login password, the ONLY way to remedy is to
recover the device to its factory default settings via long-pressing the Reset button.

Note 3: Under such situation, your device configuration will be erased accordingly. So, In
addition to keep the login password, you may have to backup the device
donfiguration and keep it properly for any unexpected accidence.
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Chapter 2 Basic Network

2.1 WAN& Uplink

[ wang uplink |

Physical Interface -

Internet Setup

WAN-1

Loading Balance
WAN-2

Interface Name

Connection Setup m

Physical Interface Operation Mode Action
Cellular(5G/LTE) Always on
] Disable

The gateway provides multiple WAN interfaces to let all client hosts in Intranet of the gateway access the

Internet via ISP. But ISPs in the world apply various connection protocols to let gateways or user's devices dial
in ISPs and then link to the Internet via different kinds of transmit media.

So, the WAN Connection lets you specify the WAN Physical Interface, WAN Internet Setup and WAN Load
Balance for Intranet to access Internet. For each WAN interface, you must specify its physical interface first
and then its Internet setup to connect to ISP. Besides, since the gateway has multiple WAN interfaces, you can
assign physical interface to participate in the Load Balance function.
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2.1.1 Physical Interface

Physical Interface

Physical
Interface List Interface Name Physical Interface Operation Mode WAN Type Action

N WAN-1 Cellular(5G/LTE) Always on Cellular Edit
-

1 setect WAN-2 - Disable - Edit
Physical
Interface
i -
Select
Arayaon o4 Item Setting
% » WAN Type Cellular v

M2M gateways are usually equipped with various WAN interfacess to support different WAN connection
scenario for requirement. You can configure the WAN interface one by one to get proper internet connection
setup. Refer to the product specification for the available WAN interfaces in the product you purchased.

The first step to configure one WAN interface is to specify which kind of connection media to be used for the
WAN connection, as shown in "Physical Interface" page.

In "Physical Interface" page, there are two configuration windows, "Physical Interface List" and "Interface
Configuration". "Physical Interface List" window shows all the available physical interfaces. After clicking on
the "Edit" button for the interface in "Physical Interface List" window the "Interface Configuration" window
will appear to let you configure a WAN interface.

Physical Interface:

« Ethernet WAN: The gateway has one or more RJ45 WAN portsthat can be configured to be WAN
connections. You can directly connect to external DSL modem or setup behind a firewall device.

+ Cellular WAN: The gateway has onebuilt-in5GNR modemas WAN connection. For each cellularWAN, there
are 1 or 2 SIM cards to be inserted for special failover function.

(" )

® PleaseMUST POWER OFF the gateway before you
' insert or remove SIM card.

® The SIM card can be damaged if you insert or

remove SIM card while the gateway is in operation. )
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Operation Mode:
There are three option items “Alwayson”, “Failover”

, and “Disable” for the operation mode setting.

Alwayson:Set this WAN interface to be active all the time. When two or more WAN are established at "Always
on" mode, outgoing data will through these WAN connections base on load balance policies.

Failover:

Diagram For Failover

s

(D))

@Dlsconnected

. 'WAN-1
ISP-DSLAM

) Failover
WAN-2 Gateway

(R /
Cellular /& @ Change Routing to WAN-2

“WAN-2 Failover WAN1

D LB

(5) Failback to WAN-1|

@«

Cellular ‘xf

WAN-2 Gateway

(B WAN-2 Terminate Connection

WAN-1
Physical Interface: Ethernet
Operation Mode: Always on

WAN-2
Physical Interface: 3G/4G
Operation Mode: Failover (WAN-1)

"WAN-1 Failback, WAN-2 Terminate

Seamless Failover:

Diagram For Seamless Failover

| @Dlsconnected
) ‘ WAN-1

ISP-DSLAM
®@ Fallover

(D)

WAN-2 Gateway

Cellular,(& @ change Routing to WAN-2

*WAN-2 Failover WAN1

DL\

(5) Failback to WAN-1

(V)

Cellular ‘x_

@ Keep alive, no traffic

"WAMN-1 Failback, WAN-2 Keep Alive

A failover interface is a backup connection to the
primary. That means only when its primary WAN
connection is broken, the backup connection will be
started up to substitute the primary connection.

As shown in the diagram, WAN-2 is backup WAN for
WAN-1. WAN-1 serves as the primary connection with
operation mode "Always on". WAN-2 won’t be
activated untilWAN-1disconnected. When WAN-
lconnection is recovered back with a connection, it
will take over data traffic again. At that time, WAN-2
connection will be terminated.

In addition, there is a "Seamless" option for Failover
operation mode. When seamless option is activated
by checking on the "Seamless" box in configuration
window, both the primary connection and the
failover connection are started up after system
rebooting. But only the primary connection executes
the data transfer, while the failover one just keeps
alive of connection line. As soon as the primary
connection is broken, the system will switch,
meaning failover, the routing path to the failover
connection to save the dial up time of failover
connection since it has been alive.

When the “Seamless” enable checkbox is activated, it
can allow the Failover interface to be connected
continuously from system booting up. Failover WAN
interfacejust keeps connecting without data traffic.

The purpose is to shortenthe switch time during failover process. So, whenprimary connection is
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disconnected, failover interface will take over the data transfer mission instantly by only changing routing
path to the failover interface. The dialing-up time of failover connection is saved since it has been
connected beforehand.

VLAN Tagging

Sometimes, your ISP required a VLAN tag to be inserted into the WAN packets from Gateway for specific
services. Please enable VLAN tagging and specify tag in the WAN physical interface. Please be noted that only
Ethernet and ADSL physical interfaces support the feature. For the device with 3G/4G/5G WAN only, it is
disabled.
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Physical Interface Setting

Go to Basic Network>WAN >Physical Interfacetab.

The Physical Interfaceallows user to setup the physical WAN interface and to adjust WAN’s behavior.

Note: Numbers of available WAN Interfaces can be different for the purchased gateway.

%1 Internet Connection List

Interface Name Physical Interface Operation Mode WAN Type Action
WAN-1 Cellular(5G/LTE) Always on Cellular

WAN-2 ; Disable -

When Edit button is applied, an Interface Configuration screen will appear. WAN-1 interface is used in this
example.

Interface Configuration:

#| Interface Configuration { WAN-1 )

Item Setting
» Physical Interface  Ethernet v |
» Operation Mode
» VLAN Tagging () Enablel0 | (1-4095)

Interface Configuration
Item Value setting Description
Select one expected interface from the available interface dropdown list.It

1. A Must fill settin
& can be Cellular, or Etherent.

. 2. WAN-1 is the primar
Physical Interface P y Depending on the gateway model, Disable and Failover options will be

interface and is factory . . .

available only to multiple WAN gateways. WAN-2 ~ WAN-n interfaces are
set to Always on. ] .

only available to multiple WAN gateways

Define the operation mode of the interface.
Select Always on to make this WAN always active.
Operation Mode A Must fill setting Select Disable to disable this WAN interface.
Select Failover to make this WAN a Failover WAN when the primary or the

secondary WAN link failed. Then select the primary or the existed
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VLAN Tagging Optional setting

secondary WAN interface to switch Failover from.

(Note: for WAN-1, only Always on option is available.)

Check Enable box to enter tag value provided by your ISP. Otherwise
uncheck the box.

Value Range:1 ~ 4095.

Note: This feature is NOT available for Cellular WAN connection.
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2.1.2Connection Setup

Internet Setup

Internet
Connection List

# |Internet Connection List

Interface Name Physical Interface Operation Mode WAN Type Action
WAN-1 Cellular(5G/LTE) Always on Cellular
WAN-2 - Disable -

Internet Connect
Configure (WAN-x

xxx WAN Type
Configuration

# Internet Connection Configuration { WAN-1)

Item Setting

» WAN Type Cellular v

= Cellular WAN Type Configuration °
Item Setting

» Preferred SIM Card SIM-A First v | Failback: [} Enable

» Auto Flight Mode (] Enable

» SIM Switch Policy Policy Setting

After specifying the physical interface for each WAN connection, administrator must configure their
connection profile to meet the dial in process of ISP, so that all client hosts in the Intranet of the gateway can

access the Internet.

In "Connection Setup" page, there are some configuration windows: "Internet Connection List", "Internet
Connection Configuration", "WAN Type Configuration" and related configuration windows for each WAN type.
For the Internet setup of each WAN interface, you must specify its WAN type of physical interface first and

then its related parameter configuration for that WAN type.

After clicking on the "Edit" button of a physical interface in "Internet Setup List" window, the "Internet
Connection Configuration" window will appear to let you specify which kind of WAN type that you will use for
that physical interface to make an Internet connection. Based on your chosen WAN type, you can configure
necessary parameters in each corresponding configuration window.
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Internet Connection List - Ethernet WAN

= Intermnet Connection Configuration { WAN -1 ) e
Item Setting
Internet Connection List =
» WAN Type [Dynamic 1P = |
Static IP
= Dynamic IP WAN Type Confi Dynamic IP =
FPFoE
Item PPTF Setting
Internet Connect » Host Name L2TF ] toptienan
Configure -
. f&gﬁg'smmd MAC | | [ clone | (optionar)
i Auto-reconnect v
( WAN Type= > » Connection Control [ J
» MTU Setup ) Enable
DynamicIP » NAT ¥ Enable
Static IP -
PPPoE r IGMP Disable »
L2TP : » WAN IP Alias [ Enable [10.0.0.1 |
PPTP : L4 Setup — -
XXX WAN Type = Network Monitoring Configuration -
Configuration Item Setting
+ Network Monitoring # Enable
L4 Setup Configuration
Ethernet Connection » Checking Method DNS Query ¥
Common Configure + Loading Check @ Enable
» Query Interval [s | (seconds)
b:‘ » Latency Threshold [3000 | (ms)

WAN Type for Ethernet Interface:
Ethernet is the most common WAN and uplink interface for M2M gateways. Usually it is connected with xDSL
or cable modem for you to setup the WAN connection. There are various WAN types to connect with ISP.

» Static IP: Select this option if ISP provides a fixed IP to you when you subsribe the service. Usually is more
expensive but very importat for cooperate requirement.

* Dynamic IP: The assigned IP address for the WAN by a DHCP server is different every time. It is cheaper
and usually for consumer use.

* PPP over Ethernet: As known as PPPoE. This WAN type is widely used for ADSL connection. IP is usually
different for every dial up.

e PPTP:This WAN type ispopular in some countries, like Russia.

* L2TP :This WAN type ispopular in some countries, like Israel.

Configure Ethernet WAN Setting

When Edit button is applied,Internet Connection Configuration screen will appear. WAN-1 interface is used in
this example.
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WAN Type = Dynamic IP

# Internet Connection Configuration { WAN -1)

Item

Setting

F WAN Type

' Dynamic IP v |

When you select it, "Dynamic IP WAN Type Configuration" will appear. Items and setting is explained below

* Dynamic IP WAN Type Configuration

ltem Setting
¥ Host Name | | {Optional)
ISP Registered MAC .
K
Address | | | Clone | (Optional)

Dynamic IP WAN Type Configuration

Item
Host Name

Value setting
An optional setting

Description
Enter the host name provided by yourService Provider.

ISP Registered MAC
Address

An optional setting

Enter the MAC address that you have registered with your service provider.
Or Click the Clone button to clone your PC’'s MAC to this field.

Usually this is the PC’'s MAC address assigned to allow you to connect to
Internet.

WAN Type= Static IP
# Internet Connection Configuration { WAN -1)

Item

Setting

F WAN Type

| Static IP

v |

When you select it, "Static IP WAN Type Configuration" will appear. Items and setting is explained below

« Static IP WAN Type Configuration a

Item

Setting

F WAN IP Address

F WAN Subnet Mask

1255255 255 0 (124)

]

F WAN Gateway

¥ Primary DNS

¢ Secondary DNS

{Optional)
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Static IP WAN Type Configuration

Item Value setting Description

WAN IP Address A Must filled setting Enter the WAN IP address given by your Service Provider

WAN Subnet Mask A Must filled setting Enter the WAN subnet mask given by your Service Provider

WAN Gateway A Must filled setting Enter the WAN gateway IP address given by your Service Provider
Primary DNS A Must filled setting Enter the primaryWAN DNS IP address given by your Service Provider
Secondary DNS An optional setting Enter the secondaryWAN DNS IP address given by your Service Provider

WAN Type= PPPoE

# Internet Connection Configuration ( WAN -1

ltem Setting

» WAN Type | PPPoE v
When you select it, "PPPoE WAN Type Configuration" will appear. Items and setting is explained below

* PPPoE WAN Type Configuration ’

ltem Setting

b IP Type IPvd v

¥ PPPoE Account

» PPPoE Password

¥ Primary DNS | | (Optional)
+ Secondary DNS | | {Optional)
F Service Name | | {Optional)
» Assigned IP Address | | (Optional)
PPPoE WAN Type Configuration
Item Value setting Description
PPPoE Account A Must filled setting Enter the PPPoE User Name provided by your Service Provider.
PPPoE Password A Must filled setting Enter the PPPoE passwordprovided by your Service Provider.
Primary DNS An optional setting Enter the IP address of Primary DNS server.
Secondary DNS An optional setting Enter the IP address of Secondary DNS server.
Service Name An optional setting Enter the service name if your ISP requires it
Assigned IP Address An optional setting Enter the IP address assigned by your Service Provider.
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WAN Type= PPTP

# Internet Connection Configuration { WAN -1 )

Item

Setting

F WAN Type

| PPTP

v

When you select it, "PPTP WAN Type Configuration" will appear. Items and setting is explained below

= PPTP WAN Type Configuration ’

Item

Setting

» IP Mode

' Dynamic IP Address v |

¥ Server IP Address / Name |

¥ PPTP Account

» PPTP Password

¥ Connection ID

{Optional)

» MPPE

(] Enable

PPTP WAN Type Configuration

Item

Value setting

Description
Select either Static or Dynamic IP address for PPTP Internet connection.
[ ) When Static IP Address is selected, you will need to enter the WAN IP
Address, WAN Subnet Mask, and WAN Gateway.
[ | WAN IP Address(A Must filled setting):Enter the WAN IP
address given by your Service Provider.

IP Mode A Must filled setting [ | WAN Subnet Mask(A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
B WAN Gateway(A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
®  When Dynamic IP is selected, there are no above settings required.
Server IP A Must filled setting Enter the PPTP server name or IP Address.
Address/Name
PPTP Account A Must filled setting Enter the PPTP username provided by your Service Provider.

PPTP Password

A Must filled setting

Enter the PPTP connection password provided by your Service Provider.

Connection ID

An optional setting

Enter a name to identify the PPTP connection.

MPPE

An optional setting

Select Enable to enable MPPE(Microsoft Point-to-Point Encryption) security
for PPTP connection.
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WAN Type= L2TP
# Internet Connection Configuration { WAN -1 )

Item

Setting

F WAN Type

[L2TP

v

When you select it, "L2TP WAN Type Configuration" will appear. Iltems and setting is explained below

« L2TP WAN Type Configuration ’

Item

Setting

kP Mode

| Dynamic IP Address v |

¥ Server IP Address / Name

¥ L2TP Account

¥ L2TP Password

b Service Port

| User-defined

v | 1702 |

» MPPE

[ Enable

L2TP WAN Type Configuration

Item

Value setting

Description
Select either Static or Dynamic IP address for L2TP Internet connection.
[ ) When Static IP Address is selected, you will need to enter the WAN IP
Address, WAN Subnet Mask, and WAN Gateway.
B WAN IP Address(A Must filled setting):Enter the WAN IP
address given by your Service Provider.

IP Mode A Must filled setting [ | WAN Subnet Mask(A Must filled setting): Enter the WAN
subnet mask given by your Service Provider.
[ | WAN Gateway(A Must filled setting): Enter the WAN gateway
IP address given by your Service Provider.
[J When Dynamic IP is selected, there are no above settings required.
Server IP A Must filled setting Enter the L2TP server name or IP Address.
Address/Name
L2TP Account A Must filled setting Enter the L2TP username provided by your Service Provider.
L2TP Password A Must filled setting Enter the L2TPconnection password provided by your Service Provider.

Service Port

A Must filled setting

Enter the service port that the Internet service.
There are three options can be selected :
®  Auto:Port will be automatically assigned.
(] 1701 (For Cisco): Set service port to port 1701 to connect to
CISCO server.
() User-defined: enter a service port provided by your Service
Provider.

MPPE

An optional setting

Select Enable to enable MPPE(Microsoft Point-to-Point Encryption) security
for PPTP connection.
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Ethernet Connection Common Configuration

\I.r Select
Connection

Control

Setup

*MTU
*MAT Enable?

Yes
lp Select

*DMNS Query
“ICMP Checking

-L Setup

*Loading Check?
*Check Interval
*Check Timeout
*Latency Threshold
*Fail Threshold
*Target 1

*Target 2

Enable
IGMP Enable?
WAM IP Alias?

S

¥ Connection Control

Auto-reconnect

» MTU Setup Enable
» NAT #| Enable
r IGMP Disable
» WAN IP Alias

Item

Enable [10.0.0.1

Setting

L NetworkMoniorng | g enave

» Checking Methed DNS Query v

+ Loading Check # Enable

» Query Interval 5 (seconds)
» Latency Thresheld 3000 (ms)

+ Fail Thresheld 5 (Times)

» Target1 DNS1 v

» Target2 None v

There are some important parameters to be setup no matter which Ethernet WAN type is selected. You should
follow up the rule to configure.

Connection Control.

3 —(u

(D Disconnected

Gateway

(@ Re-connecting
Auto-reconnect

(@ Start Connecting

ISP-DSLAM
Q@ ‘. """""" 55 €

(8 Disconnect when idle timeout?

Connect-on-demand
(DRequest

Gateway

—

) \oiook ook

oming

Auto-reconnect: This gateway will establish
Internet connection automatically once it has
been booted up, and try to reconnect once the
connection is down. It’s recommended to choose
this scheme if for mission critical applications to
ensure full-time Internet connection.

Connect-on-demand: This gateway won’t start to
establish Internet connection until local data is
going to be sent to WAN side. After normal data
transferring between LAN and WAN sides, this
gateway will disconnect WAN connection if idle
time reaches value of Maximum Idle Time.
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ISP-DSLAM @ Start Connecting

Manually

Gateway

(@) Disconnect when idle timeout

(D Connect Button

Manually: This gateway won’t start to establish
WAN connection until you press “Connect”
button on web Ul. After normal data transferring
between LAN and WAN sides, this gateway will
disconnect WAN connection if idle time reaches
value of Maximum Idle Time.

Please be noted, if the WAN interface serves as the primary one for another WAN interface in Failover role,
the Connection Control parameter will not be available to you to configure as the system must set it to “Auto-

reconnect (Always on)”.

Network Monitoring

Start

“Check Loading
Enable?

Wait for

“Check Interval”

Loading Yes
Enough?

No Select One

alive checking
H *FQDN Query or
*ICMP Check

Ll

“Checking
Timeout"”?

Yes Yes I

Reply Time
= "Latency™

A

Fail = Fail +1

Fail >
Fail Thresh ?

Yes

Exception Handing
System Re-initial

It is necessary to monitor connection status continuous.
To do it, "ICMP Check" and "FQDN Query" are used to
check. When there is trafiic of connection, checking
packet will waste bandwidth. Response time of replied
packets may also increase. To avoid "Network
Monitoring"  work  abnormally, enabling"Checking
Loading" option will stop connection check when there is
traffic. It will wait for another "Check Interval" and then
check loading again.

When you do “Network Monitoring”, if reply time longer
than "Latency" or even no response longer than
"Checking Timeout", "Fail" count will be increased. If it is
continuous and "Fail" count is more than "Fail Threshold",
gateway will do exception handing process and re-initial
this connection again . Otherwise, network monitoring
process will be start again.
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Set up “Ethernet Common Configuration”

Connection Control

Maximum Idle Time

MTU Setup

MTU Setup

NAT

IGMP

WAN IP Alias

A Must filled setting

1. An Optional setting
2. By default 600
seconds is filled-in

1. An Optional setting
2. Uncheck by default

1. A Must filled setting

2. Auto (value zero) is
set by default

3. Manual set range
1200~1500

1. An optional setting

2. NAT is enabled by
default

1. A Must filled setting
2. Disable is set by
default

1. An optional setting
2. Uncheck by default

There are three connection modes.
° Auto-reconnectenables the router to always keep the Internet
connection on.
° Connect-on-demand enables the router to automatically re-
establish Internet connection as soon as user attempts to access

the Internet. Internet connection will be disconnected when it has

been inactive for a specified idle time.

° Connect Manually allows user to connect to Internet manually.
Internet connection will be inactive after it has been inactive for
specified idle time.

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the 3G/4G/5Gconnection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

When set to Auto (value ‘0’), the router selects the best MTU for best
Internet connection performance.

Enable NAT to apply NAT on the WAN connection. Uncheck the box to
disable NAT function.

Enable IGMP (Internet Group Management Protocol) would enable the
router to listen to IGMP packets to discover which interfaces are connected
to which device. The router uses the interface information generated by
IGMP to reduce bandwidth consumption in a multi-access network
environment to avoid flooding the entire network.

Enable WAN IP Alias then enter the IP address provided by your service
provider.

WAN IP Alias is used by the device router and is treated as a second set of
WAN IP to provide dual WAN IP address to your LAN network.
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Item Setting
» Network Monitoring ¥ Enable
Configuration
¥ Checking Method ||:-"NS Query v |
» Loading Check @ Enable

» Query Interval (seconds)
¢ Latency Threshold (ms)

b Fail Threshold (Times)

» Targeti

» Target?2

Network Monitoring Configuration

Item Value setting Description
o 1. An optional setting Check the Enable box to activate the network monitoring function.

Network Monitoring .
Configuration 2. Box is checked by

default

Choose either DNS Queryor ICMP Checking to detect WAN link.

1. AnOptional setting WithDNS Query,thesystem checks the connection bysending DNS Query
Checking Method 2. DNS Query is set by packets to the destination specified in Target 1 and Target 2.

default WithICMP Checking,thesystem will check connection by sending ICMP

request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is to
prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Queryor
ICMP checkingpackets.

WithDNS Query, thesystem checks the connection bysending DNS Query
packets to the destination specified in Target 1 and Target 2.

Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Queryor
ICMP checkingpackets.

WithICMP Checking, thesystem will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
beforedisconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
beforedisconnection is acknowledged.

Fail Thresholdspecifies the detected disconnection before the router
recognize the WAN link down status.

1. An optional setting
Loading Check 2. Box is checked by
default

1. AnOptional setting
Query Interval 2.5 seconds is selected
by default.

1. AnOptional setting
Check Interval 2.5 seconds is selected
by default.

1. AnOptional setting
Latency Threshold 2.3000 ms is set by
default

1. AnOptional setting
Fail Threshold 2.5 times is set by
default
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Target 1

Target 2

Save
Undo

1. AnOptional filled
setting

2. DNS1 is selected by
default

1. AnOptional filled
setting

2. None is selected by
default

N/A
N/A

Value Range: 1 ~ 10 times.

Target1 specifies the first target of sending DNS query/ICMP request.
DNS1: set theprimary DNS to be the target.

DNS2: set thesecondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Target1 specifies the second target of sending DNS query/ICMP request.

None: no second target is required.

DNS1: set theprimary DNS to be the target.

DNS2: set thesecondary DNS to be the target.
Gateway: set the Current gateway to be the target.
Other Host: enter an IP address to be the target.
Click Save to save the settings.

Click Undo to cancel the settings.
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Internet Connection — Cellular WAN

Edit

Internet Connect List

Internet Connect
Configure

% Internet Connection Configuration { WAN-2 ) -

[tem

Setting

» WAN Type

Cellular v

[tem

& Cellular WAN Type Configuration -

Setting

Cellular WAN Type
Configuration

L4 Setup

SIM-A/ SIM-B
APN Profile List

lRepeatAdded'rt

APN Profile-x

SIM-A/B APN
Profile Configuration

Cellular Connection
Common Configure

Preferred SIM Card — Dual SIM Fail Over

¥ Preferred SIM Card

SIM-AFirst v| Faiback: [] Enable

+ Auto Flight Mode

(] Enable

r SIM Switch Policy

Policy Setting

Configure « Connection with SIM-A Card
5|M'A,-f SIM-B - onnecion ar n

# Connection with SIM-B Card n

= Cellular Connection Common Configuration -

[tem

Setting

b Connection Control

[ Auto-reconnect v

» Time Schedule (0) Always v
» MTU Setup "] Enable

¥ IP Passthrough (Cellular Bridge)

[ Enable Fixed MAC

» WAT Enable
 1GMP
¥ WAN IF Alias (7] Enable 10.0.0.1

For Cellular embedded device,one embedded cellular module can create only one WAN interface. This device

has featured by using dual SIM cards for one module with special fail-over mechanism. It is called Dual SIM

Failover. This feature is useful for ISP switch over when location is changed. Within “Dual SIM Failover”, there
are various usage scenarios, including "SIM-A First", "SIM-B First“ with “Failback” enabled or not, and “SIM-A

Only and “SIM-B Only”.
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SIM-A/SIM-B only: When “SIM-A Only” or “SIM-B Only” is used, the specified SIM slot card is the only one to
be used for negotiation parameters between gateway device and cellular ISP.

SIM-A / SIM-B first without enable Failback

By default, “SIM-A First” scenario is used to connect to cellular ISP fordata
transfer. In the case of “SIM-A First” or “SIM-B First” scenario, the

(((g) 6 % ()  sateway will try to connect to the Internet by using SIM-A or SIM-B card
|

“Disconnected gpy.a

first. And when the connection is broken, the gateway will switch to use
the other SIM card for an alternate automatically and will not switch back
to use original SIM card except current SIM connection is also broken.
That is, SIM-A and SIM-B are used iteratively, but either one will keep
being used for data transfer when current connection is still alive.

Connected
1552 Not back to SIM-A

SIM-A / SIM-B first with Failback enable
With Failback option enabled, “SIM-A First” scenario is

Disconnected SIM-A
((( ))) 5|MA ((( ») Ready LL(( ) used to connect when the connection is broken, gateway
‘ M I system will switch to use SIM-B. And when SIM-A
f " e connection is recovered, it will switch back to use original
ISP1 SIM-A card
(« )
/A¢Connected
ISPZ
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Configure Cellular WAN Setting

When Edit button is applied,Internet Connection Configuration, and Cellular WAN Configurationscreens will

appear.

Item

F WAMN Type

Item

» Preferred SIM Card
r Auto Flight Mode
¥ SIM Switch Policy

WAN Type

Preferred SIM Card

Auto Flight Mode

Cellular »

Setting

Setting

SIM-A First w | Failback: [_| Enable

(] Enable

| Policy Setting |

1.A Must filled setting
2.Cellular is set by
default.

1. A Must filled setting
2. By default SIM-A First
is selected

3. Failback is unchecked
by default

The box is unchecked by
default

From the dropdown box, selectinternet connection method for Cellular
WAN Connection. Only Cellular is available.

Choose which SIM card you want to use for the connection.

When SIM-A First or SIM-B First is selected, it means the connection is built
first by using SIM A/SIM B. And if the connection is failed, it will change to
the other SIM card and try to dial again, until the connection is up.

When SIM-A only or SIM-B only is selected, it will try to dial up only using
the SIM card you selected.

When Failback is checked, it means if the connection is dialed-up not using
the main SIM you selected, it will failback to the main SIM and try to
establish the connection periodically.

Note_1: For the product with single SIM design, only SIM-A Only option is
available.

Note_2: Failback is available only when SIM-A First or SIM-B First is
selected.

Check the Enable box to activate the function.

By default, if you disabled the Auto Flight Mode, the cellular module will
always occupy a physical channel with cellular tower. It can get data
connection instantly, and receive managing SMS all the time on required.
If you enabled the Auto Flight Mode, the gateway will pop up a message
“Flight mode will cause cellular function to be malfunctioned when the
data session is offline.”, and it will make the cellular module into flight
mode and disconnected with cellular tower phycially. In, addition,
whenever the cellular module is going to be used for data connection to
backup the failed primary connection, the cellular module will be active to
connect with cellular tower and get the data connection for use, It takes
few more seconds.

Note: Keep it unchecked unless your cellular ISP asked the connected
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gateway to enable the Auto Flight Mode.
Click the Policy Setting button to define the SIM Switch policy or browse
the current policy settings.

SIM Switch Policy NA

= Policy Setting

Item

Setting

v Failed connection

D (1-10) times

+ RSSI Monitor

[ Enable Threshold: - 0

{(-90~-113 dBm)

r Network Service

[] Enable Loss LTE signal:

0

{1~30 minutes)

+ Roaming Service

(] Enable Timeout: ()

(1~30 minutes)

Configure SIM-A / SIM-B Card

Here you can set configurations for the cellular connection according to your situation or requirement.

= Connection with SIM-A Card -

item Setting
b Network Type
+ Dial-Up Profile | Manual-configuration v
» APN | |
» PIN Code | | (Optional)
+ Dial Number | | (Optional)
» Account | | (Optional)
v Password | D>/ (Optional)
» Authentication
» IP Mode
b Primary DNS | | (Optional)
» Secondary DNS | | (Optional)
* Roaming [] Enable

Note_1: Configurations of SIM-B Card follows the same rule of Configurations of SIM-A Card, here we list SIM-
A as the example.

Note_2: Both Connection with SIM-A Card and Connection with SIM-B Card will pop up only when the SIM-A
First or SIM-B First is selected, otherwise it only pops out one of them.

Connection with SIM-A/-B Card

Item Value setting
Network Type 1. A Must filled setting

Description
Select Auto to register a network automatically, regardless of the network
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Dial-Up Profile

APN

IP Type

PIN code

Dial Number,
Account,
Password

Authentication

IP Mode

2. By default Auto is
selected

1. A Must filled setting
2. By default Manual-
configuration is selected

1. A Must filled setting
2. String format : any
text

1. A Must filled setting
2. By default IPv4 is
selected

1. An Optionalsetting
2. String format :
interger

1. AnOptional setting
2. String format : any
text

1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. By default Dynamic IP
is selected

type.

Select 2G Only to register the 2G network only.

Select 2G Prefer to register the 2G network first if it is available.
Select 3G only to register the 3G network only.

Select 3G Prefer to register the 3G network first if it is available.
Select LTE only to register the 4G network only.

Note: Options may be different due to the specification of the module.
Specify the type of dial-up profile for your cellular network. It can be
Manual-configuration, APN Profile List, or Auto-detection.

Select Manual-configuration to set APN (Access Point Name), Dial Number,
Account, and Password to what your carrier provides.

Select APN Profile List to set more than one profile to dial up in turn, until
the connection is established. It will pop up a new filed, please go to Basic
Network > WAN& Uplink> Internet Setup > SIM-A APN Profile List for
details.

Select Auto-detection to automatically bring out all configurations needed
while dialing-up, by comparing the IMSI of the SIM card to the record listed
in the manufacturer’s database.

Note_1: You are highly recommended to select the Manual or APN Profile
List to specify the network for your subscription. Your ISP alwaysprovides
such network settings for the subscribers.

Note_2:If you select Auto-detection, it is likely to connect to improper
network, or failed to find a valid APN for your ISP.

Enter the APN you want to use to establish the connection.

This is a must-filled setting if you selected Manual-configuration as dial-up
profile scheme.

Specify the IP type of the network serveice provided by your cellular
network. It can be IPv4, IPv6, or IPv4/6.

Enter the PIN (Personal Identification Number) code if it needs to unlock
your SIM card.

Enter the optional Dial Number, Account, and Password settings if your ISP
provided such settings to you.

Note: These settings are only displayed when Manual-configuration is
selected.

Select PAP (Password Authentication Protocol) and use such protocol to be
authenticated with the carrier’s server.

Select CHAP (Challenge Handshake Authentication Protocol) and use such
protocol to be authenticated with the carrier’s server.

When Auto is selected, it means it will authenticate with the server either
PAP or CHAP.

When Dynamic IP is selected, it means it will get all IP configurations from
the carrier’s server and set to the device directly.

If you have specific application provided by the carrier, and want to set IP
configurations on your own, you can switch to Static IP mode and fill in all
parameters that required, such as IP address, subnet mask and gateway.

Note: IP Subnet Mask is a must filled setting, and make sure you have the
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right configuration. Otherwise, the connection may get issues.

1. An Optional setting Enter the IP address to change the primary DNS (Domain Name Server)
Primary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

1. An Optional setting Enter the IP address to change the secondary DNS (Domain Name Server)
Secondary DNS 2. String format : IP setting. If it is not filled-in, the server address is given by the carrier while

address (IPv4 type) dialing-up.

Check the box to establish the connection even the registration status is
The box is unchecked by  roaming, not in home network.

Roaming default

Note: It may cost additional charges if the connection is under roaming.

Create/Edit SIM-A / SIM-B APN Profile List

You can add a new APN profile for the connection, or modify the content of the APN profile you added. It is
available only when you select Dial-Up Profile as APN Profile List.

= SIM-A APN Profile List LN

Profile

ID
Name

APN IP Type Account | Password | Authentication | Priority | Enable Actions

List all the APN profile you created, easily for you to check and modify. It is available only when you select
Dial-Up Profile as APN Profile List.

When Add button is applied, an APN Profile Configurationscreen will appear.

= SIM-A APN Profile Configuration

Item Setting
» Profile Name |Profile-1 |
b APN | |
» IP Type
» Account | | (Optional)
¢ Password | D| (Optional)
¥ Authentication
» Priority [ ]
» Profile ] Enable

SIM-A/-B APN Profile Configuration

Item Value setting Description
1. By default Profile-x is Enter the profile name you want to describe for this profile.
Profile Name listed
2. String format : any text
APN String format : any text Enter the APN you want to use to establish the connection.
1. A Must filled setting Specify the IP type of the network serveice provided by your cellular
IP Type 2. By default IPv4 is network. It can be IPv4, IPv6, or IPv4/6.
selected
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Account

Password

Authentication

Priority

Profile

Save

Undo

String format : any text

String format : any text
1. A Must filled setting
2. By default Auto is
selected

1. A Must filled setting
2. String format : integer

The box is checked by
default

N/A

N/A

Enter the Account you want to use for the authentication.
Value Range:0 ~53 characters.

Enter the Password you want to use for the authentication.
Select the Authentication method for the cellular connection.
It can be Auto, PAP, CHAP, or None.

Enter the value for the dialing-up order. The valid value is from 1 to 16. It
will start to dial up with the profile that assigned with the smallest number.

Value Range:1 ~ 16.
Check the box to enable this profile.
Uncheck the box to disable this profile in dialing-up action.

Click the Save button to save the configuration.
Click the X button to restore what you just configured back to the previous
setting.

Setup Cellular Connection Common Configuration

Here you can change common configurations for Cellular WAN.

ltem

b Connection Contro

F Time Schedule

¥ MTU Setup [(] Enable

v IP Passthrough (Cellular Bridge)| (] Enable Fixed MA
F NAT Enable

b IGMP

F WAN IP Alias

Connection Control

Maximum Idle Time

Setting

| Auto-reconnect

W

(0) Always »

(] Enable 10.0.0.

By default Auto-
reconnect is selected

1. AnOptional setting

2. By default 600seconds

1

When Auto-reconnect is selected, it means it will try to keep the Internet
connection on all the time whenever the physical link is connected.
When Connect-on-demand is selected, it means the Internet connection
will be established only when detecting data traffic.

When Connect Manually is selected, it means you need to click the
Connect button to dial up the connection manually. Please go to Status
>Basic Network> WAN & Uplinktab for details.

Note:If the WAN interface serves as the primary one for another WAN
interface in Failover role( and vice versa), the Connection Control
parameter will not be available on both WANs as the system must set it to
“Auto-reconnect”

Specify the maximum Idle time setting to disconnect the internet
connection when the connection idle timed out.
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Time Schedule

MTU Setup

IP Pass-through
(Cellular Bridge)

NAT
IGMP

WAN IP Alias

Item

F Network Monitoring
Configuration

k Checking Method
¥ Loading Check

¥ Query Interval

b Latency Threshold
¥ Fail Threshold

+ Targeit

k Target2

Network Monitoring
Configuration

Checking Method

is filled-in

1. A Must filled setting
2. By default (0) Always
is selected

1. AnOptional setting
2. Uncheck by default

1. The box is unchecked
by default

2. String format for Fixed
MAC:

MAC address, e.g.
00:50:18:aa:bb:cc

Check by default

By default Disable is
selected

1. Unchecked by default
2. String format: IP
address (IPv4 type)

DNS Query +
Enable

I n
m
=
ik}
(=
[15]

0oo [

E

5)

DNSA1 v

MNone w

1. An optional setting
2. Box is checked by
default

1. AnOptional setting
2. DNS Query is set by
default

(Times)

Value Range: 300 ~ 86400.

Note: This field is available only when Connect-on-demand or Connect
Manually is selected as the connection control scheme.

When (0) Always is selected, it means this WAN is under operation all the
time. Once you have set other schedule rules, there will be other options to
select. Please go to Object Definition> Scheduling for details.

Check the Enable box to enable the MTU (Maximum Transmission Unit)
limit, and specify the MTU for the cellular connection.

MTU refers to Maximum Transmission Unit. It specifies the largest packet
size permitted for Internet transmission.

Value Range: 1200 ~ 1500.

When Enable box is checked, it means the device will directly assign the
WAN [P to the first connected local LAN client.

However, when an optional Fixed MAC is filled-in a non-zero value, it
means only the client with this MAC address can get the WAN IP address.

Note: When the IP Pass-through is on, NAT and WAN IP Alias will be
unavailable until the function is disabled again.

Uncheck the box to disable NAT (Network Address Translation) function.
Select Auto to enable IGMP function.

Check the Enable box to enable IGMP Proxy.

Check the box to enable WAN IP Alias, and fill in the IP address you want to
assign.

Setting

(seconds)

Check the Enable box to activate the network monitoring function.

Choose either DNS Queryor ICMP Checking to detect WAN link.
WithDNS Query,thesystem checks the connection bysending DNS Query
packets to the destination specified in Target 1 and Target 2.

WithICMP Checking,thesystem will check connection by sending ICMP
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Loading Check

Query Interval

Check Interval

Latency Threshold

Fail Threshold

Target 1

Target 2

Save
Undo

1. An optional setting
2. Box is checked by
default

1. AnOptional setting
2. 5 seconds is selected
by default.

1. AnOptional setting
2. 5 seconds is selected
by default.

1. AnOptional setting
2.3000 ms is set by
default

1. AnOptional setting
2.5 times is set by
default

1. AnOptional filled
setting

2. DNS1 is selected by
default

1. AnOptional filled
setting

2. None is selected by
default

N/A
N/A

request packets to the destination specified in Target 1 and Target 2.
Check the Enable box to activate the loading check function.

Enable Loading Check allows the gateway to ignore unreturned DNS
queries or ICMP requests when WAN bandwidth is fully occupied. This is to
prevent false link-down status.

Specify a time interval as the DNS Query Interval.

Query Interval defines the transmitting interval between two DNS Queryor
ICMP checkingpackets.

WithDNS Query, thesystem checks the connection bysending DNS Query
packets to the destination specified in Target 1 and Target 2.

Value Range: 2 ~ 14400.

Specify a time interval as the ICMP Checking Interval.

Query Interval defines the transmitting interval between two DNS Queryor
ICMP checkingpackets.

WithICMP Checking, thesystem will check connection by sending ICMP
request packets to the destination specified in Target 1 and Target 2.
Value Range: 2 ~ 14400.

Enter a number of detecting disconnection times to be the threshold
beforedisconnection is acknowledged.

Latency Threshold defines the tolerance threshold of responding time.
Value Range: 2000 ~ 3000 seconds.

Enter a number of detecting disconnection times to be the threshold
beforedisconnection is acknowledged.

Fail Thresholdspecifies the detected disconnection before the router
recognize the WAN link down status.

Value Range: 1 ~ 10 times.

Target1 specifies the first target of sending DNS query/ICMP request.
DNS1: set theprimary DNS to be the target.

DNS2: set thesecondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Targetl specifies the second target of sending DNS query/ICMP request.
None: no second target is required.

DNS1: set theprimary DNS to be the target.

DNS2: set thesecondary DNS to be the target.

Gateway: set the Current gateway to be the target.

Other Host: enter an IP address to be the target.

Click Save to save the settings.

Click Undo to cancel the settings.
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2.2 LAN & VLAN

This section provides the configuration of LAN and VLAN. VLAN is an optional feature, and it depends on the
product specification of the purchased gateway.

2.2.1 Ethernet LAN

3

xDSLand,or
4G Cellular

The Local Area Network (LAN) can be
used to share data or files among

computers attached to a network.
Ethernet LAM

Please follow the following instructions to do IPv4 Ethernet LAN Setup.

¥ P Mode

b LAM P Address

¥ Subnet Mask

IP Mode

LAN IP
Address

Subnet Mask

Static P

Following diagram illustrates the
network that wired and interconnects
computers.

Setting

192168123254

255.255.255.0 (/24) v

N/A

1. A Must filled setting
2.192.168.123.254 is set by
default

1. A Must filled setting
2.255.255.255.0 (/24) is set

It shows the LAN IP mode for the gateway according the related configuration.
Static IP: If there is at least one WAN interface activated, the LAN IP mode is
fixed in Static IP mode.

Dynamic IP: If all the available WAN inferfaces are disabled, the LAN IP mode
can be Dynamic IP mode.

Enter the local IP address of this device.

The network device(s) on your network must use the LAN IP address of this
device as their Default Gateway. You can change it if necessary.

Note: /t’s also the IP address of web Ul. If you change it, you need
to type new IP address in the browser to see web UI.

Select the subnet mask for this gateway from the dropdown list.

Subnet mask defines how many clients are allowed in one network or subnet.
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by default The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 IP
addresses are allowed in this subnet. However, one of them is occupied by LAN
IP address of this gateway, so there are maximum 253 clients allowed in LAN

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.252 (/30).

Save N/A Click the Savebutton to save the configuration
Click the Undobutton to restore what you just configured back to the previous
setting.

Undo N/A

Create / Edit Additional IP

This gateway provides the LAN IP alias function for some special management consideration. You can add
additional LAN IP for this gateway, and access to this gateway with the additional IP.

= Additional IP " "

1D Name Interface IP Address Subnet Mask Enable Action

When Add button is applied,Additional IP Configuration screen will appear.

= Additional IP Configuration ' a

Item Setting
» Mame | |
» Interface
» IP Address | |
» Subnet Mask 1255.255.255.0 (124) v |
» Enahle (]

Configuration

Item Value setting Description
Name .1 An Optional Setting Enter the name for the alias IP address.
1. A Must filled settin
Interface & Specify the Interface type. It can be lo or br0.

2. lo is set by default

1. AnOptional setting

IP Address 2.192.168.123.254 is set by  Enter the addition IP address for this device.
default
Select the subnet mask for this gateway from the dropdown list.
1. A Must filled setting Subnet mask defines how many clients are allowed in one network or subnet.
Subnet Mask 2.255.255.255.0 (/24) isset  The default subnet mask is 255.255.255.0 (/24), and it means maximum 254 |P
by default addresses are allowed in this subnet. However, one of them is occupied by LAN

IP address of this gateway, so there are maximum 253 clients allowed in LAN
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Save NA

network.
Value Range: 255.0.0.0 (/8) ~ 255.255.255.255 (/32).

Click the Savebutton to save the configuration
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2.2.2VLAN

VLAN (Virtual LAN) is a logical network under a certain switch or router device to group client hosts with a
specific VLAN ID. This gateway supports both Port-based VLAN and Tag-based VLAN.These functions allow you
to divide local network into different “virtual LANs”. It is common requirement for some application scenario.
For example,there are various departments within SMB. All client hosts in the same department should own
common access privilege and QoS property. You can assign departments either by port-based VLAN or tag-
based VLAN as a group, and then configure it by your plan. In some cases, ISP may need router to support
“VLAN tag” for certain kinds of services (e.g. IPTV). You can group all devices required this service as one tag-
based VLAN.

If the gatewayhas only one physical Ethernet LAN port, only very limited configuration is available if you
enable the Port-based VLAN.

> Port-based VLAN

Port-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~
VAP-8, together for differentiated services like Internet surfing, multimedia enjoyment, VolP talking, and so on.
Two operation modes, NAT and Bridge, can be applied to each VLAN group. One DHCP server can be allocated
for a NAT VLAN group to let group host member get its IP address. Thus, each host can surf Internet via the
NAT mechanism of business access gateway. In bridge mode, Intranet packet flow is delivered out WAN trunk
port with VLAN tag to upper link for different services.

VLAN Group 1 NAT
= = Wireless Network s (
Fa k. J N\ WiFi E T s
IQ/\? D/(’:!:} / ',"D wr Bridge peLMed \Ei'g}
. __,/ £ 7,

\Uf

T Wireless Network

T T T ] y

Seeog | @ | ...

\ Wired Netwerk

! T J

S

Wired Netwerk

A port-based VLAN is a group of ports on an Ethernet or Virtual APs of Wired or Wireless Gateway that form a
logical LAN segment. Following is an example.

For example, in a company, administrator schemes out 3 network segments, Lobby/Meeting Room, Office,
and Data Center. In a Wireless Gateway, administrator can configure Lobby/Meeting Room segment with
VLAN ID 3. The VLAN group includes Port-3 and VAP-8 (SSID: Guest) with NAT mode and DHCP-3 server
equipped. He also configure Office segment with VLAN ID 2. The VLAN group includes Port-2 and VAP-1 (SSID:
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Staff) with NAT mode and DHCP-2 server equipped. At last, administrator also configure Data Center segment
with VLAN ID 1. The VLAN group includes Port-1 with NAT mode to WAN interface as shown in following

diagram.

Wireless Gateway ()

\ @ xDSL and/or

4G Cellular

E 3
VLANID 1 % %

S Ponasts [ Pere

m
@ Data Center 3
®
VID1: 34
DHCP Server: DHCP-1
VID2:
DHCP Server: DHCP-2
VID3:
DHCP Server: DHCP-3 @ Office Network  /

VLANID 2

Above is the general case for 3 Ethernet LAN ports in the gateway. But if the device just has one Ethernet LAN
port, there will be only one VLAN group for the device. Under such situation, it still supports both the NAT and
Bridge mode for the Port-based VLAN configuration.

» Tag-based VLAN

Tag-based VLAN function can group Ethernet ports, Port-1 ~ Port-4, and WiFi Virtual Access Points, VAP-1 ~
VAP-8, together with different VLAN tags for deploying subnets in Intranet. All packet flows can carry with
different VLAN tags even at the same physical Ethernet port for Intranet. These flows can be directed to
different destination because they have differentiated tags. The approach is very useful to group some hosts
at different geographic location to be in the same workgroup.

Tag-based VLAN is also called a VLAN Trunk. The VLAN Trunk collects all packet flows with different VLAN IDs
from Router device and delivers them in the Intranet. VLAN membership in a tagged VLAN is determined by
VLAN ID information within the packet frames that are received on a port. Administrator can further use a
VLAN switch to separate the VLAN trunk to different groups based on VLAN ID. Following is an example.
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VLAN Group 1

= = Wireless Network WiFi

Internet|
xDSL Modem -
WiFi

Wireless Network

For example, in a company, administrator schemes out 3 network segments, Lab, Meeting Rooms, and Office.
In a Security VPN Gateway, administrator can configure Office segment with VLAN ID 12. The VLAN group is
equipped with DHCP-3 server to construct a 192.168.12.x subnet. He also configure Meeting Rooms segment
with VLAN ID 11. The VLAN group is equipped with DHCP-2 server to construct a 192.168.11.x subnet for
Intranet only. That is, any client host in VLAN 11 group can’t access the Internet. At last, he configures Lab
segment with VLAN ID 10. The VLAN group is equipped with DHCP-1 server to construct a 192.168.10.x subnet.

Gateway VID10 :
DHCP Server : DHCP-1{192.168.10.x)
VID11 :
DSL and/or \D.-':-In(n::z server: DHCP-2({192.168.11.x)
AG Cellular )

DHCP Server: DHCP-3(192.168.12.x)
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» VLAN Groups Access Control

Administrator can specify the Internet access permission for all VLAN groups. He can also configure which
VLAN groups are allowed to communicate with each other.

VLAN Group Internet Access

Administrator can specify members of one VLAN group to be able to access Internet or not. Following is an
example that VLAN groups of VID is 2 and 3 can access Internet but the one with VID is 1 cannot access
Internet. That is, visitors in meeting room and staffs in office network can access Internet. But the
computers/servers in data center cannot access Internet since security consideration. Servers in data center
only for trusted staffs or are accessed in secure tunnels.

Wireless Gateway )

@ Office Network

: VLANID 2
VLANID 2
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Inter VLAN Group Routing:

In Port-based tagging, administrator can specify member hosts of one VLAN group to be able to communicate
with the ones of another VLAN group or not. This is a communication pair, and one VLAN group can join many
communication pairs. But communication pair doesn’t have the transitive property. That is, A can
communicate with B, and B can communicate with C, it doesn’t imply that A can communicate with C. An
example is shown at following diagram. VLAN groups of VID is 1 and 2 can access each other but the ones
between VID 1 and VID 3 and between VID 2 and VID 3 can’t.

Wireless Gateway )

xDSL and/or
4G Cellular

VLANID 1

@ Office Network

VLANID 2

VLANID 2
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VLAN Setting

Go to Basic Network >LAN & VLAN>VLAN Tab.

The VLAN function allows you to divide local network into different virtual LANs. There are Port-based and
Tag-based VLAN types. Select one that applies.

Item

» WLAN Types

» Systermn Reserved VLAR 1D

VLAN Type

System
Reserved
VLAN ID

Save

FPort-based v

Start 1D 1

Port-based is selected by

default

(1-4081) ~ End ID [5

Setting

Select the VLAN type that you want to adopt for organizing you local subnets.

Port-based:Port-based VLANallows you to add rule for each LAN port, and you
can do advanced control with its VLAN ID.
Tag-based: Tag-based VLANallows you to add VLAN ID, and select member and
DHCP Server for this VLAN ID. Go to Tag-based VLAN List table.

Specify the VLAN ID range that is reserved for the system operation. For the

Port-based/Tag-based VLAN grouping, only use the ID outside the reserved

1~ 5is reserved by default

NA

range.

Value Range: 1 ~ 4091.

Click the Savebutton to save the configuration

Port-based VLAN - Create/Edit VLAN Rules

The port-based VLAN allows you to custom each LAN port. There is a default rule shows the configuration of all
LAN ports. Also, if your device has a DMZ port, you will see DMZ configuration, too. The maxima rule numbers
is based on LAN port numbers.

Add

Delete

Name VLAN ID T%Siﬂg NAT / Bridge Port Members LAN IP Address Subnet Mask Joined WAN WAN VID Enable | Actions
OME 40584 i AT DMz Port 192168.6.254 28524852550 AR -1 0 Edit
LAr MHative WLAM X MAT Detail 192168123254 285265 2550 AlNWANS 0 Edit

Apply | InterYLAN Group Routing

When Add button is applied, Port-based VLAN Configuration screen will appear, which is including 3 sections:
Port-based VLAN Configuration, IP Fixed Mapping Rule List, and Inter VLAN Group Routing (enter through a

button)
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Port-based VLAN - Configuration

» Mame

» WVLAN D

» WLAN Tagging
v MAT { Bridge
» Port Members
» LAN ta Join

Name

VLAN ID

VLAN Tagging

NAT / Bridge

Port Members

LAN to Join

Save

Undo

Item

LAN

Setting

Mative YLAMN

Disable v

NAT

Port ) Port-1 ) Fort-2

Enahble

1. A Must filled setting
2. String format: already
have default texts

A Must filled setting

Disable is selected by
default.

NAT is selected by default.
These boxesare unchecked
by default.

The box is unchecked by
default.

NA

NA

OHCP 1 v

Define the Name of this rule. It has a default text and cannot be modified.

Define the VLAN ID number, range is 1~4094.
The rule is activated according to VLAN ID and Port Members configuration
when Enable is selected.

The rule is activated according Port Members configuration when Disable is
selected.

Select NAT mode or Bridge mode for the rule.

Select which LAN port(s) and VAP(s) that you want to add to the rule.

Note: The available member list can be different for the purchased product.
Check the Enable box and select one of the defined DHCP Server for the List to
define the DHCP server for the VLAN group.

If you enabled this function, all the rest settings will be greyed out, not required
to configured manually.

Click the Savebutton to save the configuration

Click the Undobutton to restore what you just configured back to the previous

setting.

If you didn’t decide to bind the VLAN group to a pre-defined DHCP server, you have to further specify the
following settings.
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Subnet Mask

WAR & WWARN YID to Join
LAM IP Address

AlVWANS v

one

192.168.123 254
255.255.255.0 (124) v

» DHCP Server f Relay Server v
» DHCP Server Name DHCP 1
Starting Address: 192,168,123 100
» 1P Poal )
Ending Address: 192 168,123 200
» Lease Time 800 seconds
» Domain Marme (Optional)
¥ Primary DNS (Optional)
» Secondary DNS (Optional)
» Primary WINGS [(Cptional)
» Secondary WINS [(Cptional)
» Gateway {Optional)
» Enable
WAN & WAN All WANs is selected by Select which WAN or All WANSs that allow accessing Internet.
VID to Join default. Note: If Bridge mode is selected, you need to select a WAN and entera VID.
LAN IP ) . Assign an IP Address for the DHCP Server that the rule used, this IP address is a
A Must filled setting
Address gateway IP.

Subnet Mask

DHCP Server
/Relay

DHCP Server
IP Address
(for DHCP
Relay only)
DHCP Option
82

(for DHCP
Relay only)
DHCP Server
Name

IP Pool

Lease Time

255.255.255.0(/24) is
selected by default.

Server is selected by default.

A Must filled setting

An Optional filled setting

A Must filled setting

A Must filled setting

A Must filled setting

Select a Subnet Mask for the DHCP Server.

Define the DHCP Server type.

There are three types you can select: Server, Relay, and Disable.

Relay: Select Relay to enable DHCP Relay function for the VLAN group, and you
only need to fill the DHCP Server IP Address field.

Server:Select Server to enable DHCP Server function for the VLAN group, and
you need to specify the DHCP Server settings.

Disable:Select Disable to disable the DHCP Server function for the VLAN group.
If you select Relay type of DHCP Server, assign a DHCP Server IP Address that
the gateway will relay the DHCP requests to the assigned DHCP server.

If you select Relay type of DHCP Server, you can further enable the DHCP
Option 82 setting if the DHCP server support it.

Define name of the DHCP Server for the specified VLAN group.

Define the IP Pool range.

There are Starting Address and Ending Address fields. If a client requests an IP
address from this DHCP Server, it will assign an IP address in the range of IP
pool.

Define a period of time for an IP Address that the DHCP Server leases to a new
device. By default, the lease time is 86400 seconds.
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Domain Name

Primary DNS

Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Enable

Save

Undo

String format can be any
text
IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format
The box is unchecked by
default.

NA

NA

The Domain Name of this DHCP Server.
Value Range: 0 ~ 31 characters.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.
The Gateway of this DHCP Server.

Click Enable box to activate this rule.

Click the Savebutton to save the configuration
Click the Undobutton to restore what you just configured back to the previous
setting.
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Besides, you can add some IP rules in the IP Fixed Mapping Rule List if DHCPServer for the VLAN groups is
required.

= IP Fixed Mapping Rule List [[5] [
MAC Address IP Address Enable Actions

When Add button is applied,Mapping Rule Configuration screen will appear.

Mapping Rule Configuration

Item Value setting Description
MAC Address A Must filled setting Define the MAC Address target that the DHCP Server wants to match.
Define the IP Address that the DHCP Server will assign.
. . If there is a request from the MAC Address filled in the above field, the DHCP
IP Address A Must filled setting Server will ass?gn this IP Address to the client whose MAC Addressmatched the
rule.
The box is unchecked by Click Enable box to activate this rule.
Enable
default.
Save NA Click the Savebutton to save the configuration

Note: ensure to always click on Apply button to apply the changes after the web browser refreshed taken you
back to the VLAN page.

« Portbased VLAN List YT EEES - %

Name | VLANID T:;‘;iﬂg NAT/Bridge | oM LAN IP Address Subnet Mask | Joined WAN = WAN VID | Enable | Actions
Native WVLAN -

LAN Tog 1 X NAT 192.168 661 2552552540 | Al WANs 0

| Apply | Inter VLAN Group Routing
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Port-based VLAN - Inter VLAN Group Routing

Click VLAN Group Routing button, the VLAN Group Internet Access Definition and Inter VLAN Group Routing
screen will appear.

* VLAN Group Internet Access Definition

VLAN IDs Members Internet Access(WAN)

1 Al

*] Inter VLAN Group Routing

VLAN IDs Members Action

Edit

Edit

Edit

Edit

When Edit button is applied, a screen similar to this will appear.

*| YLAN Group Internet Access Definition

VLAN IDs Members Internet Access(WAN)

1 Al

*] Inter VLAN Group Routing

VLAN IDs Members Action
@

Inter VLAN Group Routing

Item Value setting Description

By default, all boxes are checked means all VLAN ID members are allow to
VALN Group access WAN interface.
Internet All boxes are checked by If uncheck a certainVLAN ID box, it means the VLAN ID member can’t access
Access default. Internet anymore.
Definition Note: VLAN ID 1 is available always; it is the default VLAN ID of LAN rule. The

other VLAN IDsare available only when they are enabled.

Click the expected VLAN IDs box to enable the Inter VLAN access function.
Inter VLAN The box is unchecked by By default, members in different VLAN IDs can’t access each other. The gateway
Group Routing default. supports up to 4 rules for Inter VLAN Group Routing.

For example, if ID_1 and ID_2 are checked, it means members in VLAN ID_1 can
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access members of VLAN ID_2, and vice versa.
Save N/A Click the Save button to save the configuration

Tag-based VLAN — Create/Edit VLAN Rules

The Tag-based VLAN allows you to customize each LAN port according to VLAN ID. There is a default rule
shows the configuration of all LAN ports and all VAPs. Also, if your device has a DMZ port, you will see DMZ
configuration, too. The router supports up to a maximum of 128 tag-based VLAN rule sets.

= Configuration ° o

Item Setting
» VLAN Type
» System Reserved VLAN ID Start ID (1-4091)~EndiD |5 |
®) Tag-based VLAN List [IR% ° n
VLANID Internet Port Members Bridge Interface IP Address Subnet Mask Actions
Native VLAN v Port: v Port-1 v Port-2 DHCP 1 Select

When Add button is applied,Tag-based VLAN Configuration screen will appear.

% Tag-based VLAN Configuration

Item Setting
» VLAN D
b Internet Access Enabile
» Port Members Fart: '« Port-1 & Port-2
» Bridge Interface

Tag-based VLAN Configuration (Part-1)

Item Value setting Description
Define the VLAN ID number, that is outside the system reserved range.

VALN ID A Must filled setting Value Range: 1 ~ 4095,
Internet The box is checked by Click Enable box to allow the members in the VLAN group access to internet.
Access default.

Check the LAN port box(es) to join the VLAN group.

The boxes are unchecked by Check the VAPbox(es) to join the VLAN group.

Port Members

default. Note: Only the wireless gateway has the VAP list.
Bridge DHCP 1 is selected by Select a predefinedDHCP Server, a New to defined a new DHCP server for these
Interface default. members of this VLAN group.
Save N/A Click Save button to save the configuration

Note:After clicking Save button, always click Apply button to apply the settings.
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If you select New to create a new DHCP server setting for the VLAN group, you have to further specify the
following configuration.

» IP Address | |

» Subnet Mask |255 2552550 (/24)  ~ |
» DHCP Relay [J Enable & Server IP : |

» WAN Interface WAN-1~

» DHCP Relay Option 82 [J Enable

Tag-based VLAN Configuration (part-Il)

Item Value setting Description
IP Address A Must filled setting Assign an IP Address for the DHCP Server that the rule used, this IP address is a
gateway IP.
Subnet Mask 255.255.255.0(/24) is Select a Subnet Mask for the DHCP Server.
selected by default.
DHCP Rela The box is unchecked by Check the box to enable the DHCP Relay function for the VLAN group, and you
v default. only need to fill the DHCP Server IP Address field.
WAN-1 is selected by Select which WANinterface that allow accessing Internet.

WAN Interface default.

DHCP Option . ) . If you select Relay type of DHCP Server, you can further enable the DHCP
82 An Optional filled setting Option 82 setting if the DHCP server support it.
Save NA Click the Savebutton to save the configuration
Click the Undobutton to restore what you just configured back to the previous
Undo NA

setting.

Tag-based VLAN Summary

The configured tag-based VLAN group information will be displayed in the following screen.

=] Tag-based VLAN Summary ° ®
Port VLAN IDs
Port1 Native VLAN
Port2 Native VLAN
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2.2.3 DHCP Server

> DHCP Server

The gateway supports up to 4 DHCP servers to fulfill the DHCP requests from different VLAN groups (please
refer to VLAN section for getting more usage details). And there is one default setting for whose LAN IP
Address is the same one of gateway LAN interface, with its default Subnet Mask setting as “255.255.255.0”,
and its default IP Pool ranges is from “.100” to “.200” as shown at the DHCP Server List page on gateway’s

WEB ULI.
()

Gateway

> CEE

@ Meeting Room

1UI9Y13

EXX:

@ Office Network

User can add more DHCP server configurations by clicking on the “Add” button behind “DHCP Server List”, or
clicking on the “Edit” button at the end of each DHCP Server on list to edit its current settings. Besides, user
can select a DHCP Server and delete it by clicking on the “Select” check-box and the “Delete” button.
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» Fixed Mapping

User can assign fixed IP address to map the specific client MAC address by select them then copy, when targets
were already existed in the DHCP Client List, or to add some other Mapping Rules by manually in advance,
once the target's MAC address was not ready to connect.

{ PC-A: 00-12-34-AB-CD-0A }_ i 192.168.123.150
: : Fixed Mapping :
: PC-B: ey

PC—C 00-12-34-AB-CD-0C : : 10.10.133.181

----------------------------------

------------------------------------------------
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DHCP Server Setting

Go to Basic Network >LAN & VLAN> DHCP Server Tab.

The DHCP Server setting allows user to create and customize DHCP Server policies to assign IP Addresses to
the devices on the local area network (LAN).

Create / Edit DHCP Server Policy

The gateway allows you to custom your DHCP Server Policy. If multiple LAN ports are available, you can define
one policy for each LAN (or VLAN group), and it supports up to a maximum of 4 policy sets.

w7 Add || Delete || DHCP Client List |

DHCP . . .
LANIP Lease Domain Primary Secondary Primary  Secondary .
SNear:.'Zr Address Subnet Mask IP Pool Time Name DNS DNS WINS WINS Gateway  Enable Actions
-Edit
DHCP 1192 168.66.1 | 255.255.254.0| 192,168.66.100-| g5 0000 | 0000 |0000 0000 | 0000 | ¥ : :
1 192168 66.200 Fixed Mapping

When Add button is applied,DHCP Server Configuration screen will appear.

= DHCP Server Configuration

Item Setting
» DHCP Server Name |DHCP 1 |
» LAN IP Address 1192.168.123.254 |
» Subnet Mask |255.255.255.0 (/24) v |

Starting Address:  192.168.123.100 |
Ending Address:  192.168.123.200 |

Lease Time seconds

b

IP Pool

b4

» Domain Name | ‘ (Optional)
» Primary DNS | ‘ (Optional)
» Secondary DNS | ‘ (Optional)
» Primary WINS | ‘ (Optional)
» Secondary WINS | ‘ (Optional)
» Gateway | ‘ (Optional)
» Server (¢ Enable

DHCP Server Configuration
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DHCP Server
Name

LAN IP
Address

Subnet Mask

IP Pool

Lease Time

Domain Name

Primary DNS
Secondary
DNS

Primary WINS

Secondary
WINS

Gateway
Server
Save

Undo

Back

1. String format can be any
text

2. A Must filled setting

1. IPv4 format.

2. A Must filled setting
255.0.0.0 (/8) is set by
default

1. IPv4 format.

2. A Must filled setting

1. Numberic string format.
2. A Must filled setting
String format can be any
text

IPv4 format

IPv4 format
IPv4 format
IPv4 format

IPv4 format

The box is unchecked by
default.

N/A

N/A

N/A

Enter a DHCP Server name. Enter a name that is easy for you to understand.

The LAN IP Address of this DHCP Server.

The Subnet Mask of this DHCP Server.

The IP Pool of this DHCP Server. It composed of Starting Address entered in this
field and Ending Address entered in this field.

The Lease Time of this DHCP Server.

Value Range: 300 ~ 604800 seconds.

The Domain Name of this DHCP Server.

The Primary DNS of this DHCP Server.
The Secondary DNS of this DHCP Server.
The Primary WINS of this DHCP Server.
The Secondary WINS of this DHCP Server.

The Gateway of this DHCP Server.
Click Enablebox to activate this DHCP Server.

Click the Savebutton to save the configuration

Click the Undobutton to restore what you just configured back to the previous
setting.

When the Backbutton is clicked the screen will return to the DHCP Server
Configuration page.

Create / Edit Mapping Rule List on DHCP Server

The gateway allows you to custom your Mapping Rule List on DHCP Server. It supports up to a maximum of 64
rule sets. When Fix Mapping button is applied, the Mapping Rule List screen will appear.

Add || Delete

MAC Address

IP Address Enable Actions

When Add button is applied,Mapping Rule Configuration screen will appear.
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Item Setting

» MAC Address | |
» IP Address | |
» Rule [[] Enable

Mapping Rule Configuration

Item Value setting Description
1. MAC Address string
MAC Address format The MAC Address of this mapping rule.

2. A Must filled setting
1. IPv4 format.

IP Address . . The IP Address of this mapping rule.
2. A Must filled setting

The box is unchecked by

Rule Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo N/A .
setting.
When the Back button is clicked the screen will return to the DHCP Server
Back N/A

Configuration page.

View / Copy DHCP Client List

When DHCP Client List button is applied, DHCP Client List screen will appear.

e TR Copy to Fixed Mapping

LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions
Ethermnet Dynamic /192.168.123.100 James-P45V 74:D0:2B:62:8D:42 00:49:07 ] Select

e A RS Copy to Fixed Mapping -l %
LAN Interface IP Address Host Name MAC Address Remaining Lease Time | Actions

When the DHCP Client is selected and Copy to Fixed Mapping button is applied. The IP and MAC address of
DHCP Client will apply to the Mapping Rule List on specific DHCP Server automatically.

Enable / Disable DHCP Server Options
The DHCP Server Options setting allows user to set DHCP OPTIONS 66,72,or 114. Click the Enable button to

activate the DHCP option function, and the DHCP Server will add the expected options in its sending out
DHCPOFFERDHCPACK packages.
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Option H Meaning RFC
66 TFTP server name RFC 2132]
72 Default World Wide Web Server RFC 2132]
114 URL RFC 3679]
= Configuration ’ %
Item Setting
» DHCP Server Options [J Enable

Create / Edit DHCP Server Options

The gateway supports up to a maximum of 99 option settings.

« DHCP Server Option List ¢
DHCP Sever Select

Enable

Option Name Option Select

When Add/Edit button is applied, DHCP Server Option Configuration screen will appear.

& DHCP Server Option Configuration

ltem Setting
» Option Name (Option 1 |
» DHCP Sever Selsct
» Option Select |DHCP OPTION 66 v |
» Type | Single IP Address v |
» Value |
» Enable [l Enable

DHCP Server Option Configuration

Item \ Value setting Description
1. String format can be any
Option Name text
2. A Must filled setting.

Enter a DHCP Server Option name. Enter a name that is easy for you to
understand.

SD::;Server BIr-IOCde:)(\eI:\r/:: of all available Choose the DHCP server this option should apply to.

1. A Must filled setting. Choose the specific option from the dropdown list. It can be Option 66, Option
Option Select 2. Option 66 is selected by 72, Option 144, Option 42, Option 150, orOption 160.

default. Option 42for ntp server;
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Option 66 for tftp;

Option 72 for www;

Option 144 for url;

Each different options has different value types.

Single IP Address

66 -
Single FQDN
72 IP Addresses List, separated by “,”
Type Dropdown. list c')f DHCP 114 Single URL
server option value’s type -
42 IP Addresses List, separated by “,”
150 IP Addresses List, separated by “,”
Single IP Address
160 -
Single FQDN
Should conform to Type :
1. IPv4 format Type Value
2. FQDN format Single IP Address IPv4 format
Value 3. 1P list 66 -
4. URL format Single FQDN FQDN format
5. A Must filled setting 72 IP Addresses List, separated by “,”  IPv4 format, separated by “,”
114 Single URL URL format
Enable The box s unchecked by Click Enable box to activate this setting.
default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed

Create / Edit DHCP Relay

The gateway supports up to a maximum of 6 DHCP Relay configurations.

E Add | Delete

. . DHCP Relay .
D Agent Name LAN interface WAN interface Server IP Option 82 Enable Actions

When Add/Edit button is applied, DHCP Relay Configuration screen will appear.
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[tem Setting
» Agent Name | |
b LAMN interface
» WAN interface WAN -1~
» Server IP |
» DHCP OPTION 82 g
» Enable o

DHCP Relay Configuration

Item Value setting Description

1. String format can be any

Enter a DHCP Relay name. Enter a name that is easy for you to understand.

Agent Name text o
2. A Must filled setting. Value Range:1~64 characters.
1. A Must filled setting. Choose alAN Interfacefor the dropdown list to apply with the DHCP Relay

LAN Interface 2. LAN is selected by default.  function.

1. A Must filled setting.
WAN Interface 2.WAN-1 is selected by

Choose aWAN Interfacefor the dropdown list to apply with the DHCP Relay
function. It can be the available WAN interface(s), and L2TP connection.

default.

1. A Must filled setting. Assign a DHCP Server IP Address that the gateway will relay the DHCP requests
Server IP . . . .

2. null by default. to the assigned DHCP server via specified WAN interface.

Click Enable box to activate DHCP OPTION 82 function.
DHCP OPTION The box is unchecked by Option 82 is organized as a single DHCP option that contains circuit-ID
82 default. information known by the relay agent. If the relayed DHCP server required the
such information, you have to enable it, otherwise, just leave it as unchecked.

The box is unchecked by

Enable Click Enable box to activate this setting.

default.
Save NA Click the Save button to save the setting.
When the Undo button is clicked the screen will return back with nothing
Undo NA changed
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2.3WiFi (not supported)

Not supported feature for the purchased product, leave it as blank.
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2.4 IPv6

The growth of the Internet has created a need for more addresses than are possible with IPv4. IPv6 (Internet
Protocol version 6) is a version of the Internet Protocol (IP) intended to succeed IPv4, which is the protocol
currently used to direct almost all Internet traffic. IPv6 also implements additional features not present in IPv4.
It simplifies aspects of address assignment (stateless address auto-configuration), network renumbering and

router announcements when changing Internet connectivity providers.

2.4.1 IPv6 Configuration

IPv6
Configuration

L4 Setup

AN Type

Configuration
If =

Static IPv6
W DHCPv6

WAN Connection
Option

LAN
Configuration

Address Auto-
Configuration

= Main IPv6 Configuration

Item Setting
» Main IPv6 [« Enable
» WAN Connection Type

= Main DHCPv6 WAN Type Configuration

# Main Address Auto-configuration

= Failover IPv6 Configuration

Item Setting
} Failover IPv6 (v Enable
» WAN Connection Type DHCPv6 v
= Failover DHCPv6 WAN Type Configuration

Item Setting

» DNS

(® From Server () Specific DNS

¥ Primary DNS

» Secondary DNS

» MLD Snooping

(| Enable

The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 network.This
gateway supports various types of IPv6 connection, including Static IPv6,DHCPv6, and PPPoEv6

Note: The available WAN connection types can be different, depending on the Interface type of WAN.
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IPv6 WAN Connection Type

Static IPv6
Static IPv6 does the same function as static IPv4. The static IPv6 provides manual setting of IPv6 address, IPv6

default gateway address, and IPv6 DNS.

ISP IP: 2001:470:871¢::100 /64
DNS 1: 2001:470:20::2 Gateway

& Cﬁ - 2@0 >R
§ -
- \-\

2001:410:871c::5 xDSL Modem
Primary DD 10.0.75.2)8
Sewer S — 2001:470§871:50ff::75:2 /64
2001:470:207
Secondary @ , )
Server >
2001:470:20::6 N
: : : Intranet

pC1

Above diagram depicts the IPv6 IP addressing, type in the information provided by your ISP to setup the IPv6
network.

DHCPv6

DHCP in IPv6 does the same function as DHCP in IPv4. The DHCP server sends IP address, DNS server addresses
and other possible data to the DHCP client to configure automatically. The server also sends a lease time of
the address and time to re-contact the server for IPv6 address renewal. The client has then to resend a
request to renew the IPv6 address.

DNS 1:2001:470:20::2

ISP DNS 2:2001:4860:4860::8888
2001:47p:871c::5 xDSL Modem

PrimaryD 10.0.75.2 /8
Se | 2001:470:871c:500 d:250:18ff:fe21:deea/6
J
Seconda S
Server ) g
2001:470:20::6 % % % N

Above diagram depicts DHCP IPv6 IP addressing, the DHCPv6 server on the ISP side assigns IPv6 address, IPv6
default gateway address, and IPv6 DNS to client host’s automatically.
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PPPoEV6

PPPOEV6 in IPv6 does the same function as PPPoE in IPv4. The PPPoEv6 server provides configuration
parameters based on PPPoEv6 client request. When PPPoEv6 server gets client request and successfully
authenticates it, the server sends IP address, DNS server addresses and other required parameters to
automatically configure the client.

DNS 1:2001:470:20::2

ISP DNS 2:2001:4860:4860::8888
LAM

2001:47p:871c::5 xDSL Modem

PrimaryD 10.0.75.2/8
sServinel = | 2001:470:871c:500d:250:18ff-fe21:deea/6
§
Seconda S | :
Server [ §
2001:470:20::6 % % Q NN

The diagram above depicts the IPv6 addressing through PPPoE, PPPoEv6 server (DSLAM) on the ISP side
provides IPv6 configuration upon receiving PPPoEv6 client request. When PPPoEvV6 server gets client request
and successfully authenticates it, the server sends IP address, DNS server addresses and other required
parameters to automatically configure the client.
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IPv6 Configuration Setting

Go to Basic Network > IPv6 > Configuration Tab.
The IPv6 Configuration setting allows user to set the IPv6 connection type to access the IPv6 network.

The device provides two types of IPv6 connections, one is for the Main IPv6 connection, and the other is for
Failover IPv6 connection. You have to configure the Main IPv6 related configurations first, and the configure
the Failover parts if required.

= Failover IPv6 Configuration ° n

Item Setting
» Failover IPv6 ¥/ Enable
» WAN Connection Type
IPv6 Configuration
Item Value setting Description
IPv6 The boxis unchecked Check the Enable box to activate the Main IPv6 function.
by default,

Define the selected IPv6 WAN ConnectionType to establish the IPv6
connectivity via Main / Failover WAN Interface.
The available WAN connection type are Static IPv6, DHCPv6, PPPOEV6,

1. A Must filled setting  Select Static IPv6 when your ISP provides you with a set IPv6 addresses.
WAN Connection 2.DHCPv6 is selected Select DHCPv6 when your ISP provides you with DHCPv6 services.
Type by default Select PPPoEv6 when your ISP provides you with PPPoEv6 account settings.

Note: The available WAN connection types can be different, depending on the
Interface type of corresponding WAN.

Static IPvé WAN Type Configuration

& Main Static IPv6 WAN Type Configuration e

[tem Setting

F |PvG Address | |

» Subnet Prefix Length [ ]

+ Default Gateway

k Primary DNS

¥ Secondary DNS

Enable

Ol=—=l—

¥ MLD Snooping
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Static IPv6é WAN Type Configuration
Item

{ Value setting

' Description

IPv6 Address A Must filled setting Enter the WAN IPv6 Address for the router.

f::;;‘t Prefix A Must filled setting Enter the WAN Subnet Prefix Length for the router.
Default Gateway A Must filled setting Enter the WAN Default Gateway IPv6 address.
Primary DNS An optional setting Enter the WAN primary DNS Server.

Secondary DNS An optional setting Enter the WAN secondary DNS Server.

The box is unchecked

MLD Snooping by default

Enable/Disable the MLD Snooping function

DHCPv6 WAN Type Configuration

= Main DHCPv6 WAN Type Configuration "

[tem

Setting

r DNS

(@ From Server () Specific DNS

» Primary DNS

r Secondary DNS

(] Enable

¥ MLD Snooping

DHCPv6 WAN Type Configuration

Item \ Value setting Description

The opt!on [From Select the [Specific DNS] option to active Primary DNS and Secondary DNS. Then
DNS Server] is selected by ) . .

fill the DNS information.

default
Primary DNS Can not modified by Enter the WAN primary DNS Server.

default
Secondary DNS szpa:ﬁct modified by Enter the WAN secondary DNS Server.

The box is unchecked . . .
MLD by default Enable/Disable the MLD Snooping function
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PPPoEv6 WAN Type Configuration

= Main PPPoEv6 WAN Type Configuration .

[tem

Setting

F Account

¥ Password

F Service Name

¥ Connection Control

Auto-reconnect (Always on)

» MTU

[ |

F MLD Snooping

(] Enable

PPPoEve WAN Type Configuration

Item

Account

Value setting

A Must filled setting

Description
Enter the Account for setting up PPPoEv6 connection. If you want more
information, please contact your ISP.
Value Range:0 ~45 characters.

Password

A Must filled setting

Enter the Password for setting up PPPoEv6 connection. If you want more
information, please contact your ISP.

Service Name

A Must filled
setting/Option

Enter the Service Name for setting up PPPoEv6 connection. If you want more
information, please contact your ISP.
Value Range:0 ~45 characters.

Connection Control

Fixed value

The value is Auto-reconnect(Always on).

MTU

A Must filled setting

Enter the MTU for setting up PPPoEv6 connection. If you want more
information, please contact your ISP.
Value Range: 1280 ~ 1492.

MLD Snooping

The box is unchecked
by default

Enable/Disable the MLD Snooping function

Address Auto-configuration

= Main Address Auto-configuration

[tem

Setting

¥ Auto-configuration

Enable

» Auto-configuration Type

Stateless »

r Router Advertisement Lifetime

(coconcs)

Address Auto-configuration

Item

Auto-configuration

Value setting
The box is unchecked
by default

| Description

Check to enable the Auto configuration feature.
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1. Only can be

. . selected when Auto-
Auto-configuration

Type configurationenabled

2. Stateless is selected
by default

Define the selected IPv6 WAN Connection Type to establish the IPv6
connectivity.

Select Stateless to manage the Local Area Network to be SLAAC + RDNSS
Router Advertisement Lifetime (A Must filled setting): Enter the Router
Advertisement Lifetime (in seconds). 200 is set by default.

Value Range:0 ~ 65535.

Select Stateful to manage the Local Area Network to be Stateful (DHCPv6).
IPv6 Address Range(Start) (A Must filled setting): Enter the start IPv6 Address
for the DHCPv6 range for your local computers. 0100 is set by default.

Value Range:0001 ~ FFFF.

IPv6 Address Range(End)(A Must filled setting): Enter the end IPv6 Address for
the DHCPv6 range for your local computers. 0200 is set by default.
Value Range:0001 ~ FFFF.

IPv6 Address Lifetime (A Must filled setting): Enter the DHCPv6 lifetime for your
local computers. 36000 is set by default.
Value Range:0 ~ 65535.

If above settingsareconfigured, click the save button to save the configuration.
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2.5 Port Forwarding

Network address translation (NAT) is a methodology of remapping one IP address space into another by
modifying network address information in Internet Protocol (IP) datagram packet headers while they are in
transit across a traffic routing device. The technique was originally used for ease of rerouting traffic in IP
networks without renumbering every host. It has become a popular and essential tool in conserving global
address space allocations in face of IPv4 address exhaustion.The product you purchased embeds and activates
the NAT function. You also can disable the NAT function in [Basic Network]-[WAN& Uplink]-[Internet Setup]-
[WAN Type Configuration] page.

Widget

' @ Status . W “Virtual Server & Virtual Computer - Special AP & ALG ' DMZ & Pass Through

—

Basic Network

- -
- WAN & Uplink Item Setting
* LAN & VLAN » NAT Loophack ¥ Enable

- WiFi

- IPv6

© Port Forwarding

- Routing

- DNS & DDNS p
Usually all local hosts or servers behind corporate gatewayare protected by NAT firewall. NAT firewall will filter
out unrecognized packets to protect your Intranet.So, all local hosts are invisible to the outside world. Port
forwarding or port mapping isfunction that redirects a communication request from one address and port
number combination to assigned one. This technique is most commonly used to make services on a host
residing on a protected or masqueraded (internal) network available to hosts on the opposite side of the
gateway (external network), by remapping the destination IP address and port number
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2.5.1 Configuration

NAT Loopback

This feature allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Configuration Setting

Go to Basic Network >Port Forwarding> Configuration tab.

The NAT Loopback allows user to access the WAN IP address from inside your local network.

Enable NAT Loopback

= NAT Loopback -

ltem Setting

» NAT Loopback Enahle

Configuration

Item Value setting Description

NAT Loopback The box is checked by default Check the Enable box to activate this NAT function
Save N/A Click the Save button to save the settings.
Undo N/A Clickthe Undobutton to cancel the settings
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2.5.2 Virtual Server & Virtual Computer

= Configuration a .
Item Setting

¥ Virtual Server ] Enable

» Virtual Computer ¥ Enable

= Virtual Server List [[RT]

WAN Interface

Server IP Source IP Protocol | Public Port Time Schedule  Enable

Global IP

There are some important Pot Forwarding functions implemented within the gateway, including "Virtual
Server", "NAT loopback" and "Virtual Computer".

It is necessary for cooperate staffs who travel outside andwant to access various servers behind office gateway.
You can set up those servers by using "Virtual Server" feature. After trip,if want to access those servers from
LAN side by global IP, without change original setting, NAT Loopback can achieve it.

"Virtual computer" is a host behind NAT gateway whose IP address is a global one and is visible to the outside
world. Since it is behind NAT, it is protected by gateway firewall. To configure Virtual Computer, you just have
to map the local IP of the virtual computer to a global IP.
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Virtual Server&NAT Loopback
g - "Virtual Server" allows you to access servers with the
A global IP address or FQDN of the gateway as if they are
SO cemiramsas  servers existed in the Internet. But in fact, these servers
are located in the Intranet and are physically behind the
gateway. The gateway serves the service requests by port

8”@

Remote User

[ N .
i1~ \\3 . forwarding the requests to the LAN servers and transfers
AiContigure E-mell Server (16,6.75.304) | _\ , the replies from LAN servers to the requester on the
za;av"‘ua'sﬂvef N ' WAN side. As shown in example, an E-mail virtual server
emote User access E-mail Server E ranar XS Eofal L=t ‘K
with Gateway Global IP (118.1881.33). 156.75%301 |& worsa0 | is defined to be located at a server with IP address
3.With NAT Loopback enabled, Local \ /" . . .
User can access local E-mail Server e 10.0.75.101 in the Intranet of Network-A, including SMTP
with Global IP (118.18.81.33) as well. Global IP:118.18.81.44 . )
. locallPi10075102 service port 25 and POP3 service port 110.So, the remote
oy _d user can access the E-mail server with the gateway’s

global IP 118.18.81.33 from its WAN S|de But the real E-mail server is located at LAN side and the gateway is
the port forwarder for E-mail service.

NAT Loopback allows you to access the WAN global IP address from your inside NAT local network. It is useful
when you run a server inside your network. For example, if you set a mail server at LAN side, your local
devices can access this mail server through gateway’s global IP address when enable NAT loopback feature. On
either side are you in accessing the email server, at the LAN side or at the WAN side, you don’t need to change
the IP address of the mail server.

Virtual Computer

N kA "Virtual Computer" allows you to assign LAN hosts to
4 stworke global IP addresses, so that they can be visible to outside
b ateway Global IP: 118.18.81.33

aira00rsz World. While so, they are also protected by the gateway
6—2‘\‘@- 7-_—— \ firewall as being client hosts in the Intranet. For example,
Remote User ' i you set a FTP file server at LAN side with local IP

. address 10.0.75.102 and global IP address 118.18.82.44,

1. Configure File Server as a Virtual i !
PO skt i g —@ | aremote user can access the file server while it is hidden
global IP (118.18.81.44) directly ‘;E_mamr < N2 behind the NAT gateway. That is because the gateway
ey wo7sio - takes care of all accessing to the IP address 118.18.82.44,
B e including to forward the access requests to the file
S ‘°““"’1°'°"5"°f y server and to send the replies from the server to outside
R ot world.
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Virtual Server & Virtual Computer Setting

Go to Basic Network >Port Forwarding> Virtual Server & Virtual Computer tab.

Enable Virtual Server and Virtual Computer

e  _BC

Item Setting

+ Virtual Server [ Enable
¥ Virtual Computer [+ Enable

Configuration

Item { Value setting { Description
. The box is unchecked b
Virtual Server default Y Check the Enable box to activate this port forwarding function
efau
. The box is checked b
Virtual Computer default Y Check the Enable box to activate this port forwarding function
efau
Save N/A Click the Save button to save the settings.
Undo N/A Click theUndobutton to cancel the settings.

Create / Edit Virtual Server

The gateway allows you to custom your Virtual Server rules. It supports up to a maximum of 20 rule-based
Virtual Server sets.

= Virtual Server List
Private
1D WAN Interface Server IP Source IP Protocol | Public Port Time Schedule | Enable Actions
Port

When Add button is applied,Virtual Server Rule Configuration screen will appear.
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Item

» WAN Interface
» Server IP

» Source [P

» Protocol

» Public Port

» Private Port

» Time Schedule

» Rule

Setting

«| All WAN-1 WAN-2
Any v
TCP(6) & UDP(17) v
Well-known Service v | | -- select one -- v
Single Port
(0) Always v

Enable

Save

WAN Interface

Server IP

Source IP

Protocol

Define the selected interface to be the packet-entering interface of the
gateway.
If the packets to be filtered are coming from WAN-x then select WAN-x for this

1. A Must filled setting field.

2. Default is ALL. Select ALL for packets coming into the gateway from any interface.
It can be selected WAN-x box when WAN-x enabled.
Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number of
WAN interfaces for the product.

. . This field is to specify the IP address of the interface selected in the WAN

A Must filled setting .

Interface setting above.
) . This field is to specify the Source IP address.
1. A Must filled setting
2. By default Any is

selected

Select Any to allow the access coming from any IP addresses.

Select Specific IP Address to allow the access coming from an IP address.

Select IP Range to allow the access coming from a specified range of IP address.
When “ICMPv4” is selected

It means the option “Protocol” of packet filter rule is ICMPv4.

Apply Time Schedule to this rule, otherwise leave it as Always. (refer to
Scheduling setting underObject Definition)

Then check Enable box to enable this rule.

1. A Must filled setting

2. TCP & UDP is selected When “TCP” is selected

by default. It means the option “Protoco

|u

of packet filter rule is TCP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
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Time Schedule

Rule

Save
Undo

1. Anoptional filled setting
2. (0)Alwaysls selected by
default.

1. Anoptional filled setting
2.The box isunchecked by
default.

N/A

N/A

can be selected Single Port or Port Range.
Value Range:1 ~ 65535 for Public Port, Private Port.

When “UDP” is selected

It means the option “Protocol” of packet filter rule is UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range:1 ~ 65535 for Public Port, Private Port.

When “TCP & UDP” is selected

It means the option “Protocol” of packet filter rule is TCP and UDP.

Public Port selected a predefined port from Well-known Service, and Private
Port is the same with Public Port number.

Public Port is selected Single Port and specify a port number, and Private Port
can be set a Single Port number.

Public Port is selected Port Range and specify a port range, and Private Port
can be selected Single Port or Port Range.

Value Range:1 ~ 65535 for Public Port, Private Port.

When “GRE” is selected
It means the option “Protocol” of packet filter rule is GRE.

When “ESP” is selected
It means the option “Protocol” of packet filter rule is ESP.

When “SCTP” is selected
It means the option “Protocol” of packet filter rule is SCTP.

When “User-defined” is selected

It means the option “Protocol” of packet filter rule is User-defined.

For Protocol Number, enter a port number.

Apply Time Schedule to this rule; otherwise leave it as (0)Always. (refer to
Scheduling setting under Object Definition)

Check the Enable box to activate the rule.

Click the Save button to save the settings.

Click theXbutton to cancel the settings and return to previous page.
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Create / Edit Virtual Computer

The gateway allows you to custom your Virtual Computer rules. It supports up to a maximum of 20 rule-based
Virtual Computer sets.

P S—

1D Global IP Local IP Enable Actions

When Add button is applied,Virtual Computer Rule Configuration screen will appear.

= Virtual Computer Rule Configuration

Global IP Local IP Enable
| | | | =

Virtual Computer Rule Configuration

Item H Value setting \ Description

Global IP A Must filled setting This field is to specify the IP address of the WAN IP.
Local IP A Must filled setting This field is to specify the IP address of the LAN IP.
Enable N/A Then check Enablebox to enable this rule.

Save N/A Click the Savebutton to save the settings.
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2.5.3 DMZ & Pass Through

DMZ (De Militarized Zone) Host is a host that is exposed to the Internet cyberspace but still within the
protection of firewall by gateway device. So, the function allows a computer to execute 2-way communication
for Internet games, Video conferencing, Internet telephony and other special applications. In some cases
when a specific application is blocked by NAT mechanism, you can indicate that LAN computer as a DMZ host

to solve this problem.

TheDMZ function allows you to ask the gateway pass through all normal packets to the DMZ host behind the
NAT gateway only when these packets are not expected to receive by applications in the gateway or by other
client hosts in the Intranet. Certainly, the DMZ host is also protected by the gateway firewall. Activate the
feature and specify the DMZ host with a host in the Intranet when needed.

Item
Enable All WAN-1
» DMz DMZ Host :
» Pass Through Enable < IPSec ¥ PPTP [« L2TP
DMZ Scenario

Global IP:118.18.81.33

Local IP: 10.0.75.2
‘ Gateway
D= e X

Remote User 2

1.Set X Server as DMZ Host

2.Request X server service by Gateway Global IP
3.Gateway redirect service request to DMZ host:
10.0.75.100

X Server

Setting

When the network administrator wants to set up
some service daemons in a host behindNAT
gateway to allow remote users request for services
from server actively,you just have to configure this
host as DMZ Host. As shown in the diagram, there
is an X server installed as DMZ host, whose IP
address is 10.0.75.100. Then, remote user can
request services from X server just as it is provided
by the gateway whose global IP address is
118.18.81.33. The gateway will forward those
packets, not belonging to any configured virtual
server or applications, directly to the DMZ host.
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VPN Pass through Scenario

Network-A @ HQ Data Center Gateway without

> VPN Pass Through

5
O

P Fail to establish VPN tunnel
Application ¢ T B R, W
Server hoatabase | o mmmmm————
W) server 4+ =~
4 4
f 4
\ -
4 L 2
PR VPN Tunnel

SecurityGatewayl = = = = = = = = = = = = = = = =
with a “StaticIP” Establish VPN tunnel
successfully
Global IP: 203.95.80.22

Local IP: 10.0.76.2

DMZ & Pass Through Setting

VPN Pass Through behind NAT Gateway

Since VPN traffic is different from that of TCP or
UDP connection, it will be blocked by NAT gateway.
To support the pass through function for the VPN
connections initiating from VPN clients behind NAT
gateway, the gateway must implement some kind
of VPN pass through function for such application.
The gateway support the pass through function for
IPSec, PPTP, and L2TP connections, you just have
to check the corresponding checkbox to activate it.

Go to Basic Network >Port Forwarding> DMZ& Pass Through tab.

The DMZ host is a host that is exposed to the Internet cyberspace but still within the protection of firewall by

gateway device.

Enable DMZ and Pass Through

Item

Enable All WAN-1 WAN-2

» DMz DMZ Host :

» Pass Through Enable ¥ IPSec [(¢#) PPTP [# L2TP

DMZ 1. A Must filled setting
2. Default is ALL.

Setting

Check the Enable box to activate theDMZ function
Define the selected interface to be the packet-entering interface of the

gateway, and fill in the IP address of Host LAN IP in DMZ Hostfield

If the packets to be filtered are coming from WAN-x then select WAN-x for

this field.

Select ALL for packets coming into the router from any interfaces.
It can be selected WAN-x box when WAN-x enabled.

Note: The available check boxes (WAN-1 ~ WAN-4) depend on the number
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Pass Through Enable  The boxesare checked by

default
Save N/A
Undo N/A

of WAN interfaces for the product.

Check the box to enable the pass through function for the IPSec, PPTP, and
L2TP.

With the pass through function enabled, the VPN hosts behind the gateway
still can connect to remote VPN servers.

Click theSave button to save the settings.
Click theUndobutton to cancel the settings
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2.6 Routing

: ; ) : ) ) Widget
' . Status W Dynamic Routing Routing Information

o

Basic Netwo

= WAN & Uplink

Item Setting

E—— » Static Routing [} Enable

D Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions

= WiFi

- IPv6

- Port Forwarding

- DNS & DDNS

If you have more than one router and subnet, you will need to enable routing function to allow packets to find
proper routing path and allow different subnets to communicate with each other.Routing is the process of
selecting best paths in a network. It is performed for many kinds of networks, like electronic data networks
(such as the Internet), by using packet switching technology. The routing process usually directs forwarding on
the basis of routing tables which maintain a record of the routes to various network destinations. Thus,
constructing routing tables, which are held in the router's memory, is very important for efficient routing. Most
routing algorithms use only one network path at a time.

The routing tables record your pre-defined routing paths for some specific destination subnets. It is static
routing. However, if the contents of routing tables record the obtained routing paths from neighbor routers by
using some protocols, such as RIP, OSPF and BGP. It is dynamic routing. These both routing approaches will be
illustrated one after one. In addition, the gateway also built in one advanced configurable routing software
Quagga for more complex routing applications, you can configure it if required via Telnet CLI.
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2.6.1 Static Routing

Configuration

JI Enable

Static No
Routing?

Yes

Setup

4 Static Routing
Rule List

‘L Check

Finish?
¢ No
Static Routing
Rule Configuration

db

¥ Subnet Mask
F Gateway P
v Interace

¥ Matnc

¥ Rule

Item Sutting
b5 outing # Enable
Add § Deleta
18] Destination IP Subnat Mask Gateway IF Interface Matrle  Enable Aetiens
[bem Satting
¥ Destination IP

20N IA0IA4) »

T

Enable

"Static Routing" function lets you define the routing paths for some dedicated hosts/servers or subnets to
store in the routing table of the gateway. The gateway routes incoming packets to different peer gateways
based on the routing table. You need to define the static routing information in gateway routing rule list.

1) Google(173.194.72.94): -> WAN-1
Yahoo(188.125.73.108): -> WAN-2

ISP-DSLAM

u ( EE oogle

192.168.121.253

))_} (@ Yahoo LAN

) B 192.168.22.1

| Static Routing: Enable |

[Static Routing]-[Static Routing Rule List]

Cellular {((ﬁ

((9)) Gateway

ID1:
Destination IP: 173.194.72.94
Subnet Mask: 255.255.255.255
Gateway: 192.168.121.253
Metric: 255
Rule: Enable

ID2:
Destination IP: 188.125.73.108
Subnet Mask: 255.255.255.255
Gateway: 192.168.22.1
Metric: 255
Rule: Enable

When the administrator of the gateway wants to
specify what kinds of packets to be transferred via
which gateway interface and which peer gateway to
their destination. It can be carried out by the "Static
Routing" feature.Dedicated packet flows from the
Intranet will berouted to their destination via the pre-
defined peer gateway and corresponding gateway
interface that are defined in the system routing table
by manual.

As shown in the diagram, when the destination is
Google access, rule 1 set interface as ADSL, routing
gateway as IP-DSLAM gateway 192.168.121.253. All the
packets to Google will go through WAN-1. And the
same way applied to rule 2 of access Yahoo. Rule 2 sets
3G/4G/5G as interface.
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Static Routing Setting

Go to Basic Network >Routing>Static Routing Tab.

There are three configuration windows for static routing feature, including"Configuration", "Static Routing
Rule List" and "Static Routing Rule Configuration" windows. "Configuration" window lets you activate the
global static routing feature. Even there are alreadyrouting rules, if you want to disable routing temporarily,
just uncheck the Enable box to disable it. "Static Routing Rule List" window lists all your defined static routing
rule entries. Using "Add" or "Edit" button to add and create one new static routing rule or to modify an
existed one.

When "Add" or "Edit" button is applied, the "Static Routing Rule Configuration" window will appear to let you
define a static routing rule.

Enable Static Routing

Just check the Enable box to activate the "Static Routing" feature.

ltem Setting

» Static Routing # Enable

. . The box is unchecked by . . .
Static Routing default Check the Enable box to activate this function
efau

Create / Edit Static Routing Rules

The Static Routing Rule List shows the setup parameters of all static routing rule entries.To configure a static
routing rule, you must specify related parameters including the destination IP address and subnet mask of
dedicated host/server or subnet, the IP address of peer gateway, the metric and the rule activation.

Add | Delete

1D Destination IP Subnet Mask Gateway IP Interface Metric Enable Actions

The gateway allows you to custom your static routing rules. It supports up to a maximum of 64 rule sets. When
Add button is applied, Static Routing Rule Configuration screen will appear, while the Edit button at the end
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of each static routing rule can let you modify the rule.

# |Pvd4 Static Routing Rule Configuration

Iltem Setting

v Destination IFP | |
¥ Subnet Mask |255.255.255.0 (724 o« |

b Gateway 1P | |

v Interface
¥ Metric I:l

» Fule [} Enahle

IPv4 Static Routing

Item Value setting Description

s 1. IPv4 Format
Destination IP . . Specify the Destination IP of this static routing rule.
2. A Must filled setting

255.255.255.0 (/24) is set by
default
1. IPv4 Format

Gateway IP . . Specify the Gateway IP of this static routing rule.
2. A Must filled setting

Subnet Mask Specify the Subnet Mask of this static routing rule.

Select the Interface of this static routing rule. It can be Auto, or the available

Interface Auto is set by default .
WAN / LAN interfaces.
Metric 1. Numberic String Format The Metric of this static routing rule.
2. A Must filled setting Value Range: 0 ~ 255.
The box is unchecked b
Rule v Click Enable box to activate this rule.
default.
Save NA Click the Save button to save the configuration
Click the Undo button to restore what you just configured back to the previous
Undo NA .
setting.
When the Back button is clicked the screen will return to the Static Routing
Back NA

Configuration page.
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2.6.2 Dynamic Routing

RIP
Configuration

OSPF Area List?

OFPF Area
Configuration

BGP Network
Configuration

BGP
Metwork List?

BGP Neighbor
Configuration

®—

= RIP Configuration

Item Setting
» RIP Enable Disable -
OSP = R,
Item Setting
» OSPF [~ Enable
+ Router ID |
» Authentication None -
» Backbone Subnet |
= OSPF Area List ’
ID Area Subnet Area ID Enable Actions
= OSPF Area Configuration ' n
Item Setting
» Area Subnet [
» Area ID |
» Area [~ Enable
Save |
% BGP Configuration . n
Item Setting
» BGP [~ Enable
» ASN [
» Router ID |
= BGP Network List ’
ID Network Subnet Enable Actions
* BGP Neighbor List n
ID Neighbor IP Remote ASN Enable Actions

Dynamic Routing, also called adaptive routing, describes the capability of a system, through which routes are
characterized by their destination, to alter the path that the route takes through the system in response to a

change in network conditions.

This gateway supports dynamic routing protocols, including RIPv1/RIPv2 (Routing Information Protocol), OSPF
(Open Shortest Path First), and BGP (Border Gateway Protocol), for you to establish routing table
automatically. The feature of dynamic routing will be very useful when there are lots of subnets in your
network. Generally speaking, RIP is suitable for small network. OSPF is more suitable for medium network.
BGP is more used for big network infrastructure.
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The supported dynamic routing protocols are described as follows.

RIP Scenario

\@ :

@ Basic Network-Routi

[Dynamic Routing]‘[Rlpnfonﬁguration] ((( )))

RIP:RIPviOrRIPV2 |

@Routing Table#1
ISP-DSLAM

— s

118.18.81.1

@ Routing Table #2

OSPF Scenario

GatewaySettings:

[Dynamic Routing]-{0SPF Configuratig

OSPF:Enable

Backbone Subnet: 192.168.0.0/16

[Oynamic Routing]-{OSPF Area List]

DL

Area ID: 192.168.101.254
Area: Enable
D2

Area ID: 192.168.102.254
Area: Enable

Area Subnet: 192.168.101.0/24

Area Subnet: 192.168.102.0/24

WAN 1: ADSL
| 118.18.81.33

WAN-2: 36/

203.95.80.22

® Routing Table #1 +#2

j& 203.9580,1 ‘u Q () 9 ; /,”'

Cellular Network

5

~

The Routing Information Protocol (RIP) is one of the
oldest distance-vector routing protocols, which
employs the hop count as a routing metric. RIP
prevents routing loops by implementing a limit on the
number of hops allowed in a path from the source to a
destination. The maximum number of hops allowed
for RIP is 15. This hop limit, however, also limits the
size of networks that RIP can support. A hop count of
16 is considered an infinite distance, in other words
the route is considered unreachable. RIP implements
the split horizon, route poisoning and hold-down
mechanisms to prevent incorrect routing information
from being propagated.

Open Shortest Path First (OSPF) is a routing protocol
that useslink state routing algorithm. It is the most
widely used interior gateway protocol (IGP)in large
enterprise networks.It gathers link state information
from available routers and constructs a topology map
of the network.The topology is presented as a routing
table which routes datagrams based solely on the
destination IP address.

Network administrator can deploy OSPF gateway in
large enterprise network to get its routing table from
the enterprise backbone,and forward routing
information to other routers, which are no linked to
the enterprise backbone. Usually,an OSPF network is
subdivided into routing areas to simplify
administration and optimize traffic and resource
utilization.

As shown in the diagram, OSPF gateway gathers routing information from the backbone gateways in area O,
and will forward its routing information to the routers inarea 1 and area 2 which are not in the backbone.

95



5G/LTE WAN Extender

BGP Scenario

Border Gateway Protocol (BGP) is a standardexterior
gateway protocol designed to exchange routing and
reachability  information  between  autonomous
systems(AS)on the Internet. It usually makes routing
decisions based on paths, network policies, or rule-sets.

MostISPs use BGP to establish routing between one
another (especiallyfor multi-homed). Very large private
IP networks also use BGP internally. The major BGP
gateway within one AS will links with some other
border gateways for exchanging routing information. It
will distribute the collected datain AS to all routers in
other AS.

As shown in the diagram, BGP 0 is gateway to dominate

ASO (self IP is 10.100.0.1 and self ID is 100).1t links with other BGP gateways in the Internet. The scenario is like
Subnet in one ISP to be linked with the ones in other ISPs.By operating with BGP protocol, BGP 0 can gather
routing information from other BGP gateways in the Internet. And then it forwards the routing data to the
routers in its dominated AS.Finally, the routers resided in AS 0 know how to route packets to other AS.
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Dynamic Routing Setting

Go to Basic Network >Routing>Dynamic Routing Tab.

The dynamic routing setting allows user to customize RIP, OSPF, and BGP protocol through the router based
on their office setting.

In the "Dynamic Routing" page, there are several configuration windows for dynamic routing feature. They are
the "RIP Configuration" window, "OSPF Configuration" window, "OSPF Area List", "OSPF Area Configuration",
"BGP Configuration"”, "BGP Neighbor List" and "BGP Neighbor Configuration" window. RIP, OSPF and BGP
protocols can be configured individually.

The "RIP Configuration" window lets you choose which version of RIP protocol to be activated or disable it.
The "OSPF Configuration" window can let you activate the OSPF dynamic routing protocol and specify its
backbone subnet. Moreover, the "OSPF Area List" window lists all defined areas in the OSPF network.
However, the "BGP Configuration" window can let you activate the BGP dynamic routing protocol and specify
its self ID. The "BGP Neighbor List" window lists all defined neighbors in the BGP network.

RIP Configuration

The RIP configuration setting allows user to customize RIP protocol through the router based on their office
setting.

Item Setting

» RIP Enable |Disable .|

Select Disablewill disable RIP protocol.
RIP Enable Disable is set by default Select RIP v1will enable RIPv1 protocol.
Select RIP v2will enable RIPv2 protocol.

OSPF Configuration

The OSPF configuration setting allows user to customize OSPF protocol through the router based on their
office setting.
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* OSPF Configuration . ®
ltem Setting

» OSPF [~ Enable

» Router ID |

» Authentication None ~

+ Backbone Subnet |

OSPF Configuration

Item Value setting Description

OSPF Disable is set by default Click Enablebox to activate the OSPF protocol.
1. IPv4 Format

Router ID The Router ID of this router on OSPF protocol

2. A Must filled setting

The Authentication method of this router on OSPF protocol.

Select None will disable Authentication on OSPF protocol.

Select Textwill enable Text Authentication with entered the Key in this field on
OSPF protocol.

Select MD5will enable MD5 Authentication with entered the ID and Key in
these fields on OSPF protocol.

Authentication None is set by default

1. Classless Inter Domain

Routing (CIDR) Subnet

Mask Notation. (Ex: The Backbone Subnet of this router on OSPF protocol.
192.168.1.0/24)

2. A Must filled setting

Backbone
Subnet

Create / Edit OSPF Area Rules

The gateway allows you to custom your OSPF Area List rules. It supports up to a maximum of 32 rule sets.
| OSPF Area List [,%[s

Area Subnet

When Add button is applied,OSPF Area Rule Configuration screen will appear.
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® OSPF Area Configuration

Item Setting
¥ Area Subnet I
» Area ID |
» Area |_ Enable

_Save |

OSPF Area Configuration

Item

Area Subnet

Value setting

1. Classless Inter Domain
Routing (CIDR) Subnet
Mask Notation. (Ex:
192.168.1.0/24)

2. A Must filled setting

Description

The Area Subnet of this router on OSPF Area List.

1. IPv4 Format

Area ID . . The Area ID of this router on OSPF Area List.
2. A Must filled setting
The box is unchecked b
Area Y Click Enable box to activate this rule.
default.
Save N/A Click the Save button to save the configuration
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BGP Configuration

The BGP configuration setting allows user to customize BGP protocol through the router setting.

= BGP Configuration ‘ %®

Item Setting

» BGP [T Enable

» ASN |

» Router ID |

BGP Network Configuration

Item Value setting Description

BGP The box is unchecked by Check the Enablebox to activate the BGP protocol.
default

ASN 1. Numberic String Format ~ The ASN Number of this router on BGP protocol.
2. A Must filled setting Value Range: 1 ~ 4294967295.

Router ID 1. IPv4 Format The Router ID of this router on BGP protocol.
2. A Must filled setting

Create / Edit BGP Network Rules

The gateway allows you to custom your BGP Network rules. It supports up to a maximum of 32 rule sets.
= BGP Network List | ¢

Network Subnet

When Add button is applied,BGP Network Configuration screen will appear.

= BGP Network Configuration ' ®
Item Setting
» Network Subnet P |255.255.255.0 (/24) -]
» Network [T Enable
_Save |

\ Value setting Description
Network Subnet 1. |Pv4 Format The Network Subnet of this router on BGP Network List. It composes of entered
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2. A Must filled setting the IP address in this field and the selected subnet mask.
The box is unchecked b

Network Y Click Enablebox to activate this rule.
default.

Save N/A Click the Savebutton to save the configuration

Create / Edit BGP Neighbor Rules

The gateway allows you to custom your BGP Neighbor rules. It supports up to a maximum of 32 rule sets.
= BGP Neighbor List

Neighbor IP Remote ASN Actions
When Add button is applied,BGP Neighbor Configuration screen will appear.
& BGP Neighbor Configuration a »®
ltem Setting
» Neighbor IP |
» Remote ASN |
» Neighbor [~ Enable

BGP Neighbor Configuration
Item \ Value setting \ Description
1. IPv4 Format

Neighbor IP . . The Neighbor IP of this router on BGP Neighbor List.
2. A Must filled setting

1. Numberic String Format The Remote ASN of this router on BGP Neighbor List.

Remote ASN . .
2. A Must filled setting Value Range: 1 ~ 4294967295.
. The box is unchecked b
Neighbor y Click Enablebox to activate this rule.
default.
Save N/A Click the Savebutton to save the configuration
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2.6.3 Routing Information

The routing information allows user to view the routing table and policy routing information. Policy Routing
Information is only available when the Load Balance function is enabled and the Load Balance Strategy is By

User Policy.

Go to Basic Network > Routing > Routing Information Tab.

* Routing Table . »®

Destination IP Subnet Mask Gateway IP Metric Interface
10010516772 255255255252 0000 0 WAN-2
192 168.66.0 2552552550 0000 0 LAN
1921661270 2552552550 0000 0 WWAN-1
169.254.0.0 255.255.0.0 0.0.00 0 LAN
127000 255000 0000 0 lo
Routing Table
Item Value setting Description
Destination IP N/A Routing record of Destination IP. IPv4 Format.

Subnet Mask N/A Routing record of Subnet Mask. IPv4 Format.
Gateway IP N/A Routing record of Gateway IP. IPv4 Format.
Metric N/A Routing record of Metric. Numeric String Format.
Interface N/A Routing record of Interface Type. String Format.

# Policy Routing Information

Policy Routing Source

Source IP

Destination IP

Destination Port

WAN Interface

Load Balance

Policy Routing Information

Item

Value setting

Description

Policy Routing Source N/A Policy Routing of Source. String Format.

Source IP N/A Policy Routing of Source IP. IPv4 Format.
Destination IP N/A Policy Routing of Destination IP. IPv4 Format.
Destination Port N/A Policy Routing of Destination Port. String Format.
WAN Interface N/A Policy Routing of WAN Interface. String Format.
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2.7 DNS&DDNS

How does user access your server if your WAN IP address changes all the time? One way is to register a new
domain name, and maintain your own DNS server. Another simpler way is to apply a domain name to a third-
party DDNS service provider. The service can be free or charged. If you want to understand the basic concepts
of DNS and Dynamic DNS, you can refer to Wikipedia website>®.

2.7.1DNS & DDNS Configuration

Dynamic DNS

Inform
@ DDNS Server

Network-A

_ Global IP:118.18.81.33-> .44 (D WAN IP
=4 < _FQDN: mygw.no-ip.org Changed

o
§ -----------
S ~
0 \

,
Root Name Servler Public ‘.

Gateway

Local IP: 10.0.75.2
No-IP
DDNS Server

1

i

o
»
&
2
o
)

\\

E-mail Server )
Local IP: 10.0.75.101 N

File Server

Local IP: 10.0.75.102
Global IP: 118.18.81.44.

Remote User

Access E-mail Server
(mygw.no-ip.org) from Internet

To host your server on a changing IP address, you
have to use dynamic domain name service (DDNS).
Therefore, anyone wishing to reach your host only
needs to know the domain name. Dynamic DNS will
map the name of your host to your current IP
address, which changes each time you connect your
Internet service provider.

The Dynamic DNS service allows the gateway to alias
a public dynamic IP address to a static domain
name, allowing the gateway to be more easily
accessed from various locations on the Internet. As
shown in the diagram, user registered a domain

name to a third-party DDNS service provider (NO-IP) to use DDNS function.Once the IP address of designated
WAN interface has changed, the dynamic DNS agent in the gateway will inform the DDNS server with the new
IP address. The server automatically re-maps your domain name with the changed IP address. So, other hosts
or remote users in the Internet world are able to link to your gateway by using your domain name regardless of

the changing global IP address.

5 http://en.wikipedia.org/wiki/Domain_Name_System
6 http://en.wikipedia.org/wiki/Dynamic_DNS
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DNS & DDNS Setting

Go to Basic Network >DNS & DDNS>ConfigurationTab.

The DNS & DDNS setting allows user to setup Dynamic DNS feature and DNS redirect rules.

Setup Dynamic DNS

The gateway allows you to custom your Dynamic DNS settings.

= Dynamic DNS ' x
ltem Setting

» DDNS [ Enable

» WAN Interface IWAN‘l 'I

b Provider | DynDNS.org(Dynamic) -]

» Host Name I

» User Name / E-Mail |

» Passward / Key I

DDNS (Dynamic DNS) Configuration

Item Value setting Description
The box is unchecked by

DDNS Check the Enable box to activate this function.
default

WAN Interface WAN 1 is set by default Select the WAN Interface IP Address of the gateway.

Provider DynDNS.org (Dynamic) is Select your DDNS provider of Dynamic DNS. It can be DynDNS.org(Dynamic),
set by default DynDNS.org(Custom), NO-IP.com, etc...

1. String format can be any
Host Name text

2. A Must filled setting

1. String format can be any

Your registered host name of Dynamic DNS.
Value Range:0 ~ 63 characters.

User Name / E-

Mail text Enter your User name or E-mail addresss of Dynamic DNS.
2. A Must filled setting
1. String format can be any

Password / Key  text Enter your Password or Key of Dynamic DNS.
2. A Must filled setting

Save N/A Click Save to save the settings

Undo N/A ClickUndo to cancel the settings
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Setup DNS Redirect
DNS redirect is a special function to redirect certain traffics to a specified host. Administator can manage the

internet / intranet traffics that are going to access some restricted DNS and force those traffics to be redirected
to a specified host.

# DNS Redirect . ®

ltem Setting

» DNS Redirect [ Enable

DNS Redirect Configuration

Item Value setting Description
. The box is unchecked b
DNS Redirect Y Check the Enable box to activate this function.
default
Save N/A Click Save to save the settings
Undo N/A ClickUndo to cancel the settings

If you enabled the DNS Redirect function, you have to further specify the redirect rules. According to the rules,
the gateway can redirect the traffic that matched the DNS to corresponding pre-defined IP address.

= RedirectRule | -7/ Delete

Mapping Rule Condition Description

When Add button is applied,Redirect Rule screen will appear.

« Redirect Rule oo . x

ltem Setting
Domain Name P
Mapping Rule
| (* for Any)
Condition | Always - |
Description |
Enable [~ Enable

Redirect Rule Configuration

Item Value setting Description

Domain Name 1. String format can be any  Enter a domain name to be redirect. The traffic to specified domain name will
text be redirect to the following IP address.
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2. A Must filled setting Value Range:at least 1 character is required; ‘*’ for any.
1. IPv4 format .
IP Enter an IP Addressas the target for the DNS redirect.

2. A Must filled setting
Specify when will the DNS redirect action can be applied.

1. A Must filled setting It can be Always, orWAN Block.
Condition 2. Always is selected by Always: The DNS redirect function can be applied to matched DNS all the time.
default. WAN Block: The DNS redirect function can be applied to matched DNS only

when the WAN connection is disconneced, or un-reachable.
1. String format can be any
Description text
2. A Must filled setting
The box is unchecked by

Enter a brief description for this rule.
Value Range:0 ~ 63 characters.

Enable Click the Enable button to activate this rule.
default

Save N/A Click Save to save the settings

Undo N/A ClickUndo to cancel the settings
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Chapter 30bject Definition

3.1 Scheduling

Scheduling provides ability of adding/deleting time schedule rules, which can be applied to other functionality.

3.1.1 Scheduling Configuration

Go to Object Definition> Scheduling >Configuration tab.

= Time Schedule List | ;% Delete

Button description

Item Value setting Description
Add N/A Click the Add button to configure time schedule rule
Delete N/A Click the Delete button to delete selected rule(s)

When Add button is applied, Time Schedule Configurationand Time Period Definitionscreens will appear.

= Time Schedule Configuration

Item Setting

» Rule Name |

» Rule Policy Inactivate =| the Selected Days and Hours Below.

Time Schedule Configuration

Item Value Setting Description
Rule Name String: any text Set rule name
Rule Policy Default Inactivate Inactivate/activate the function been applied to in the time period below
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% Time Period Definition

D Week Day Start Time (hh:mm) End Time (hh:mm)
1 | -- choose one — +| |— I—
2 | -- choose one — j |— |—
3 | -- choose one — +| |— I—
4 | -- choose one -- j |— I—
5 | — choose one — | I— |—
6 | — choose one — | I— |—
7 | -- choose one — j I— I—
8 | — choose one — | I— |—

Time Period Definition

Item Value Setting Description

Week Day Select from menu Select everyday or one of weekday

Start Time Time format (hh :mm) Start time in selected weekday

End Time Time format (hh :mm) End time in selected weekday

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Refresh N/A Click the Refresh button to refresh the time schedule list.
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3.2User (not supported)

Not supported feature for the purchased product, leave it as blank.
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3.4 External Server

Go to Object Definition> External Server > External Server tab.

The External Server setting allows user to add external server.

Create External Server

= External Server List

Server Name Server Type Server IP/[FQDN Actions

Server Port

When Add button is applied, External Server Configuration screen will appear.

* External Server Configuration

ltem Setting

F Server Name |

I Email Server j

» Server Type User Name: |

Password: |

» Server IP/FFQDN |

+ Server Port |25

» Server [+ Enable
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Sever Name

1. String format can be
any text
2. A Must filled setting

Enter a server name. Enter a name that is easy for you to understand.

Server Type

A Must filled setting

Specify the Server Type of the external server, and enter the required settings

for the accessing the server.

Email Server (A Must filled setting) :

When Email Server is selected, User Name, and Password are also required.

User Name (String format: any text)
Password (String format: any text)

RADIUS Server (A Must filled setting) :

When RADIUS Server is selected, the following settings are also required.

Primary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Secondary :

Shared Key (String format: any text)

Authentication Protocol (By default CHAP is selected)
Session Timeout (By default 1)

The values must be between 1 and 60.

Idle Timeout: (By default 1)

The values must be between 1 and 15.

Active Directory Server (A Must filled setting) :

When Active Directory Server is selected,Domain setting is also required.

Domain (String format: any text)

LDAP Server (A Must filled setting) :

When LDAP Server is selected, the following settings are also required.
Base DN (String format: any text)

Identity (String format: any text)

Password (String format: any text)

UAM Server (A Must filled setting) :

When UAM Server is selected, the following settings are also required.
Login URL (String format: any text)

Shared Secret (String format: any text)

NAS/Gateway ID (String format: any text)

Location ID (String format: any text)

Location Name (String format: any text)
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TACACS+ Server (A Must filled setting) :

When TACACS+ Server is selected, the following settings are also required.
Shared Key (String format: any text)

Session Timeout (String format: any number)

The values must be between 1 and 60.

SCEP Server (A Must filled setting) :

When SCEP Server is selected, the following settings are also required.
Path (String format: any text, By default cgi-bin is filled)

Application (String format: any text, By default pkiclient.exe is filled)

FTP(SFTP) Server (A Must filled setting) :

When FTP(SFTP) Server is selected, the following settings are also required.
User Name (String format: any text)

Password (String format: any text)

Protocol(Select FTP or SFTP)

Encryprion(Select Plain, Explicit FTPS or Implicit FTPS)

Transfer mode(Select Passive or Active)

Server IP/FQDN

A Must filled setting

Specify the IP address or FQDN used for the external server.

Server Port

A Must filled setting

Specify the Port used for the external server. If you selected a certain server
type, the default server port number will be set.

For Email Server 25 will be set by default;

For Syslog Server, port514 will be set by default;

For RADIUS Server, port1812, 1823 will be set by default;
For Active Directory Server, port389 will be set by default;
For LDAP Server, port389 will be set by default;

For UAM Server, port3990, 4990 will be set by default;

For TACACS+ Server, port49 will be set by default;

For SCEP Server, port80 will be set by default;

For FTP(SFTP) Server, port21 will be set by default;

Value Range:1 ~ 65535.

Account Port

1. A Must filled setting
2. 1813 is set by default

Specify the accountingport used if you selected external RADIUS server.
Value Range:1 ~ 65535.

The box is checked by

Server ClickEnable to activate this External Server.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
Refresh N/A Click the Refresh button to refresh the external server list.
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3.5 Certificate

In cryptography, a public key certificate (also known as a digital certificate or identity certificate) is an
electronic document used to prove ownership of a public key. The certificate includes information about the
key, information about its owner's identity, and the digital signature of an entity that has verified the
certificate's contents are genuine. If the signature is valid, and the person examining the certificate trusts the
signer, then they know they can use that key to communicate with its owner’.

In a typical public-key infrastructure (PKI) scheme, the signer is a certificate authority (CA), usually a company
such as VeriSign which charges customers to issue certificates for them. In a web of trust scheme, the signer is
either the key's owner (a self-signed certificate) or other users ("endorsements") whom the person examining
the certificate might know and trust. The device also plays as a CA role.

Certificates are an important component of Transport Layer Security (TLS, sometimes called by its older name
SSL), where they prevent an attacker from impersonating a secure website or other server. They are also used
in other important applications, such as email encryption and code signing. Here, it can be used in IPSec
tunneling for user authentication.

7http://en.wikipedia.org/wiki/Public_key_certificate.
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3.5.1 My Certificate

My Certificate includesa Local Certificate List. Local Certificate List shows all generated certificates by the root
CA for the gateway. And it also stores the generated Certificate Signing Requests (CSR) which will be signed by
other external CAs. The signed certificates can be imported as the local ones of the gateway.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office
5 N
NS B ACS
t%__‘@\' Server A
i ]! - , llei’qel ’\.\‘D]_
pplication s Database d (9
@ e ; HQSe;er ¢ —\D Server — v b
reate 00 ’
® Create Loca (VPN Tunnel (IPSec IKE+X.509) 0 ¢ Import HQ Root CA
~ ) :
®|mp0l‘t_FI’an &'/__/ k' ©Create IPSec (IKE+X509) \\-\6 pOIT HQCRT
R ; VPN Tunnel N
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself or import any local certificates that are signed by other
external CAs. Also import the trusted certificates for other CAs and Clients. In addition, since it has the
root CA, it also can sign Certificate Signing Requests (CSR) to form corresponding certificates for others.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also import the
certificates of the root CA of the Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer
to following two sub-sections)
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Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.

Parameter Setup Example

For Network-A at HQ

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Root CA Certificate Configuration]

Name

HQRootCA

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQRootCA E-mail: hqrootca@amit.com.tw

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

HQCRT Self-signed:m

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITHQ Organization Unit(OU): HQRD
Common Name(CN): HQCRT E-mail: hgcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name 52s-101
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Local Subnet 10.0.76.0
Local Netmask 255.255.255.0
Full Tunnel Disable
Remote Subnet 10.0.75.0
Remote Netmask 255.255.255.0
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‘ Remote Gateway

118.18.81.33

Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: HQCRT Remote Certificate: BranchCRT

Local ID

User Name Network-A

Remote ID

User Name Network-B

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "My Certificate" function used
in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in following two sections to complete the

whole user scenario.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[My Certificate]-[Local Certificate Configuration]

Name

BranchCRT Self-signed:o

Key

Key Type: RSA Key Length: 1024-bits

Subject Name

Country(C): TW State(ST): Taiwan Location(L): Tainan
Organization(O): AMITBranch Organization Unit(OU): BranchRD
Common Name(CN): BranchCRT E-mail: branchcrt@amit.com.tw

Configuration Path

[IPSec]-[Configuration]

IPSec

m Enable

Configuration Path

[IPSec]-[Tunnel Configuration]

Tunnel m Enable
Tunnel Name §25-102
Interface WAN 1
Tunnel Scenario Site to Site
Operation Mode Always on

Configuration Path

[IPSec]-[Local & Remote Configuration]

Local Subnet 10.0.75.0
Local Netmask 255.255.255.0
Full Tunnel Disable
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Remote Subnet 10.0.76.0
Remote Netmask 255.255.255.0
203.95.80.22

Remote Gateway

Configuration Path

[IPSec]-[Authentication]

Key Management

IKE+X.509 Local Certificate: BranchCRT Remote Certificate: HQCRT

Local ID

User Name Network-B

Remote ID

User Name Network-A

Configuration Path

[IPSec]-[IKE Phase]

Negotiation Mode

Main Mode

X-Auth

None

Scenario Operation Procedure

In above diagram, "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. "Gateway 2" is the gateway of Network-B in branch office and the subnet of its Intranet is
10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface.
They both serve as the NAT security gateways.

Gateway 1 generates the root CA and a local certificate (HQCRT) that is signed by itself. Import the
certificates of the root CA and HQCRT into the "Trusted CA Certificate List" and "Trusted Client
Certificate List" of Gateway 2.

Gateway 2 generates a Certificate Signing Request (BranchCSR) for its own certificate (BranchCRT)
(Please generate one not self-signed certificate in the Gateway 2, and click on the "View" button for
that CSR. Just downloads it). Take the CSR to be signed by the root CA of Gateway 1 and obtain the
BranchCRT certificate (you need rename it). Import the certificate into the "Trusted Client Certificate
List" of the Gateway 1 and the "Local Certificate List" of Gateway 2.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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My Certificate Setting

Go to Object Definition> Certificate > My Certificate tab.

The My Certificate setting allows user to create local certificates.In "My Certificate" page, there are two
configuration windows for the "My Certificate" function. The "Local Certificate List" window shows the stored
certificates or CSRs for representing the gateway. The "Local Certificate Configuration" window can let you fill
required information necessary for corresponding certificate to be generated by itself, or corresponding CSR
to be signed by other CAs.

Create Local Certificate

- Add | Import | Delete

ID | Name Subject Issuer Vaild To Actions

When Add button is applied, Local Certificate Configuration screen will appear.The required information to be
filled for the certificate or CSR includes the name, key and subject name. It is a certificate if the "Self-signed"
box is checked; otherwise, it is a CSR.

Item Setting

» Mame | Self-signed : [©

b Key Key Type : I RSA .l Key Length : I 1024-hits .l Digest Algorithm : ISHA‘I ,,l
Country(C) : I State(ST) : I Location(L) : I

» Subject Name Organization(O) - | Organization Unit(OU) -

Common Name(CHN) - | E-mail - |

Challenge Password: | Unstructured Name:
» Extra Attributes I

Enable: [ SCEP Server I___ Option — j Add Object |
» SCEP Enrollment CA Certificate: I amit-IDG761AM-1H.crt j CA Encryption Certificate:
| Option --- | (Optional) CA Identifier | (Optional)
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Name 1. String format can be any  Enter a certificate name. It will be a certificate file name
text If Self-signed is checked, it will be signed by root CA. If Self-signed is not
2. A Must filled setting checked, it will generate a certificate signing request (CSR).

Key A Must filled setting This field is to specify the key attributes of certificate.

Key Type to set public-key cryptosystems. Currently, only RSA is supported.
Key Length to setthe length in bits of the key used in a cryptographic algorithm.
It can be 512/768/1024/1536/2048.
Digest Algorithm to setidentifier in the signature algorithm identifier of
certificates. It can be MD5/SHA-1.
Subject Name A Must filled setting This field is to specify the information of certificate.
Country(C) is the two-letter ISO code for the country where your organization is
located.
State(ST) is the state where your organization is located.
Location(L) is the location where your organization is located.
Organization(O) is the name of your organization.
Organization Unit(OU) is the name of your organization unit.
Common Name(CN) is the name of your organization.
Email is the email of your organization. It has to be email address setting only.
Extra Attributes A Must filled setting This field is to specify the extra information for generating a certificate.
Challenge Password for the password you can use to request certificate
revocation in the future.
Unstructured Namefor additional information.
SCEP Enrollment A Must filled setting This field is to specify the information of SCEP.
If user wants to generate a certificate signing request (CSR) and then signed by
SCEP server online, user can check the Enable box.

Select a SCEP Serverto identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object
Definition>External Server>External Server. You may click Add Object button
to generate, and the settings are the same as those defined in Section 3.4
External Server.

Select a CA Certificateto identify which certificate could be accepted by SCEP
server for authentication. It could be generated in Trusted Certificates.

Select an optional CA Encryption Certificate, if it is required,to identify which
certificate could be accepted by SCEP server for encryption data information. It
could be generated in Trusted Certificates.

Fill in optional CA Identifier to identify which CA could be used for signing
certificates.

Save N/A Click the Save button to save the configuration.
Back N/A When the Back button is clicked, the screen will return to previous page.
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When Import button is applied, an Import screen will appear. You can import a certificate from an existed
certificate file, or directly paste a PEM encoded string as the certificate.

Apply | Cancel

Bl | mims

Import
Item Value setting Description
Import A Must filled setting Select a certificate file from user’s computer, and click the Apply button to
import the specified certificate file to the gateway.
PEM Encoded 1. String format can be any  This is an alternative approach to import a certificate.
text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and
2. A Must filled setting click the Apply button to import the specified certificate to the gateway.
Apply N/A Click the Apply button to import the certificate.
Cancel N/A Click the Cancel button to discard the import operation and the screen will
return to the My Certificates page.
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3.5.2 Trusted Certificate

Trusted Certificate includes Trusted CA Certificate List, Trusted Client Certificate List, and Trusted Client Key
List. The Trusted CA Certificate List places the certificates of external trusted CAs. The Trusted Client
Certificate List places the others' certificates what you trust.And the Trusted Client Key List places the others’
keys what you trusted.

Self-signed Certificate Usage Scenario

Network-A @ HQ Data Center Network-B @ Branch Office

-~ .
Ak = | Acs
E : ‘?ﬁﬁi' Server
S
Application fex Database \
Server —LD Server

(D Creatg HQ Root (14

S
LY.

VPN Tunnel (IPSec IKE+X.509)O

@ Create Localt RootCA
@Impont Srapth ¢ | ® CreateIPSec (IKE + X.509) CRT
; —— VPN Tunnel .
Security Gateway 1 Security Gateway 2
with Root CA and Trusted with Trusted CA &
Client Certificates Client Certificates
Global IP: 203.95.80.22 Global IP: 118.18.81.33
Local IP: 10.0.76.2 Local IP: 10.0.75.2

Scenario Application Timing (same as the one described in "My Certificate" section)

When the enterprise gateway owns the root CA and VPN tunneling function, it can generate its own
local certificates by being signed by itself. Also imports the trusted certificates for other CAs and Clients.
These certificates can be used for two remote peers to make sure their identity during establishing a
VPN tunnel.

Scenario Description (same as the one described in "My Certificate" section)

Gateway 1 generates the root CA and a local certificate (HQCRT) signed by itself. Import a trusted
certificate (BranchCRT) —a BranchCSR certificate of Gateway 2 signed by root CA of Gateway 1.

Gateway 2 creates a CSR (BranchCSR) to let the root CA of the Gateway 1 sign it to be the BranchCRT
certificate. Import the certificate into the Gateway 2 as a local certificate. In addition, also imports the
certificates of the root CA of Gateway 1 into the Gateway 2 as the trusted ones. (Please also refer to
"My Certificate" and "Issue Certificate" sections).

Establish an IPSec VPN tunnel with IKE and X.509 protocols by starting from either peer, so that all
client hosts in these both subnets can communicate with each other.

Parameter Setup Example (same as the one described in "My Certificate" section)
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For Network-A at HQ

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issue Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File BranchCRT.crt

For Network-B at Branch Office

Following tables list the parameter configuration as an example for the "Trusted Certificate" function
used in the user authentication of IPSec VPN tunnel establishing, as shown in above diagram. The
configuration example must be combined with the ones in "My Certificate" and "Issued Certificate"
sections to complete the setup for the whole user scenario.

Configuration Path [Trusted Certificate]-[Trusted CA Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted CA Certificate Import from a File]
File HQRootCA.crt

Configuration Path [Trusted Certificate]-[Trusted Client Certificate List]

Command Button Import

Configuration Path [Trusted Certificate]-[Trusted Client Certificate Import from a File]
File HQCRT.crt

Scenario Operation Procedure (same as the one described in "My Certificate" section)

In above diagram, the "Gateway 1" is the gateway of Network-A in headquarters and the subnet of its
Intranet is 10.0.76.0/24. It has the IP address of 10.0.76.2 for LAN interface and 203.95.80.22 for WAN-
1 interface. The "Gateway 2" is the gateway of Network-B in branch office and the subnet of its
Intranet is 10.0.75.0/24. It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-
1 interface. They both serve as the NAT security gateways.

In Gateway 2 import the certificates of the root CA and HQCRT that were generated and signed by
Gateway 1 into the "Trusted CA Certificate List" and "Trusted Client Certificate List" of Gateway 2.
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Import the obtained BranchCRT certificate (the derived BranchCSR certificate after Gateway 1’s root
CA signature) into the "Trusted Client Certificate List" of the Gateway 1 and the "Local Certificate List"
of the Gateway 2. For more details, refer to the Network-B operation procedure in "My Certificate"
section of this manual.

Gateway 2 can establish an IPSec VPN tunnel with "Site to Site" scenario and IKE and X.509 protocols to
Gateway 1.

Finally, the client hosts in two subnets of 10.0.75.0/24 and 10.0.76.0/24 can communicate with each
other.
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Trusted Certificate Setting

Go to Object Definition> Certificate > Trusted Certificate tab.

The Trusted Certificate setting allows user to import trusted certificates and keys.

Import Trusted CA Certificate

#* Trusted CA Certificate List | i1 ¢gs

Vaild To

When Import button is applied, a Trusted CA import screen will appear.You can import a Trusted CA
certificate from an existed certificate file, or directly paste a PEM encoded string as the certificate.

= Trusted CA Certificate Import from a File | '7i]o\7 | 1850
HES... | ESEAE o

* Trusted CA Certificate Import from a PEM | 1Tv]o /8 |51 [

Trusted CA Certificate List

Item Value setting Description

Import from a A Must filled setting Select a CA certificate file from user’s computer, and click the Apply button to

File import the specified CA certificate file to the gateway.

Import from a 1. String format can be any  This is an alternative approach to import a CA certificate.

PEM text You can directly fill in (Copy and Paste) the PEM encoded CA certificate string,
2. A Must filled setting and click the Apply button to import the specified CA certificate to the gateway.

Apply N/A Click the Apply button to import the certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will

return to the Trusted Certificates page.
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Instead of importing a Trusted CA certificate with mentioned approaches, you can also get the CA certificate
from the SECP server.

If SCEP is enabled (Refer to Object Definition>Certificate >Configuration), you can click Get CA button, a Get
CA Configuration screen will appear.

= Get CA Configuration

Item Setting
» SCEP Server | — Option — ¥ || Add Object |
» CA Identifier [ | (Optional)

Get CA Configuration

Item Value setting Description

SCEP Server A Must filled setting Select a SCEP Serverto identify the SCEP server for use. The server detailed
information could be specified in External Servers. Refer to Object
Definition>External Server>External Server. You may click Add Object button

to generate.

CA Identifier 1. String format can be any  Fill in optional CA Identifier to identify which CA could be used for signing
text certificates.

Save N/A Click Save to save the settings.

Close N/A Click the Close button to return to the Trusted Certificates page.

Import Trusted Client Certificate

= Trusted Client Certificate List

Vaild To

When Import button is applied, a Trusted Client Certificate Import screen will appear.You can import a
Trusted Client Certificate from an existed certificate file, or directly paste a PEM encoded string as the
certificate.
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e | FIEIEIEE ¢

# Trusted Client Certificate Import from a PEM | /:7s)e} 7| Lo [ex]

TrustedClient Certificate List

Item Value setting Description

Import from a A Must filled setting Select a certificate file from user’s computer, and click the Apply button to import the

File specified certificate file to the gateway.

Import from a 1. String format can be any  This is an alternative approach to import a certificate.

PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate string, and click the
2. A Must filled setting Apply button to import the specified certificate to the gateway.

Apply N/A Click the Apply button to import certificate.

Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the

Trusted Certificates page.

Import Trusted Client Key

® Trusted Client Key List (/g [0

1D Name Actions

When Import button is applied, a Trusted Client Key Import screen will appear.You can import a Trusted
Client Key from an existed file, or directly paste a PEM encoded string as the key.
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LB | wmms-

*) Trusted Client Key Import from a PEM | /o] [185]) [0

TrustedClient Key List

Item Value setting Description

Import from a A Must filled setting Select a certificate key file from user’s computer, and click the Apply button to import

File the specified key file to the gateway.

Import from a 1. String format can be any  This is an alternative approach to import a certificate key.

PEM text You can directly fill in (Copy and Paste) the PEM encoded certificate key string, and click
2. A Must filled setting the Apply button to import the specified certificate key to the gateway.

Apply N/A Click the Apply button to import the certificate key.

Cancel N/A Click the Cancel button to discard the import operation and the screen will return to the

Trusted Certificates page.
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Chapter4Field Communication (not supported)

Not supported feature for the purchased product, leave it as blank.
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Chapter 5Security

5.1 VPN

A virtual private network (VPN) extends a private network across a public network, such as the Internet. It
enables a computer to send and receive data across shared or public networks as if it were directly connected
to the private network, while benefitting from the functionality, security and management policies of the
private network. This is done by establishing a virtual point-to-point connection through the use of dedicated
connections, encryption, or a combination of the two. The tunnel technology supports data confidentiality,
data origin authentication and data integrity of network information by utilizing encapsulation protocols,
encryption algorithms, and hashing algorithms.
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L e A
Access & Control Ethernet-based devices

The product series supports different tunneling technologies to establish secure tunnels between multiple
sites for data transferring, such as IPSec, OpenVPN, L2TP (over IPSec),PPTPand GRE. Besides, some advanced
functions,like Full Tunnel, Tunnel Failover, Tunnel Load Balance, NetBIOS over IPSec, NAT Traversal and
Dynamic VPN, are also supported.
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5.1.1 IPSec

Internet Protocol Security (IPSec) is a protocol suite for securing Internet Protocol (IP) communications by
authenticating and encrypting each IP packet of a communication session. IPSec includes protocols for
establishing mutual authentication between agents at the beginning of the session and negotiation of
cryptographic keys to be used during the session.

An IPSec VPN tunnel is established between IPSec client and server. Sometimes, we call the IPSec VPN client as
the initiator and the IPSec VPN server as the responder. This gateway can be configured as different roles and
establish number of tunnels with various remote devices. Before going to setup the VPN connections, you may
need to decide the scenario type for the tunneling.

IPSec Tunnel Scenarios
To build IPSec tunnel, you need to fill in
remote gateway global IP, and optional

. :_\: E :_\:/\ Network-B @
Q@ IPSec VPN Tunnel Scenario | Remots Site subnet if the hosts behind IPSec peer

Network-A @
Control Center

Host -DC

S’rbr!et:.tO‘OJS.x \ M2M s;;l:ne.zsz.zs.z.x can access to remote site or hosts.
{ \ Securl Gat H . .
%{_ i -\ Cateway Si Tewey Under such configuration, there are
............... y 7. Site’to Host .
« s %3__.4_05_”9&}»(;1_“:_ ’ \__ - four scenarios:
-~ 4. Host to Host v ___ — . .
Gibal b 20s.9s 022 |- L A T G e s o 0| Site to Site: You need to setup remote
Local IP:10.0.76.253 Responder Initiator Local IP: 192.168.1.253 P d b f both
(Server) (Client) gateway an subnet o ot
gateways. After the IPSec tunnel
€-——== > Site to Site: Tunnel between M2M gateway /w 192.168.1.x subnetand UTM /w 10.0.76.x subnet i .
e > Siteto Host: Tunnel between M2M gateway /w 192.168.1.x subnet and Host-DC under UTM esta bIIShed' hOStS behlnd bOth

€— - —> Host to Site: Tunnel between Host-Re under M2M Gateway and UTM /w 10.0.76.x subnet gateways can communication eaCh

<€— — > Hostto Host: Tunnel between Host-Re under M2M Gateway and Host-DC under UTM Other thrOUgh the tunnel'

Site to Host: Site to Host is suitable for tunneling between clients in a subnet and an application server (host).
As in the diagram, the clients behind the M2M gateway can access to the host "Host-DC" located in the
control center through Site to Host VPN tunnel.

Host to Site: On the contrast, for a single host (or mobile user to) to access the resources located in an
intranet, the Host to Site scenario can be applied.

Host to Host: Host to Host is a special configuration for building a VPN tunnel between two single hosts.
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IPSec Setting

Go toSecurity> VPN > IPSec tab.

The IPSec Setting allows user to create and configure IPSec tunnels.

Enable IPSec

= Configuration . -
Item Setting

» IPSec [JJ Enable

» Max. Concurrent IPSec Tunnels 16

Configuration Window

Item Value setting Description

IPsec Unchecked by default  Click the Enable box to enable IPSec function.

Max. Concurrent Depends on The specified value will limit the maximum number of simultaneous IPSec
IPSec Tunnels Productspecification. tunnel connection. The default value can be different for the purchased model.
Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Create/Edit IPSec tunnel

Ensure that the IPSec enable box is checked to enable before further configuring the IPSec tunnel settings.

= IPSec Tunnel List

Tunnel Name | Interface Remote Gateway Remote Subnet Enable Actions

When Add/Edit button is applied, a series of configuration screens will appear. They are Tunnel Configuration,
Local & Remote Configuration, Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec
Proposal Definition. You have to configure the tunnel details for both local and remote VPN devices.
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Item

+ Tunnel

+ Tunnel Name

+ Interface

+ Tunnel Scenario
+ Tunnel TCF MSS

+ ICMP Keep alive

+ Encapsulation Protoco
+ IKE Version

Tunnel

Tunnel Name

Interface

Tunnel Scenario

Tunel TCP MSS

ICMP Keep Alive

Encapsulation
Protocol

IKE Version

Setting
Enable
IPSec #1
WAN-1 ¥
Site-to-Site(Tunnel mode) v
Auto T |0 (64~1500 Bytes)

Enable Max. fail times |3

ESP ¥
vivy

Unchecked by default
1. A Must fill setting

2. String format can be
any text

1. A Must fill setting

2. WAN 1 is selected
by default

1. A Must fill setting
2. Site to site is
selected by default

1. An optional setting
2. Auto is set by
default

1. An optional setting
2.Unchecked by
default

1. A Must fill setting
2. ESP is selected by
default

1. A Must fill setting
2.vlis selected by
default

Interval {30 (secs.) Source Addr. Destination Addr.

Check the Enable box to activate the IPSec tunnel

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range:1 ~ 19 characters.

Select the interface on which IPSec tunnel is to be established. It can be the
available WAN and LAN interfaces.

Select an IPSec tunneling scenario from the dropdown box for your application.
Select Site-to-Site, Site-to-Host, Host-to-Site, orHost-to-Host. If LAN interface is
selected, only Host-to-Host scenario is available.

With Site-to-Site or Site-to-Host or Host-to-Site, IPSec operates in tunnel mode.
The difference among them is the number of subnets. With Host-to-Host, IPSec
operates in transport mode.

Select from the dropdown box to define the size of Tunel TCP MSS.

Select Auto, and all devices will adjust this parameter automatically.

Select Manual, andspecify an expected vaule for Tunel TCP MSS.

Value Range:64 ~ 1500bytes.

Check the Enable box to activate the ICMP keep alive function for the tunnel.

If the keep alive function is enabled, you have to define the numner of fail trials,
check interval, and source/destination IP address for the ICMP packets.

Value Range:1~999 for fail trials and time interval.

Select the Encapsulation Protocol from the dropdown box for this IPSec tunnel.
Available encapsulations are ESP and AH.

Specify the IKE version for this IPSec tunnel. Select v1 or v2.
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Item Setting
1D Subnet IP Address Subnet Mask Actions
» Local Subnet List 1 [192.168.66.0 | [ Delete |
Add
1D Subnet IP Address Subnet Mask Actions
» Remote Subnet List 1 1 255 255 255 0()24) v [ Delete |
» Remote Gateway [ T up AddressiFoDN)

Local & Remote Configuration Window

Item Value setting Description
Specify the Local Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete a Local Subnet.

. . Note_1: When Dynamic VPN option in Tunnel Scenario is selected, there will be
., A Must fill setting .
Local Subnet List only one subnet available.
Note_2: When Host-to-Site or Host-to-Host option in Tunnel Scenario is
selected, Local Subnet will not be available.
Note_3: When Hub and Spoke option in Hub and Spoke is selected, there will be
only one subnet available.
Specify the Remote Subnet IP address and Subnet Mask.
Click the Add or Delete button to add or delete Remote Subnet setting.

Remote Subnet List A Must fill setting

1. A Must fill setting.
Remote Gateway 2. Format can be a Specify the Remote Gateway.
ipv4 address or FQDN

Item Setting
+ Key Management IKE+Pre-shared Key | (Min. 8 characters)
» Local ID Type: [UserName v| ID:[ | (Optional)
» Remote 1D Type: [UserName v| ID: | |

Authentication Configuration Window

Item Value setting Description
Select Key Management from the dropdown box for this IPSec tunnel.
1. A Must fill setting IKE+Pre-shared Key:user needs to set a key (8 ~ 32characters).
Key Management 2. Pre-shared Key 8to  IKE+X.509: user needs Certificate to authenticate. IKE+X.509 will be available
32 characters. only when Certificate has been configured properly. Refer to Certificate section

of this manual and also Object Definition > Certificate in web-based utility.

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
Local ID An optional setting include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.
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Select Key ID for Local ID and enter the Key ID (English alphabet or number).
Specify the Remote ID for this IPSec tunnel to authenticate.
SelectUser Name for Remote ID and enter the username. The username may

include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Remote ID and enter the User@FQDN.

Select Key ID for Remote ID and enter the Key ID (English alphabet or number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel
Scenario is selected.

Remote ID An optional setting

ltem Setting
+ Megotiation Mode Main Mode v
» X-Auth Mone ¥ || X-Auth Account (Cptional)
UserName: | | Password: [ |
» Dead PeerDetecton (DFO) %m@oﬁlf (seconds) Delay: 30 | (seconds)
+ Phase1 Key Life Time |3EI}IIJ | (seconds) (Max. 36400)

IKE Phase Window
Item Value setting Description
Main Mode is set by Specify the Negotiation Mode for this IPSec tunnel. Select Main Mode or
default default Aggressive Mode.
Specify the X-Auth role for this IPSec tunnel. Select Server, Client, or None.
Selected None no X-Auth authentication is required.
Selected Server this gateway will be an X-Auth server. Click on the X-Auth
None is selected by Account button to create remote X-Auth client account.
default Selected Client this gateway will be an X-Auth client. Enter User name and
Password to be authenticated by the X-Auth server gateway.
Note: X-Auth Client will not be available for Dynamic VPN option selected in
Tunnel Scenario.
1. Checked by default Click Enable box to enable DPD function. Specify the Timeout and Delay time in

Negotiation Mode

X-Auth

Dead Peer Detection

(DPD) 2. Default Timeout seconds.
180s andDelay 30s Value Range: 0 ~ 999 seconds for Timeout and Delay.

1. A Must fill settin
Phasel Key Life & Specify the Phasel Key Life Time.
2. Default 3600s

Time Value Range: 30 ~ 86400.
3. Max. 86400s

= |KE Proposal Definition

[0} Encryption Authentication DH Group Definition
1 SHAT v # Enable
2 MD5 v [# Enzble
3 DES v SHA1 v Group 2« I# Enable
4 [30ES | SHAT v [Group2z 7] [# Enzble

IKE Proposal Definition Window
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Item Value setting Description
Specify the Phase 1 Encryption method. It can be DES/3DES / AES-128/AES-
192/AES-256.

Specify the Authentication method. It can be None/MD5/SHA1/SHA2-256.
IKE Proposal

Definition A Must fill setting

Specify the DH Group. It can be None/Group1/ Group2/
Group5/Group14/Group15/ Group16/Group17/ Group18.

Check Enable box to enable this setting

+ Phase2 Key Life Time |288{]l] | (seconds) (Max. 86400)

IPSec Phase Window

Item Value setting Description

1. A Must fill setting
Phase2 Key Life 2.28800s is set by Specify the Phase2 Key Life Time in second.
Time default Value Range: 30 ~ 86400.

3. Max. 86400s

= IPSec Proposal Definition

[[n]} Encryption Authentication PF S Group Definition

1 AES-128 v SHA1 v @ Enable

2 AES-128 v MD5 v Enable
LAes 8 v ) ‘

3 DES A SHA1 v # Enable

4 3DES v SHA1 v @ Enable

IPSec Proposal Definition Window

Item Value setting Description
Specify the Encryption method. It can be DES/3DES/AES-128/AES-192/AES-256.
Note: None is available when Encapsulation Protocol is set as AH.

Specify the Authentication method. It can be None/MD5/SHA1/SHA2-256.

Note: None and SHA2-256 are available only when Encapsulation Protocol is set
IPSec Proposal

.. A Must fill setting as ESP; they are not available for AH Encapsulation.

Definition
Specify the PFS Group. It can be None/Group1/ Group2/
Group5/Group14/Group15/ Group16/Group17/ Group18.
Click Enable to enable this setting

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings

Back N/A Click Back to return to the previous page.
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Create/Edit Dynamic VPN Server List

e Add || Delete || Refresh .B

Similar to create an IPSec VPN Tunnel for site/host to site/host scenario, when Add / Edit button is applied a
series of configuration screen will appear. They are Tunnel Configuration, Local & Remote Configuration,
Authentication, IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition. You have to
configure the tunnel details for the gateway as a Dynamic VPN server.

Note: For the purchased gateway, you can configure one Dynamic VPN server for each WAN interface.

Item Setting
» Tunnel [ Enable
+ Tunnel Name
» Interface
» Tunnel Scenario
» Encapsulation Protocol
» IKE Version

Tunnel Configuration Window

Item Value setting Description
Tunnel Unchecked by default ~ Check the Enable box to activate the Dynamic IPSec VPN tunnel.

1. A Must fill setting . . .

. Enter a tunnel name. Enter a name that is easy for you to identify.
Tunnel Name 2. String format can be
Value Range:1 ~ 19 characters.

any text

1. A Must fill setting
Interface 2. WAN 1 is selected Select WAN interface on which IPSec tunnel is to be established.

by default

1. A Must fill setting . . .

. . Select the Dynamic IPSec tunneling scenario. It can be Tunnel Mode or

Tunnel Scenario 2. Tunnel Mode is

Transport Mode.
selected by default P

1. A Must fill setting

Encapsulation . Select the Encapsulation Protocol from the dropdown box for this IPSec tunnel.
2. ESP is selected by . .
Protocol Available encapsulations are ESP and AH.
default
1. A Must fill setting
IKE Version 2. vl is selected by Specify the IKE version for this IPSec tunnel.
default
Item Setting
» Local Subnet
» Local Netmask |255.255 255 0(/24) v |
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Local & Remote Configuration Window

Item Value setting Description
Local Subnet A Must fill setting Specify the Local Subnet IP address.
LocalNetmask A Must fill setting Specify the Local Subnet Mask.

Item Setting
+ Key Management | IKE+Pre-shared Key ¥ | | | (Min. 8 characters)
» Local ID Type: |User Name ¥ | ID: {Cptional)
» Remote ID Type: [UserName ¥ | ID: | |

Authentication Configuration Window

Item Value setting Description
1. A Must fill setting

Key Management 2. Pre-shared Key 8 to
32 characters.

Select Key Management from the dropdown box for this IPSec tunnel.
IKE+Pre-shared Key:user needs to set a key (8 ~ 32 characters).

Specify the Local ID for this IPSec tunnel to authenticate.

Select User Name for Local ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Local ID and enter the User@FQDN.

Select Key ID for Local ID and enter the Key ID (English alphabet or number).

Local ID An optional setting

Specify the Remote ID for this IPSec tunnel to authenticate.

SelectUser Name for Remote ID and enter the username. The username may
include but can’t be all numbers.

Select FQDN for Local ID and enter the FQDN.

Select User@FQDN for Remote ID and enter the User@FQDN.

Select Key ID for Remote ID and enter the Key ID (English alphabet or number).
Note: Remote ID will be not available when Dynamic VPN option in Tunnel

Remote ID An optional setting

Scenario is selected.

For the rest IKE Phase, IKE Proposal Definition, IPSec Phase, and IPSec Proposal Definition settings, they are the
same as that of creating an IPSec Tunnel described in previous section. Please refer to the related description.
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5.1.2 OpenVPN

OpenVPN is an application that implements virtual private network (VPN) techniques for creating secure
point-to-point or site-to-site connections in routed or bridged configurations and remote access facilities. It
uses a custom security protocol that utilizes SSL/TLS for key exchange. It is capable of traversing network
address translators (NATs) and firewalls.

OpenVPN allows peers to authenticate each other using a Static Key (pre-shared key) or certificates.When
used in a multi-client-server configuration, it allows the server to release an authentication certificate for
every client, using signature and certificate authority. It uses the OpenSSL encryption library extensively, as
well as the SSLv3/TLSvlprotocol, and contains many security and control features.

OpenVPN Tunneling is a Client and Server based tunneling technology. The OpenVPN Server must have a
Static IP or a FQDN, and maintain a Client list. The OpenVPN Client may be a mobile user or mobile site with
public IP or private IP, and requesting the OpenVPN tunnel connection.The product supports both OpenVPN
Server and OpenVPN Client features to meet different application requirements.

There are two OpenVPN connection scenarios. They are the TAP and TUN scenarios. The product can create
either a layer-3 based IP tunnel (TUN), or a layer-2 based Ethernet TAP that can carry any type of Ethernet
traffic. In addition to configuring the device as a Server or Client, you have to specify which type of OpenVPN
connection scenario is to be adopted.

OpenVPN TUN Scenario
[ NetworkA@ Gontrol Ceter | The term "TUN" mode is referred to routing mode and
z operates with layer 3 packets.In routing mode, the VPN
: client is given an IP address on a different subnet than
scapa M Application

the local LAN under the OpenVPN server.This virtual
subnet is created for connecting to any remote VPN
computers.In routing mode, the OpenVPN server creates
a "TUN" interface with its own IP address pool which is

Servers

8.1

Admin User

VPN Gateway/Concentrator|  pccess from

with a “Static IP” or “FQDN” | Control Center M2M-loT Gateway
and RootCA. with “Public/Private IP” H Y H
OpenvPN TUNServer openvenunaiens | different to the local LAN. Remote hosts that dial-in will
GW  Global P: 60.249.211.108 GW: WAN IP: 192.168.168 111 get an IP address inside the virtual network and will have
FQDN : main-gw.ddns.net LAN IP: 192.168.123.254 VPN IP: 10.8.0.2 .
Local IP: 192.168.100.100 NB:  1P:102.168.123.21 VPNIP:10.8022 gCCESS only to the server where OpenVPN resides.

1. M2M-loT Gateway (as OpenVPN TUN Client) connects to peer VPN

Gateway/Concentrator (as OpenVPN TUN Server).
2. M2M-loT Gateway will be assigned 10.8.0.2 IP Address after OpenVPNTUN If you want to Offer remote access to a VPN server from
Connection estabilshed. (10.8.0.xis a virtual subnet) client(s),and inhibit the access to remote LAN resources

3. local networked device will get a virtual IP 10.8.0.x if its trafficgoes through the

OpenVPN TUN connection (when NAT disabled & Redirect Internet Trafficenabled).  ynder VPN server, OpenVPN TUN mode is the Simplest

4. SCADA Serverin Control Center can access remote attached device(s) with the .
assigned IP Address 10.8.0.2. SOIUt|On.

As shown in the diagram, the M2M-loT Gateway is configured as an OpenVPN TUN Client, and connects to an
OpenVPN UN Server. Once the OpenVPN TUN connection is established, the connected TUN client will be
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assigned a virtual IP (10.8.0.2) which is belong to a virtual subnet that is different to the local subnet in Control
Center. With such connection, the local networked devices will get a virtual IP 10.8.0.x if its traffic goes
through the OpenVPN TUN connection when Redirect Internet Traffic settings is enabled; Besides, the SCADA
Server in Control Center can access remote attached serial device(s) with the virtual IP address (10.8.0.2).

OpenVPN TAP Scenario

@i 2
y 1| serial cable

Application

servers @ (e»

X
SCADA
e

8.

Admin U
min User .E - _OpenVPN TAP D 8
VPN Gateway/Concentrator
with a “Static IP” or “FQDN” M2M-loT Gateway
and RootCA. with a “Public or
OpenVPN TAP Server Private IP”
GW  Global IP: 60.249.211.108 OpenVPNTAP Client
FQDN : main-gw.ddns.net WAN IP: 192.168.168.111

Local IP: 192.168.100.100 Local IP: 192.168.123.254

1. M2M-loT Gateway (as OpenVPN TAP Client) connects to peer VPN
Gateway/Concentrator (as OpenVPN TAP Server).

2. M2M-loT Gateway will be assigned 192.168.100.210 IP Address after
OpenVPN TAP Connection estabilshed. (same subnetasin Control Center)

3. SCADA Serverin Control Center can access remote attached device(s) with
the assigned IP Address 192.168.100.210.

The term "TAP" is referred to bridge mode and operates
with layer 2 packets. In bridge mode, the VPN client is
given an IP address on the same subnet as the LAN
residedunder the OpenVPN server.Under such
configuration, the OpenVPN client can directly access to
the resources inLAN.If you want to offer remote access to
the entire remote LAN for VPN client(s), you have to
setup OpenVPN in “TAP” bridge mode.

As shown in the diagram, the M2M-loT Gateway is
configured as an OpenVPN TAP Client, and connects to an
OpenVPN TAP Server. Once the OpenVPN TAP connection
is established, the connected TAP client will be assigned a
virtual IP (192.168.100.210) which is the same subnet as

that of local subnet in Control Center. With such connection, the SCADA Server in Control Center can access
remote attached serial device(s) with the virtual IP address (192.168.100.210).
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Open VPN Setting

Go toSecurity > VPN >OpenVPN tab.

The OpenVPN setting allows user to create and configure OpenVPN tunnels.

Enable OpenVPN

Enable OpenVPN and select an expected configuration, either server or client, for the gateway to operate.

[tem Setting
» OpenVPN [# Enable
v Server [ Client

Configuration

Item H Value setting \ Description
OpenVPN The box is unchecked by Check the Enablebox to activate the OpenVPN function.
default
Server/ Server Configuration is When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.
When Client is selected, you can specify the client settings in another client
configuration window.
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As an OpenVPN Server

If Server is selected, an OpenVPN Server Configuration screen will appear.OpenVPN Server Configuration
window can let you enable the OpenVPN server function, specify the virtual IP address of OpenVPN server,
when remote OpenVPN clients dial in, and the authentication protocol.

o ——— _@C

[tem Setting
» OpenVPM [# Enable
» Server f Client
» OpenVPN Configuration file Enablel Export | client.ovpn

Configuration

Item Value setting Description

OpenVPN
Configuration
File

1. An Optional setting. Click the Enable box to activate the export feature of OpenVPN Client
2. The box is unchecked by  configuration to a .ovpn file. You have to further click the Export button to get
default. the configuration file.

The OpenVPN Server supports up to 4 TUN / TAP tunnels at the same time.
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= OpenVPN Server Configuration

Item

Setting

» OpenVPN Server

[ Enable

» Protocol
» Port 4430 |

» Tunnel Scenario

TUN ¥

» Authorization Mode

TLS
CA Cert: |amit-IDG7681AM-JH.crt v

-

Server Cert.: | LocalCert1 =

» Server Virtual IP

|1U_8_[]_D |

» DHCP-Proxy Mode

+ Enable

» IP Pool Starting Address: | ~ Ending Address:
» Gateway | |
» Netmask | 255 255 255 0(/24) v |

» Redirect Default Gateway

» Encryption Cipher

» Hash Algorithm

2=
Al IE
=g =
- | m
L
L]

» Advanced Configuration

» LZO Compression Adaptive v

» Persist Key Enable

» Persist Tun Enable
Edit

OpenVPN Server Configuration

Item Value setting Description

OpenVPN Server | The box is unchecked by Click the Enable to activate OpenVPN Server functions.
default.
Protocol 1. A Must filled setting Define the selected Protocol for connecting to the OpenVPN Server.
2. Bydefault TCPis e Select TCP, or UDP
selected. ->The TCP protocol will be used to access the OpenVPN Server, and Port will be
set as 4430 automatically.
e Select UDP
->The UDP protocol will be used to access the OpenVPN Server, and Port will be
set as 1194 automatically.
Port 1. A Must filled setting Specify the Port for connecting to the OpenVPN Server.
2. Bydefault 4430isset. | Value Range: 1~ 65535.
Tunnel Scenario | 1. A Must filled setting Specify the type ofTunnel Scenariofor connecting to the OpenVPN Server. It can
2. Bydefault TUN s be TUN for TUN tunnel scenario, or TAP for TAP tunnel scenario.
selected.
Authorization 1. A Must filled setting Specify the authorization modefor the OpenVPN Server.
Mode 2. Bydefault TLS is e TLS
selected. ->The OpenVPN will use TLS authorization mode, and the following items CA
Cert., Server Cert. and DH PEM will be displayed.
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Local Endpoint
IP Address

Remote
Endpoint IP
Address

Static Key

Server Virtual IP

DHCP-Proxy
Mode

IP Pool

Gateway

Netmask

Redirect Default
Gateway

Encryption
Cipher

Hash Algorithm

LZO

A Must filled setting

A Must filled setting

A Must filled setting

A Must filled setting

1. A Must filled setting
2. The box is checked by
default.

A Must filled setting

A Must filled setting

By default - select one - is
selected.

1. An Optional setting.

2. The box is unchecked by
default.

1. A Must filled setting.

2. By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is

CA Cert. could be generated in Certificate. Refer to Object
Definition>Certificate>Trusted Certificate.

Server Cert. could be generated in Certificate. Refer to Object
Definition>Certificate>My Certificate.

e Static Key

->The OpenVPN will use static key (pre-shared) authorization mode, and the
following items Local Endpoint IP Address, Remote Endpoint IP Address and
Static Key will be displayed.

Note: Static Key will be available only when TUN is chosen in Tunnel Scenario.
Specify the virtualLocal Endpoint IP Address of this OpenVPN gateway.

Value Range:The IP format is 10.8.0.x,the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is chosen
in Authorization Mode.

Specify the virtualRemote Endpoint IP Address of the peer OpenVPN gateway.
Value Range:The IP format is 10.8.0.x,the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is
chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization
Mode.

Specify the Server Virtual IP.

Value Range:The IP format is 10.y.0.0,the range of y is 1~254.

Note: Server Virtual IP will be available only when TLS is chosen in Authorization
Mode.

Check the Enable box to activate the DHCP-Proxy Mode.

Note: DHCP-Proxy Mode will be available only when TAP is chosen in Tunnel
Device.

Specify the virtual IP poolsettingfor the OpenVPN server. You have to specify the
Starting Address and Ending Address as the IP address pool for the OpenVPN
clients.

Note: IP Pool will be available only when TAP is chosen in Tunnel Device, and
DHCP-Proxy Mode is unchecked (disabled).

Specify the Gatewaysetting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Note: Gateway will be available only when TAP
Device,andDHCP-Proxy Mode is unchecked (disabled).
Specify the Netmask setting for the OpenVPN server. It will be assigned to the
connected OpenVPN clients.

Value Range:255.255.255.0/24 (only support class C)

is chosen in Tunnel

Note_1: Netmask will be available when TAP is chosen in Tunnel Device,and
DHCP-Proxy Mode is unchecked (disabled).

Note_2: Netmask will also be available when TUN is chosen in Tunnel Device.
Check the Enable box to activate the Redirect Default Gateway function.

Specify the Encryption Cipher from the dropdown list.
It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithmfrom the dropdown list.
It can beSHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.
Specify the LZO Compression scheme.
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Compression
Multicast

Persis Key

Persis Tun

Advanced

Configuration

Save
Undo

selected.

1. An Optional setting.
2. The box is checked by
default.

1. An Optional setting.
2. The box is checked by
default.

1. An Optional setting.
2. The box is checked by
default.

N/A

N/A
N/A

It can beAdaptive/YES/NO/Default.
Check the Enable box to activate the Multicast function.

Note: Multicast function is only available for TAP tunnel scenario.
Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the

OpenVPN server.

If the button isclicked, Advanced Configuration will be displayed below.
Click Save to save the settings.

ClickX to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Server Advanced Configuration screen will appear.

% OpenVPN Server Advanced Configuration ®

Item Setting
» TLS Cipher 'None v |
¥ TLS Auth. Key 4
(Optional)
» Client to Client @ Enable
» Duplicate CN ¥ Enable
» Tunnel MTU 1500 |
¥ Tunnel UDP Fragment ‘U ‘
» Tunnel UDP MSS-Fix Enable

¥ CCD-Dir Default File

» Client Connection Script

» Additional Configuration

OpenVPN Server Advanced Configuration

Item H Value setting Description
TLS Cipher 1. A Must filled setting. Specify the TLS Cipher from the dropdown list.
2. TLS-RSA-WITH-AES128- It can be None /TLS-RSA-WITH-RC4-MD5 /TLS-RSA-WITH-AES128-SHA / TLS-
SHAIs selected by default RSA-WITH-AES256-SHA /TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.
Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.
TLS Auth. Key 1. An Optional setting. Specify the TLS Auth. Key.
2. String format: any text Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.
Client to Client The box is checked by Check the Enablebox to enable the traffics among different OpenVPNClients.
default Note: Client to Client will be available only when TLS is chosen in Authorization
Mode
Duplicate CN The box is checked by Check the Enablebox to activate the Duplicate CN function.
default Note: Duplicate CN will be available only when TLS is chosen in Authorization
Mode
Tunnel MTU 1. A Must filled setting Specify the Tunnel MTU.
2. The value is 1500 by Value Range: 0 ~ 1500.
default
Tunnel UDP 1. A Must filled setting Specify the Tunnel UDP Fragment.By default, it is equal to Tunnel MTU.
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Fragment

Tunnel UDP
MSS-Fix

CCD-Dir Default
File

Client
Connection
Script
Additional
Configuration

2. The value is 1500 by
default

1. An Optional setting.

2. The box is unchecked by
default.

1. An Optional setting.

2. String format: any text
1. An Optional setting.

2. String format: any text

1. An Optional setting.
2. String format: any text

Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Check theEnable box to activate the Tunnel UDP MSS-FixFunction.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
Protocol.

Specify the CCD-Dir Default File.

Value Range: 0 ~ 256 characters.

Specify the Client Connection Script.

Value Range: 0 ~ 256 characters.

Specify the Additional Configuration.
Value Range: 0 ~ 256 characters.
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As an OpenVPN Client

If Client is selected, theconfiguration screen will be changed as below and anOpenVPN Client Listscreen
appear.

= Configuration ’ x

Item Setting
» OpenVPM (] Enable
¥ Server [ Client Client »
» OpenVPN Configuration file Enable Upgrads | Interface WAN-1 v

OpenVPN Configuration

Item \ Value setting Description
OpenVPN The box is unchecked Check the Enablebox to activate the OpenVPN function.
by default
Server/ Server Configuration is When Server is selected, as the name indicated, server configuration will be
Client selected by default. displayed below for further setup.

When Client is selected, you can specify the client settings in another client
configuration window.

OpenVPN 1. An Optional setting.  Click the Enable box to activate the OpenVPN Client configuration via a pre-
Configuration file 2. The box is defined configuration file. You have to further specify the Interface to be
unchecked by default.  applied, and click the Upgrade button to upload the configuration from a .ovpn
file.

If you enabled this function, you can’t add any OpenVPN clients manually.

= OpenVPN Client List [

Redirect
Internet | NAT
Traffic

Remote | Remote Authorization Encryption

Mode

Algorithm Enable | Actions

When Add button is applied, OpenVPN Client Configuration screen will appear.OpenVPN Client Configuration
window let you specify the required parameters for an OpenVPN VPN client, such as "OpenVPN Client Name",
"Interface", "Protocol", "Tunnel Scenario", "Remote IP/FQDN", "Remote Subnet", "Authorization Mode",
"Encryption Cipher", "Hash Algorithm" and tunnel activation.
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Item Setting
» OpenVPN Client Name OpenVPN Client #1
k Interface WAN 1 v
+ Protocol TCP v | Port |443
» Tunnel Scenario TUN
» Remate IPFFQDN
Remote Subnet Enable 255.255.255.0(/24) ~
» Redirect Internat Traffic Enable
» MAT ¥ Enable
o TLS v
» Autherization Mode CACert: | | ClientCert: | ¥ | ClientKey: | ¥ | Please set the Certificate.
+ Encryption Cipher Blowfish +
¥ Hash Algorithm SHA-1 v
» LZ0 Compression Adaptive ¥
» Persist Key # Enable
» Persist Tun # Enable
» Advanced Configuration Edit
» Tunnel Enable
OpenVPN Client A Must filled setting The OpenVPN Client Name will be used to identify the client in the tunnel list.
Name Value Range:1 ~ 32 characters.
Interface 1. A Must filled setting  Define the physical interface to be used for this OpenVPN Client tunnel.
2. By default WAN-1 is
selected.
Protocol 1. A Must filled setting  Define the Protocol for the OpenVPN Client.
2. By default TCP is e Select TCP
selected. ->The OpenVPN will use TCP protocol, and Port will be set as 443 automatically.
e Select UDP
->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.
Port 1. A Must filled setting  Specify the Port for the OpenVPN Client to use.

Tunnel Scenario

Remote IP/FQDN

Remote Subnet

Redirect Internet

Traffic

NAT

2. By default443 is set.
1. A Must filled setting
2. By default TUN is
selected.

A Must filled setting

1. An Optional setting.
2. The box is
unchecked by default.
1. An Optional setting.
2. The box is
unchecked by default.
1. An Optional setting.
2. The box is checked

Value Range: 1 ~ 65535.
Specify the type ofTunnel Scenariofor the OpenVPN Client to use. It can be TUN
for TUN tunnel scenario, or TAP for TAP tunnel scenario.

Specify the Remote IP/FQDN of the peer OpenVPN Server for this OpenVPN
Client tunnel.

Fill in the IP address or FQDN.

Check the Enable box to activate remote subnet function, and specify Remote
Subnet of the peer OpenVPN Server for this OpenVPN Client tunnel.

Fill in the remote subnet address and remote subnet mask.

Check the Enable box to activate the Redirect Internet Traffic function.

Check the Enable box to activate the NAT function.
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Authorization Mode

Local Endpoint IP
Address

Remote Endpoint IP
Address

Static Key

Encryption Cipher
Hash Algorithm
LZO Compression

Multicast

Persis Key

Persis Tun

Advanced
Configuration

Tunnel

Save
Undo

by default.

1. A Must filled setting
2. By default TLS is
selected.

A Must filled setting

A Must filled setting

A Must filled setting

By default Blowfish is
selected.

By default SHA-1 is
selected.

By default Adaptive is
selected.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

1. An Optional setting.
2. The box is checked
by default.

N/A

The box is unchecked
by default

N/A

N/A

Specify the authorization modefor the OpenVPN Server.

o TLS

->The OpenVPN will use TLS authorization mode, and the following items CA

Cert., Client Cert. and Client Keywill be displayed.

CA Cert. could be selected in Trusted CA Certificate List. Refer to Object

Definition>Certificate>Trusted Certificate.

Client Cert. could be selected in Local Certificate List. Refer to Object

Definition>Certificate>My Certificate.

Client Key could be selected in Trusted Client key List. Refer to Object

Definition>Certificate>Trusted Certificate.

e Static Key

->The OpenVPN will use static key authorization mode, and the following items

Local Endpoint IP Address, Remote Endpoint IP Address and Static Key will be

displayed.

Specify the virtualLocal Endpoint IP Address of this OpenVPN gateway.
Value Range:The IP format is 10.8.0.x,the range of x is 1~254.

Note: Local Endpoint IP Address will be available only when Static Key is chosen

in Authorization Mode.

Specify the virtualRemote Endpoint IP Address of the peer OpenVPN gateway.
Value Range:The IP format is 10.8.0.x,the range of x is 1~254.

Note: Remote Endpoint IP Address will be available only when Static Key is

chosen in Authorization Mode.

Specify the Static Key.

Note: Static Key will be available only when Static Key is chosen in Authorization

Mode.

Specify the Encryption Cipher.

It can be Blowfish/AES-256/AES-192/AES-128/None.

Specify the Hash Algorithm.

It can beSHA-1/MD5/MD4/SHA2-256/SHA2-512/None/Disable.
Specify the LZO Compression scheme.

It can beAdaptive/YES/NO/Default.

Check the Enable box to activate the Multicast function.

Note: Multicast function is only available for TAP tunnel scenario.
Check the Enable box to activate the Persis Key function.

Check the Enable box to activate the Persis Tun function.

Click the Edit button to specify the Advanced Configuration setting for the

OpenVPN server.

If the button isclicked, Advanced Configuration will be displayed below.
Check theEnable box to activate this OpenVPN tunnel.

Click Save to save the settings.
ClickX to cancel the changes and return to last page.
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When Advanced Configuration is selected, an OpenVPN Client Advanced Configuration screen will appear.

» TLS Cipher

¥ User Name(Optional)
» Password{Optional)
» Bridge TAP to

+ Firewall Protection

+ Client IP Address

b Tunnel MTU

¥+ Tunnel UDP Fragment

» Tunnel UDP MSS-Fix

r nsCertType Verification

+ DNS

¢ Additional Configuration

Item

» TLS Auth. Key(Opfional)

* TLS Renegofiation Time(seconds)

» Connection Reiry({seconds)

None

Setting

| Optional)
(Cptional)
(Cptional)

VLAN 1 v

Enable

Dynamic IP

1500
1500

Enable
Enable
3600
-1

(seconds)

(seconds)

Automatically *

TLS Cipher

TLS Auth. Key

User Name

Password

Bridge TAP to

Firewall Protection

1. A Must filled setting.
2. TLS-RSA-WITH-
AES128-SHAis selected
by default

1. An Optional setting.
2. String format: any text

An Optional setting.

An Optional setting.

By default VLAN1 is
selected

The box is unchecked by
default.

Specify the TLS Cipher from the dropdown list.

It can be None /TLS-RSA-WITH-RC4-MD5 /TLS-RSA-WITH-AES128-SHA / TLS-
RSA-WITH-AES256-SHA /TLS-DHE-DSS-AES128-SHA / TLS-DHE-DSS-AES256-
SHA.

Note: TLS Cipher will be available only when TLS is chosen in Authorization
Mode.

Specify the TLS Auth. Keyfor connecting to an OpenVPN server, if the server
required it.

Note: TLS Auth. Key will be available only when TLS is chosen in Authorization
Mode.

Enter the User account for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Enter the Password for connecting to an OpenVPN server, if the server
required it.

Note: User Name will be available only when TLS is chosen in Authorization
Mode.

Specify the setting of “Bridge TAP to” to bridge the TAP interface to a certain
local network interface or VLAN.

Note: Bridge TAP to will be available only when TAP is chosen in Tunnel
Scenario and NAT is unchecked.

Check the box to activate theFirewall Protectionfunction.

Note: Firewall Protectionwill be available only when NAT is enabled.
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Client IP Address

Tunnel MTU

Tunnel UDP
Fragment

Tunnel UDP MSS-
Fix

nsCerType
Verification

TLS Renegotiation
Time (seconds)
Connection
Retry(seconds)

DNS

Additional
Configuration
Save

Undo

By default Dynamic IP is
selected

1.A Must filled setting
2.The value is 1500 by
default

The value is 1500 by
default

The box is unchecked by
default.

The box is unchecked by
default.

The value is 3600 by
default
The value is -1 by default

By default Automatically
is selected
An Optional setting.

N/A
N/A

Specify the virtual IP Address for the OpenVPN Client.
It can be Dynamic IP/Static IP.

Specify the value of Tunnel MTU.

Value Range: 0 ~ 1500.

Specify the value of Tunnel UDP Fragment.

Value Range: 0 ~ 1500.

Note: Tunnel UDP Fragment will be available only when UDP is chosen in
Protocol.

Check the Enablebox to activate the Tunnel UDP MSS-Fix function.

Note: Tunnel UDP MSS-Fix will be available only when UDP is chosen in
Protocol.

Check the Enablebox to activate the nsCerType Verification function.

Note: nsCerType Verification will be available only when TLS is chosen in
Authorization Mode.

Specify the time interval of TLS Renegotiation Time.

Value Range:-1 ~ 86400.

Specify the time interval of Connection Retry.

The default -1 means that it is no need to execute connection retry.

Value Range:-1 ~ 86400, and -1 means no retry is required.

Specify the setting ofDNS.

It can be Automatically/Manually.

Enter optional configuration string here. Up to 256 characters is allowable.
Value Range:0 ~ 256 characters.

Click Save to save the settings.

ClickX to cancel the changes and return to last page.
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5.1.3 L2TP

= Configuration ° n
Item Setting

» L2TP (] Enable

> Client

® L2TP Client Configuration ° n
Item Setting

» L2TP Client Enable

N B T A RE R RSEUTES Add | Delete || Refresh

" Remote .
D Tunnel Name Interface Virtual IP IP/FQDN Remote Subnet Status Enable Actions

Layer 2 Tunneling Protocol (L2TP) is a tunneling protocol used to support virtual private networks (VPNs) or as
part of the delivery of services by ISPs. It does not provide any encryption or confidentiality by itself. Rather, it
relies on an encryption protocol that it passes within the tunnel to provide privacy. This Gateway can behave
as a L2TP client both at the same time.

L2TP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the L2TP tunnel in the “Default Gateway / Remote Subnet”
parameter.
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Network-A @ HQ Data Center

Network-B @ Remote Office

Wil gy
Application Goger —
Ser\.rer Database ,,,L_‘_ y
k i J Pad
=
| 4 -7
z” \
Security —Em === — = — — - M2M
Gateway 2 ---_LZ_-LE.Illrlrle.l--_-( Gateway
“StaticIP” & “ ic Ip”
= 4> Dynamic IP”
2 . server Cijen v
Global IP:203.95.80.22 ~ = = = — — — = — 1 = = Global IP: 118.18.81.33

Local IP:10.0.76.2

[L2TP]-[L2TP Server Configuration] 1

L2TP over IPSec:

Enable Preshare Key, 12345678
Server Virtual IP: 192.168.101.253 2
IP Pool Starting Address: 10
IP Pool Ending Address: 50 3
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits
Service Port: 1701 4

ID1:
User Name: Client-1
Password: 1234

Create tunnel by Client,
Authentication by Server.

Server assign Virtual IP,
Tunnel created.

Client subnet can access
HQ server via tunnel.

Internet packets go through

Tunnel if “Default Gateway”

option Is enabled.

Local IP:10.0.75.2

[L2TP]-[L2TP Client Configuration]

Operation Mode: Always on

L2TP over IPSec: Enable

Preshare Key: 12345678

Remote LNS IP/FQDN: 203.95.80.22
Remote LNS Port: 1701

User Name: Client-1

Password: 1234

Remote Subnet: 10.0.76.0/24
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable,128 bits
Service Port: Auto

Besides, for the L2TP client peer, a Remote
Subnet item is required. It is for the Intranet
of L2TP server peer. So, at L2TP client peer,
the packets whose destination is in the
dedicated subnet will be transferred via the
L2TP tunnel. Others will be transferred based
on current routing policy of the gateway at
L2TP client peer. But, if you entered 0.0.0.0/0
in the Remote Subnet field, it will be treated
as a "Default Gateway" setting for the L2TP
client peer, all packets, including the Internet
accessing of L2TP client peer,will go through
the established L2TP tunnel. That means the
remote L2TP server peer controls the flow of
any packets from the L2TP client peer.
Certainly, those packets come through the
L2TP tunnel.
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L2TP Setting

Go toSecurity > VPN > L2TP tab.

The L2TP setting allows user to create and configure L2TP tunnels.

Enable L2TP

* Configuration . n

Item Setting

» L2TP [) Enable

¥ Client/Server
Enable L2TP Window
Item Value setting Description
L2TP Unchecked by default  Click the Enable box to activateL2TP function.

. Specify the role of L2TP. Select Client role your gateway will take. Below are the
Client A Must filled setting P ,fy . . . yolre Y

configuration windows for L2TP Client.

Save N/A Click Save button to save the settings

As a L2TP Client

When select Client in Client/Server, a series L2TP Client Configuration will appear.

# L2TP Client Configuration

Item Setting

» L2TP Client Enable

L2TP Client Configuration

Item Setting Value setting Description
L2TP Client The box is unchecked
Check the Enable box to enable L2TP client role of the gateway.
by default
Save N/A Click Save button to save the settings.
Undo N/A Click Undo button to cancel the settings.

Create/Edit L2TP Client
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R - [ oo | - I - | -

ID Tunnel Name Interface

Remote

Virtual IP IPIFQDN

Remote Subnet Status Enable Actions

1 L2TF #1 WAN 1

0.0.00 192.168.127.72

[ Select

When Add/Edit button is applied, a series of configuration screen will appear. You can add up to 8 L2TP

Clients.

& L2TP Client Configuration

ltem Setting
b Tunnel Mame |L2TP #1 |
v Interface WAN-1 »

v L2TP over IPsec

[[] Enable Preshared Key {Min. 2 characters) | Advancad seftings

+ Remote LNS IF/FQDN

]

 MTU 1500
» Remote LNS Port [1701

+ User Mame

L ]

+ Password

[ ]

+ Tunneling Password (Optional)

+ Remote Subnet

]

+ Authentication Protocol

(7] PAP [] CHAP [[] MS-CHAP (] MS-CHAP v2

» MPPE Encryption [C] Enable
¥ MAT before Tunneling [C] Enable
Auto -
Lo Eeno Tpe Interval 30 seconds Max. Failure Time & times
» Service Port [Auto ~| 0
» Tunnel [_] Enable

L2TP Client Configuration

Item Setting

Tunnel Name

Value setting

A Must filled setting

Description
Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range:1 ~ 32 characters.

Interface A Must filled setting

Define the selected interface to be the used for this L2TP tunnel
(WAN-1 is available only when WAN-1 interface is enabled)
The same applies to other WAN interfaces (e.g.WAN-2).

The box is unchecked
by default

L2TP over IPSec

When click the Enable box.

It will enable L2TP over IPSec and need to fill in the Pre-shared Key(2~31
characters).

Furthermore, you can also click the Advanced Settings button to specify
required settings for IKE Proposal and IPSec Proposal definitions:
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Remote LNS
IP/FQDN

MTU

Remote LNS Port

User Name

Password

Tunneling
Password(Optional)

Remote Subnet

Authentication
Protocol

MPPE Encryption

NAT before
Tunneling

LCP Echo Type

A Must filled setting

1.A Must filled setting
2.The value is 1500 by
default

1. A Must filled setting
2.1701 is set by
default

A Must filled setting

A Must filled setting

AnOptional filled
setting

A Must filled setting

1. A Must filled setting
2. Unchecked by
default

1. Unchecked by
default

2. an optional setting

1. A Must filled setting
2. Unchecked by
default

1. Auto is set by
default

Encryption method:It can be DES/3DES / AES-128/AES-192/AES-256.
Authentication method: It can be None/MD5/SHA1/SHA2-256.

DH Group: It can be None/Group1/ Group2/ Group5/Group14/Group15/
Group16/Groupl17/ Group18.

Enter the public IP address or the FQDN of the L2TP server.

Specify the MTU.
Value Range: 0 ~ 1500.

Enter the Remote LNS Port for this L2TP tunnel.
Value Range: 1 ~ 65535.

Enter the User Name for this L2TP tunnel to be authenticated when connect to
L2TP server.

Value Range:1 ~ 32 characters.

Enter the Password for this L2TP tunnel to be authenticated when connect to
L2TP server.

Enter the Tunneling Password for this L2TP tunnel to authenticate.

Specify the remote subnet for this L2TP tunnel to reach L2TP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of L2TP VPN server. So, at L2TP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the L2TP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at L2TP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the L2TP client peer, all packets, including the
Internet accessing of L2TP Client peer,will go through the established L2TP VPN
tunnel. That means the remote L2TP VPN server controls the flow of any
packets from the L2TP client peer. Certainly, those packets come through the
L2TP VPN tunnel.

Specify one ore multiple Authentication Protocol for this L2TP tunnel.
Available authentication methods are PAP/CHAP/MS-CHAP/MS-CHAPV2.

Specify whether L2TP server supports MPPE Protocol. Click the Enable box to
enable MPPE.

Note: when MPPE Encryption is enabled, the Authentication Protocol
PAP/CHAP options will not be available.

Specify whether NAT is required or not for this L2TP tunnel.

Specify the LCP Echo Type for this L2TP tunnel. It can be Auto, User-defined, or
Disable.

Auto:the system sets the Interval and Max. Failure Time.

User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.
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Service Port

Tunnel
Save
Undo

A Must filled setting

Unchecked by default
N/A
N/A

Disable: disable the LCP Echo.

Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.

Specify the Service Port for this L2TP tunnel to use. It can be Auto, (1701) for
Cisco), or User-defined

Auto:The system determines the service port.

1701 (for Cisco): The system use port 1701 for connecting with CISCO L2TP
Server.

User-defined: Enter the service port. The default value is 0.

Value Range: 0 ~ 65535.

Check the Enable box to enable this L2TP tunnel.

Click Save button to save the settings.

Click X button to cancel the settings and back to last page.
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5.1.4 PPTP

% Configuration ° o
Item Setting

' PPTP () Enable

> Client

=] PPTP Client Configuration ° o
Item Setting

» PPTP Client Enable

N R RE R BSETEN Add 8 Delete §| Refresh

. Remote .
1D Tunnel Name Interface Virtual IP IP/FQDN Remote Subnet Status Enable Actions

Point-to-Point Tunneling Protocol (PPTP) is a method for implementing virtual private networks. PPTP uses a
control channel over TCP and a GRE tunnel operating to encapsulate PPP packets. It is a client-server based
technology. There are various levels of authentication and encryption for PPTP tunneling, usually natively as
standard features of the Windows PPTP stack. The security gateway can play either "PPTP Client" role for a
PPTP VPN tunnel, or both at the same time for different tunnels. PPTP tunnel process is nearly the same as
L2TP.

PPTP Client: It can be mobile users or gateways in remote offices with dynamic IP. To setup tunnel, it should
get “user name”, “password” and server’s global IP. In addition, it is required to identify the operation mode
for each tunnel as main connection, failover for another tunnel, or load balance tunnel to increase overall
bandwidth. It needs to decide “Default Gateway” or “Remote Subnet” for packet flow. Moreover, you can also
define what kind of traffics will pass through the PPTP tunnel in the “Default Gateway / Remote Subnet”

parameter.

158



5G/LTE WAN

Extender

Network-A @ HQ Data Center

Network-B @ Remote Office
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Global IP: 203.95.80.22 ~ = = = = = = = = 1~~~ Global IP: 118.18.81.33

Local IP: 10.0.76.2

[PPTP]-[PPTP Server Configuration]

Server Virtual IP: 192.168.101.253
IP Pool Starting Address: 10
IP Pool Ending Address: 50
Authentication Protocol: MS-CHAP
MPPE Encryption: Enable, 128 bits

ID1:
User Name: Client-1
Password: 1234

Local IP: 10.0.75.2

[PPTP]-[PPTP Client Configuration]

1 Create tunnel by Client,

Authentication by Server. Operation Mode: Always on

Remote IP/FQDN: 203.95.80.22
User Name: Client-1
Password: 1234
Remote Subnet: 10.0.76.0/24
Authentication: MS-CHAP
Internet packets go through | MPPE Encryption: Enable, 128 bits
4 Tunnel if “Default Gateway”
option Is bled

2 Server assign Virtual IP,
Tunnel created.

Client subnet can access
3 HQ server via tunnel.

Certainly, those packets come through the PPTP tunnel.

Besides, for the PPTP client peer, a Remote
Subnet item is required. It is for the Intranet
of PPTP server peer. So, at PPTP client peer,
the packets whose destination is in the
dedicated subnet will be transferred via the
PPTP tunnel. Others will be transferred based
on current routing policy of the gateway at
PPTP client peer. But, if you entered 0.0.0.0/0
in the Remote Subnet field, it will be treated
as a "Default Gateway" setting for the PPTP
client peer, all packets, including the Internet
accessing of PPTP client peer,will go through
the established PPTP tunnel. That means the
remote PPTP server peer controls the flow of
any packets from the PPTP client peer.
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PPTP Setting

Go to Security> VPN > PPTP tab.

The PPTP setting allows user to create and configure PPTP tunnels.

Enable PPTP

= Configuration a a

Item Setting
» PPTP (¢ Enable
> Client

Enable PPTP Window

Item Value setting Description
PPTP Unchecked by default  Click the Enable box to activate PPTP function.
. Specify the role of PPTP. Select Client role your gateway will take. Below are
Client A Must fill setting pecify . . . Y & . Y
the configuration windows for PPTP Server and for Client.
Save N/A ClickSave button to save the settings.

As a PPTP Client

When select Client in Client, a series PPTP Client Configuration will appear.

« PPTP Client Configuration ’ n

Item Setting

» PPTP Client Enable

PPTP Client Configuration

Item Value setting Description

PPTP Client Unchecked by default ~ Check the Enable box to enable PPTP client role of the gateway.
Save N/A Click Save button to save the settings.

Undo N/A Click Undo button to cancel the settings.

Create/Edit PPTP Client

S ke R E RS ETTEY Add | Delete || Refresh
ID Tunnel Name Interface Virtual IP “R,?;:‘Q%‘ﬁ Remote Subnet Status Enable Actions
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When Add/Edit button is applied, a series PPTP Client Configuration will appear.

Item Setting
+ Tunnel Name PPTP #1
b Interface WANT ¥
+ Remote IP/FQDN
» MTU 1500
» User Name
» Password
» Remote Subnet
+ Authentication Protocol PAP [] CHAP [] MS-CHAP ] MS-CHAP v2
¥ MPPE Encryption Enable
F NAT before Tunneling Enable

Auto M

> LCF Echo Type Interval (30 seconds Max. Failure Time (G times
» Tunne| Enable

Tunnel Name

Interface

Remote IP/FQDN

MTU

User Name

Password

Remote Subnet

A Must fill setting

1. A Must fill setting

2. WANL1 is selected by
default

1. A Must fill setting.

2. Format can be a
ipv4 address or FQDN
1.A Must filled setting
2.The value is 1500 by
default

A Must fill setting

A Must fill setting

A Must fill setting

Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range:1 ~ 32 characters.

Define the selected interface to be the used for this PPTP tunnel
(WAN-1 is available only when WAN-1 interface is enabled)

The same applies to other WAN interfaces (e.g. WAN-2).

Enter the public IP address or the FQDN of the PPTP server.

Specify the MTU.
Value Range: 0 ~ 1500.

Enter the User Name for this PPTP tunnel to be authenticated when connect to
PPTP server.

Value Range:1 ~ 32 characters.

Enter the Password for this PPTP tunnel to be authenticated when connect to
PPTP server.

Specify the remote subnet for this PPTP tunnel to reach PPTP server.

The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).

It is for the Intranet of PPTP VPN server. So, at PPTP client peer, the packets
whose destination is in the dedicated subnet will be transferred via the PPTP
VPN tunnel. Others will be transferred based on current routing policy of the
security gateway at PPTP client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the PPTP client peer, all packets, including the
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Internet accessing of PPTP Client peer,will go through the established PPTP VPN
tunnel. That means the remote PPTP VPN server controls the flow of any
packets from the PPTP client peer. Certainly, those packets come through the
PPTP VPN tunnel.

Authentication 1. A Must fill setting Specify one ore multiple Authentication Protocol for this PPTP tunnel.
Protocol 2. Unchecked by Available authentication methods are PAP/CHAP/MS-CHAP/MS-CHAPv2.
default
1. Unchecked by Specify whether PPTP server supports MPPE Protocol. Click the Enable box to
default enable MPPE.

MPPE Encryption
2. an optional setting Note: when MPPE Encryption is enabled, the Authentication Protocol

PAP/CHAP options will not be available.
1. A Must filled setting  Specify whether NAT is required or not for this PPTP tunnel.

.T::nz(r:;e 2. Unchecked by
default
Auto is set by default Specify the LCP Echo Type for this PPTP tunnel. It can be Auto, User-defined, or
Disable.
Auto:the system sets the Interval and Max. Failure Time.
LCP Echo Type User-defined: enter the Interval and Max. Failure Time. The default value for
Interval is 30 seconds, and Maximum Failure Times is 6 Times.
Disable: disable the LCP Echo.
Value Range: 1 ~ 99999 for Interval Time, 1~999 for Failure Time.
Tunnel Unchecked by default ~ Check the Enable box to enable this PPTP tunnel.
Save N/A Click Save button to save the settings.
Undo N/A Click X button to cancel the settings and back to last page.
5.1.5 GRE
[tem Setting
» GRE Tunne Enable
+ Max. Concurrent GRE Tunnels 32
Add J| Delete
ID| Tunnel Name Interface Tunnel IP Remote [P MTU | Key | TTL Remote Subnet Enable Actions

Generic Routing Encapsulation (GRE) is a tunneling protocol developed by Cisco Systems that encapsulates a
wide variety of network layer protocols inside virtual point-to-point links over an Internet Protocol
internetwork.

Deploy a M2M gateway for remote site and establish a virtual private network with control center by using
GRE tunneling. So, all client hosts behind M2M gateway can make data communication with server hosts
behind control center gateway.
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GRE Tunneling is similar to IPSec Tunneling, client requesting the tunnel establishment with the server. Both
the client and the server must have a Static IP or a FQDN.Any peer gateway can be worked as either a client or
a server, even using the same set of configuration rule.

GRE Tunnel Scenario

Network-A @ HQ Data Center Network-B @ Remote Office
=e
WD el
Application o] Mickr
52___“:'“ Database el By
>
i
i
st
Security M2M
Gateway Gateway
“StaticlP” “Static IP”
N
Global IP: 203.95.80.22 — = = = — = — = — 1~ — Global IP: 118.18.81.33

Local IP: 10.0.76.2

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 203.95.80.22
Remote IP: 118.18.81.33

Key: 1234

TTL: 255

Remote Subnet: 10.0.75.0/24
DMVPN Spoke: Disable
Tunnel: Enable

Create tunnel by Client,
Authentication by Server.

Any peer gateway can be
both Client & Server, and
must have Static IP or FQDN.

Client subnet can access
Server subnet via tunnel.

Internet packets go through
Tunnel if “Default Gateway”
option Is enabled.

Local IP: 10.0.75.2

[GRE]-[GRE Rule Configuration]

Tunnel Name: GRE_A_B
Interface: WAN-1

Operation Mode: Always on
Tunnel IP: 118.18.81.33
Remote IP: 203.95.80.22

Key: 1234

TTL: 255

Remote Subnet: 10.0.76.0/24
DMVPN Spoke: Disable
Tunnel: Enable

To setup a GRE tunnel, each peer needs to
setup its global IP as tunnel IP and fill in the
other's global IP as remote IP.

Besides, each peer must further specify the
Remote Subnet item. It is for the Intranet of
GRE server peer. So, at GRE client peer, the
packets whose destination is in the dedicated
subnet will be transferred via the GRE tunnel.
Others will be transferred based on current
routing policy of the gateway at GRE client peer.
But, if you entered 0.0.0.0/0 in the Remote
Subnet field, it will be treated as a "Default
Gateway" setting for the GRE client peer, all
packets, including the Internet accessing of
GREclient peer,will go through the established

GRE tunnel. That means the remote GRE server peer controls the flow of any packets from the GRE client peer.
Certainly, those packets come through the GRE tunnel.

If the GRE server supports DMVPN Hub function, like Cisco router as the VPN concentrator, the GRE client can
active the DMVPN spoke function here since it is implemented by GRE over IPSec tunneling.

163



5G/LTE WAN Extender

GRE Setting

Go to Security> VPN > GRE tab.

The GRE setting allows user to create and configure GRE tunnels.

Enable GRE
= Configuration ’ n
Item Setting
» GRE Tunnel () Enable
» Max. Concurrent GRE 32
Tunnels
Enable GRE Window
Item Value setting Description
GRE Tunnel Unchecked by default  Click the Enable box to enable GRE function.
Max. Concurrent Depends on The specified value will limit the maximum number of simultaneous GRE tunnel
GRE Tunnels Productspecification. connection. The default value can be different for the purchased model.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Create/Edit GRE tunnel

# GRE Tunnel List

ID| Tunnel Hame Interface Tunnel IP Remote IP MTU Key TTL Remote Subnet Enable Actions

When Add/Edit button is applied, a GRE Rule Configuration screen will appear.
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Item Setting
» Tunnel Name ‘GRE #1 |
» Interface
» Tunnel IP IP: | | MASK: | - select one - v | (Option
» Remote IP ‘ ‘
> MTU ]
r Key ‘ ‘ (Optional)
» TTL ]

¥ Remote Subnet

¥ Tunnel

|
() Enable

GRE Rule Configuration Window

Item Value setting

Tunnel Name A Must fill setting

Description
Enter a tunnel name. Enter a name that is easy for you to identify.
Value Range:1 ~ 9 characters.

1. A Must fill setting

Select the interface on which GRE tunnel is to be established. It can be the

Interface 2. WAN 1 is selected . .
available WAN and LAN interfaces.
by default
Tunnel IP An Optional setting Enter the Tunnel IP address and corresponding subnet mask.
. . Enter the Remote IP address of remote GRE tunnel gateway. Normally this is the
Remote IP A Must fill setting

public IP address of the remote GRE gateway.

1. A Must filled setting
MTU 2. Auto (value zero or
blank) is set by default

MTU refers to Maximum Transmission Unit. It specifies the largest packet size
permitted for Internet transmission.

When set to Auto (value ‘0’ or blank), the router selects the best MTU for best
Internet connection performance.

Value Range:0 ~ 1500.

Key An Optional setting

Enter the Key for the GRE connection.
Value Range: 0 ~ 9999999999.

1. A Must fill setting

Specify TTLhop-count value for this GRE tunnel.

m 2. 1to 255 range Value Range: 1 ~ 255.
Specify the remote subnet for this GRE tunnel.
The Remote Subnet format must be IP address/netmask (e.g. 10.0.0.2/24).
It is for the Intranet of GRE server peer. So, at GRE client peer, the packets
whose destination is in the dedicated subnet will be transferred via the GRE
Remote Subnet A Must fill setting tunnel. Others will be transferred based on current routing policy of the security

gateway at GRE client peer.

If you entered 0.0.0.0/0 in the Remote Subnet field, it will be treated as a
default gateway setting for the GRE client peer, all packets, including the
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Tunnel
Save
Undo

Unchecked by default
N/A
N/A

Internet accessing of GREclient peer,will go through the established GRE tunnel.

That means the remote GRE serverpeer controls the flow of any packets from
the GRE client peer. Certainly, those packets come through the GRE tunnel.
Check Enable box to enable this GRE tunnel.

Click Save button to save the settings.

ClickX button to cancel the settings and back to last page.

166



5G/LTE WAN Extender

5.2 Firewall

Internet
Sessions | - — — o -
M2M-loT <J——— Allow/ Sspecific destination port TCP/UDP
-—
Gateway =.|“" Deny Specific Destination IP Address

1 o
(( )) .._: Allow | specific key word of URL
I

MAC Control
i [
—.Q;: Block  Specific P2P Software
Application Filter
B et Rl el Applicati
3=, Block Lotsof TCP/UDP/ICMP Farvers |
| attack packe
ttack kets
IPS

Local
Access & Control

The firewall functions include Packet Filter, URL Blocking, Content Filter, MAC Control, Application Filter, IPS
and some firewall options. The supported function can be different for the purchased gateway.

5.2.1 Packet Filter

Item Setting
» Packet Filters + Enable
» Black List / White List Deny those match the following rules.
¥ Log Alert Log Alert
o Add Delete
D Rule From To Destination | Source Source Destination Time

Source IP P MAC Protocol Schedule Enable Actions

Name | Interface Interface Port Port
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"Packet Filter" function can let you define some filtering rules for incoming and outgoing packets. So the
gateway can control what packets are allowed or blocked to pass through it. A packet filter rule should
indicate from and to which interface the packet enters and leaves the gateway, the source and destination IP
addresses, and destination service port type and port number. In addition, the time schedule to which the rule
will be active.

Packet Filter with White List Scenario

As shown in the diagram, specify "Packet Filter Rule
List" as white list (Allow those match the following

Denied to pass for non-http packets.
(packets not dest. to TCP port 80 / 443)

- Xe--- -’3‘57””““P"”f"""""“’”’/””"/" rules) anddefine the rules. Rule-1is to allow HTTP
. m%e—. or @ @ & packets to pass, and Rule-2 is to allow HTTPS packets
- ~ Gateway N
Allowed to Pass "\_\ % % ~ to paSS
{pn‘ckets with TCP Poff&'ﬂ‘/ﬂﬂg}.____ User Group 192.168.123.2007250

Access “http://www.abc.com/”

Rule Name : Allow HTTP_HTTPS | Destination IP: Any

From Interface : Any Destination Port :

To Interface : Any HTTP (TCP:80) for Rule-1,

Source IP: 192.168.123.200 HTTPs (TCP:443) for Rule-2
192.168.123.250 Protocol : TCP

Black List / White List: Allow those
match the following rules

Packet Filter Setting

Under such configuration, the gateway will allow only
HTTP and HTTPS packets, issued from the IP range
192.168.123.200 to 250, which are targeted to TCP
port 80 or 443 to pass the WAN interface.

Go to Security> Firewall >Packet Filter Tab.

The packet filter setting allows user to create and customize packet filter policies to allow or reject specific
inbound/outbound packets through the router based on their office setting.

EnablePacket Filter

Item

» Packet Filters Enable

» Black List / White List

v Log Alert Log Alert

The box is unchecked by
default

Packet Filter

Setting

Deny those match the following rules. »

Check the Enable box to activate Packet Filter function
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When Deny those match the following rules is selected, as the name suggest,
] Deny those match the e . . .
Black List / . . packets specified in the rules will be blocked —black listed. In contrast, with
L following rules is set by . o -
White List default Allow those match the following rules, you can specifically white list the
efau
packets to pass and the rest will be blocked.
The box is unchecked b
Log Alert v Check the Enable box to activate Event Log.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit Packet Filter Rules

The gateway allows you to customize your packet filtering rules. It supports up to a maximum of 20 filter rule
sets.

= Packet Filter List [[XE] [EEECH

Source IP

Destination Source |Destination

IP

Enable Actions

Protocol Schedule

When Add button is applied,Packet Filter Rule Configuration screen will appear.

%1 Packet Filter Rule Configuration

Item Setting
» Rule Mame |Rule1 |
+ From Interface Any v
» Tolnterface Ay v
» Source P |Aﬂy v |
» Destination IP |Aﬂy v |
¥ Source MAC |Aﬂy \d |
» Protocol
» Source Part 'User-defined Senvice v | - |
» Destination Port User-defined Service v | | - |
¥ Time Schedule
» Rule [ Enable

Packet Filter Rule Configuration

Item Name Value setting Description
1. String format can be . .
Enter a packet filter rule name. Enter a name that is easy for you to remember.
Rule Name any text
. . Value Range: 1 ~ 30 characters.
2. A Must filled setting
From Interface 1. A Must filled setting Define the selected interface to be the packet-entering interface of the router.
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To Interface

Source IP

Destination IP

Source MAC

Protocol

2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any is
selected

1. A Must filled setting
2. By default Any(0) is
selected

If the packets to be filtered are coming from LAN to WAN then select LANfor
this field. Or VLAN-1 to WAN then select VLAN-1 for this field. Other examples
are VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets coming into the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

Define the selected interface to be the packet-leaving interface of the router. If
the packets to be filtered are entering from LAN to WAN then select WAN for
this field. Or VLAN-1 to WAN then select WAN for this field. Other examples are
VLAN-1 to VLAN-2. VLAN-1 to WAN.

Select Any to filter packets leaving the router from any interfaces.

Please note that two identical interfaces are not accepted by the router. e.g.,
VLAN-1 to VLAN-1.

This field is to specify the Source IP address.

Select Any to filter packets coming from any IP addresses.

Select Specific IP Address to filter packets coming from an IP address.

Select IP Range to filter packets coming from a specified range of IP address.
Select IP Address-based Group to filter packets coming from a pre-defined
group. Note: group must be pre-defined before this option become available.
Refer to Object Definition>Grouping > Host grouping. You may also access to
create a group by the Add Rule shortcut button.

This field is to specify the Destination IP address.

Select Any to filter packets that are entering to any IP addresses.

Select Specific IP Address to filter packets entering to an IP address entered in
this field.

Select IP Range to filter packets entering to a specified range of IP address
entered in this field.

Select IP Address-based Group to filter packets entering to a pre-defined group
selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition>Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button. Setting done through
the Add Rule button will also appear in the Host grouping setting screen.

This field is to specify the SourceMACaddress.

Select Any to filter packets coming from any MAC addresses.

Select Specific MAC Address to filter packets coming from a MAC address.
Select MAC Address-based Group to filter packets coming from a pre-defined
group selected. Note: group must be pre-defined before this selection become
available. Refer to Object Definition>Grouping > Host grouping. You may also
access to create a group by the Add Rule shortcut button.

For Protocol, select Any to filter any protocol packets

Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.

Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
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Value Range:1 ~ 65535 for Source Port, Destination Port.

For Protocol, select ICMPv4 to filter ICMPv4 packets
For Protocol, select TCP to filter TCP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range:1 ~ 65535 for Source Port, Destination Port.
For Protocol, select UDP to filter UDP packets
Then for Source Port, select a predefined port dropdown box when Well-known
Service is selected, otherwise select User-defined Service and specify a port
range.
Then for Destination Port, select a predefined port dropdown box when Well-
known Service is selected, otherwise select User-defined Service and specify a
port range.
Value Range:1 ~ 65535 for Source Port, Destination Port.
For Protocol, select GRE to filter GRE packets
For Protocol, select ESP to filter ESP packets
For Protocol, select SCTP to filter SCTP packets
For Protocol, select User-defined to filter packets with specified port number.
Then enter a pot number in Protocol Number box.
Apply Time Schedule to this rule, otherwise leave it as Always.

Time Schedule A Must filled setting If the dropdown list is empty ensure Time Schedule is pre-configured. Refer to
Object Definition> Scheduling >Configuration tab.

The box is unchecked by

Rule Click Enable box to activate this rule then save the settings.
default.

Save N/A Click Save to save the settings.

Undo N/A Click X to cancel the settings and back to last page.
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5.2.2URL Blocking (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.3 MAC Control

Item

» MAC Control ¥ Enahle

» Black List / White List

» Log Alert Enahble

v Knowen MAC fram LAN PC List v | Copyto
- Add Delste

1D Rule Name MAC Address

Setting

Deny MAC Address Below. v

Time Schedule Rule Enable Actions

"MAC Control" function allows you to assign the accessibility to the gateway for different users based on
device’s MAC address.When the administrator wants to reject the traffics from some client hosts with specific
MAC addresses, he can use the "MAC Control" function to reject with the black list configuration.

MAC Control with Black List Scenario

MACAddress : “20:6A:6A:6A:6A:6B”
Denied to access Internet.

WAN

MAC Address : “00:50:18:99:99:011
Allowed to access Internet. I

IR Nl

Staff

Black List / White List:

Rule Name : Deny_JP
Deny MAC Address Below.

MAC Address : 20:6A:6A:6A:6A:6B

20:6A:6A:6A:6A:6B

00:50:18:99:99:01

As shown in the diagram, enable the MAC control
function and specify the "MAC Control Rule List" is
a black list, and configure one MAC control rule for
the gateway to deny the connection request from
the "JP NB" with its own MAC address
20:6A:6A:6A:6A:6B.

System will block the connecting from the "JP NB"
to the gateway but allow others.
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MAC Control Setting

Go to Security> Firewall > MAC Control Tab.

The MAC control setting allows user to create and customize MAC address policies to allow or reject packets
with specific source MAC address.

Enable MAC Control

® Configuration . x

Item Setting
» MAC Control [ Enable
» Black List / White List | Deny MAC Address Below. v
¥ Log Alert Enahle
¥ Known MAC from LAN PC List EI

Configuration Window

Item Value setting Description

The box is unchecked b
MAC Control default Y Check the Enable box to activate the MAC filter function
efau
When Deny MAC Address Below is selected, as the name suggest, packets
Black List / Deny MAC Address Below  specified in the rules will be blocked —black listed. In contrast, with Allow MAC
White List is set by default Address Below, you can specifically white list the packets to pass and the rest
will be blocked.
The box is unchecked b
Log Alert default Y Check the Enable box to activate to activate Event Log.
Known MAC N/A Select a MAC Address from LAN Client List. Click the Copy to to copy the
from LAN PC List selected MAC Address to the filter rule.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings
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Create/Edit MAC Control Rules

The gateway supports up to a maximum of 20 filter rule sets. Ensure that the MAC Control is enabled before
we can create control rules.

® MAC Control Rule List -' ..

MAC Address

Rule Name Time Schedule Rule Actions

When Add button is applied,Filter Rule Configuration screen will appear.

# MAC Control Rule Configuration ®

Rule Name MAC Address (Use : to Compose) Time Schedule | Enable

Rule1 ||| | [(0)Aways v | | [

MAC Control Rule Configuration

Item Value setting Description
1. String format can be any

Rule Name text Enter a MAC Control rule name. Enter a name that is easy for you to remember.
2. A Must fill setting

MAC Address 1. MAC Address string

(Use: to Format Specify the Source MAC Address to filter rule.

Compose) 2. A Must fill setting

Apply Time Schedule to this rule; otherwise leave it as (0) Always.
Time Schedule A Must fill setting If the dropdown list is empty, ensure Time Schedule is pre-configured. Refer to
Object Definition> Scheduling >Configuration tab

The box is unchecked by

Enable default Click Enable box to activate this rule, and then save the settings.
ult.

Save N/A Click Save to save the settings

Undo N/A Click Undo to cancel the settings
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5.2.4Content Filter (not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.5Application Filter(not supported)

Not supported feature for the purchased product, leave it as blank.
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5.2.6 IPS

Item
v IPS Enable
» Log Alert Enable

Item
+ SYN Flood Defense Enable |300
» UDP Flood Defense Enable 300
v ICMP Flood Defense Enable |300

» Port Scan Defense Enable (200

Setting

Setting
FPackets/second (10~10000)
Fackets/second (10~10000)
Packets/second (10~10000)

Packets/second (10~10000)

To provide application servers in the Internet, administrator may need to open specific ports for the services.
However, there are some risks to always open service ports in the Internet. In order to avoid such attack risks,

it is important to enable IPS functions.

Intrusion Prevention System(IPS) is network security appliances that monitor network and/or system activities
for malicious activity. The main functions of IPS are to identify malicious activity, log information about this
activity, attempt to block/stop it and report it. You can enable the IPS function and check the listed intrusion
activities when needed. You can also enable the log alerting so that system will record Intrusion events when

corresponding intrusions are detected.

IPS Scenario

Block lots of TCP attack packets to
Remote administration port: 8080 X Gateway
Global IP: 118.18.81.200

Local IP:192.168.1.253

Attackers

Block lots of TCP attack packets to
Mail Server :SMTP 25, POP3 110

[IPS]-[Configuration]

Block lots of TCP attack packets to
Web Server : HTTP 80, HTTPS 443

| IPS: Enable |
Intrusion Prevention \

SYN Flood Defense Mail Server (port: 25,110)
Port Scan Detection Local IP: 192.168.1.2
Block IP Spoof

Block TCP Flag Scan

Wed Server (port: 80, 443)
Local IP: 192.168.1.3

As shown in the diagram, the gateway serves
as an E-mail server, Web Server and also
provides TCP port 8080 for remote
administration.So, remote users or unknown
users can request those services from Internet.
With IPS enabled, the gateway can detect
incoming attack packets, including the TCP
ports (25, 80,110,443 and 8080) with services.
It will block the attack packets and let the
normal access to pass through the gateway
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IPS Setting

Go to Security> Firewall >IPS Tab.

The Intrusion Prevention System (IPS) setting allows user to customize intrusion prevention rules to prevent
malicious packets.

EnablelPS Firewall
:
Item Setting
v IPS [C] Enable
b Log Alert Enable

Configuration Window

Item H Value setting \ Description
The box is unchecked b
IPS Y Check the Enable box to activate IPS function
default
The box is unchecked b
Log Alert Y Check the Enable box to activate to activate Event Log.
default
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Setup Intrusion Prevention Rules

The router allows you to select intrusion prevention rules you may want to enable. Ensure that the IPS is
enabled before we can enable the defense function.
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# Intrusion Prevention . x
ltem Setting
» SYN Flood Defense Enable Packets/second (10~10000)
» UDP Flood Defense Enable Packets/second (10~10000)
» ICMP Flood Defense Enable Packets/second (10~10000)
» Port Scan Defense Enable Packets/second (10~10000)
» Block Land Attack Enable
» Block Ping of Death Enable
» Block IP Spoof Enable
» Block TCP Flag Scan Enable
» Block Smurf Enable
» Block Traceroute Enable
» Block Fraggle Attack Enable
» ARP Spoofing Defense Enable Packets/second (10~10000)
Setup Intrusion Prevention Rules
Item Name Value setting Description
SYN Flood Click Enable box to activate this intrusion prevention rule and
Defense 1. A Must filled setting enter the traffic threshold in this field.
UDP Flood 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defense 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
ICMP Flood 4. The value range can be from 10 to Click Enable box to activate this intrusion prevention rule and
oo
10000. enter the traffic threshold in this field.
Defense
Value Range: 10 ~ 10000.
1. A Must filled setting
Port Scan 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defection 3. Traffic threshold is set to 200 by default enter the traffic threshold in this field.
4. The value range can be from 10 to Value Range: 10 ~ 10000.
10000.
Block Land
Attack
Block Ping of
Death
Block IP Spoof
Block TCP Flag  The box is unchecked by default. Click Enable box to activate this intrusion prevention rule.
Scan
Block Smurf
Block
Traceroute
Block Fraggle
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Attack
1. A Must filled setting
ARP Spoofing 2. The box is unchecked by default. Click Enable box to activate this intrusion prevention rule and
Defence 3. Traffic threshold is set to 300 by default enter the traffic threshold in this field.
4. The value range can be from 10 to Value Range: 10 ~ 10000.
10000.
Save NA Click Save to save the settings
Undo NA Click Undo to cancel the settings
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5.2.7 Options

« Firewall Options ’ x
ftem Setting

» Stealth Mode [[] Enable

F SP| Enable

v Discard Ping from WAN (] Enable

= Remote Administrator Host Definition | x

Service
ID | Interface Protocol P Subnet Mask Enable | Action
Port

1| AllWAN HTTPS Any IP NIA 443
2 | AlWAN HTTPS Any IP NIA 443
3 | AllWAN HTTPS Any IP NIA 443
4 | AlWAN HTTPS Any IP NIA 443
5 | AlWAN HTTPS Any IP NIA 443

There are some additional useful firewalloptions in this page.

“Stealth Mode” lets gateway not to respond to port scans from the WAN so that makes it less susceptible to
discovery and attacks on the Internet. ”SPI1” enables gateway to record the packet information like IP address,
port address, ACK, SEQ number and so on while they pass through the gateway,and the gateway checks every
incoming packet to detect if this packet is valid.

“Discard Ping from WAN” makes any host on the WAN side can't ping this gateway. And finally, “Remote
Administrator Hosts” enables you to perform administration task from a remote host. If this feature is enabled,
only specified IP address(es) can perform remote administration.
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Enable SPI Scenario

Dst IP and Port

118.18.81.200: 1999 DstIP and Port

SrcIP and Port 203.95.80.22 : 80

200.10.10.10: 80 SrcIPand Port Gafeway

118.18.81.200: 1999

________ I%__-'X\ =~
[y ------7 WP = - - - - ,_

Unknown User
With Portscan Utility
Global IP: 200.10.10.10

Dst IP and Port
118.18.81.200: 1999
SrcIPand Port
203.95.80.22: 80

Cloud Server
Global IP: 203.95.80.22

/Nétwork-A \

. GlobalIP: 118.18.81.200 “

As shown in the diagram, Gateway has the IP
address of 118.18.81.200 for WAN interfaceand
192.168.1.253 for LAN interface. It serves as a NAT
gateway.Users in Network-A initiate to access
cloud server through the gateway. Sometimes,
unknown users will simulate the packets but use
different source IP to masquerade. With the SPI
feature been enabled at the gateway, it will block
such packets from unknown users.

Discard Ping from WAN& Remote Administrator Hosts Scenario

Use “Ping tool” to detect if Global IP is existed,

- The gateway doesn’t reply such requests.
—
- - - -
- S~
Unknown User S~
=~ ~  Global IP:118.18.81.200

~  Local IP:192.168.1.253

v
Gateway

e 4 c X

& (= - -

Remote Admin. Remote Admin. can access Gateway GUI
via Browser “Http.// 118.18.81.200:8080"

“Discard Ping from WAN” makes any host on the
WAN side can't ping this gateway reply any ICMP
packets.Enable the Discard Ping from WAN function
to prevent security leak when local users surf the
internet.

Remote administratorknows the gateway’s global IP,
and he can access the Gateway GUI via TCP port
8080.
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Firewall Options Setting

Go to Security> Firewall >Options Tab.

The firewall options setting allows network administrator to modify the behavior of the firewall and to enable
Remote Router Access Control.

Enable Firewall Options

= Firewall Options . .
[tem Setting

b Stealth Mode [l Enable

» SPI Enable

» Discard Ping from WAN [] Enable

Firewall Options

Item \ Value setting \ Description
The box is unchecked by . .
Stealth Mode default Check the Enable box to activate the Stealth Mode function
The box is checked by . .
SPI Check the Enable box to activate the SPI function
default
Discard Pi The box i hecked b
f iscard Hing = DOXIS ENENECREC Y Check the Enable box to activate the Discard Ping from WAN function
rom WAN default

Define Remote Administrator Host

The router allows network administrator to manage router remotely. The network administrator can assign
specific IP address and service port to allow accessing the router via designated WAN interface.
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« Remote Administrator Host Definition - n
Service
ID | Interface Protocol P Subnet Mask Enable | Action
Port

1 | AllWAN HTTPS Any IP NIA 443 O
2 | AllWAN HTTPS Any IP NIA 443 T || Edit
3 | AlWAN HTTPS Any IP N/A 443 O
4 | AllWAN HTTPS Any IP NIA 443 || Edit
5 | AllWAN HTTPS Any IP NIA 443 T || Edit

Remote Administrator Host Definition

Item Value setting Description

Protocol HTTPS is set by default Select HTTP or HTTPS method for remoteadministration.

This field is to specify the remote host to assign access right for remote access.
Select Any IP to allow any remote hosts

P A Must filled setting Select Specific IP to allow the remote host coming from a specific subnet. An IP
address entered in this field and a selected Subnet Mask to compose the
subnet.

1. 80 for HTTP by default o . . .
This field is to specify a Service Port to HTTP or HTTPS connection.

Service Port 2. 443 for HTTPS by
Value Range:1 ~ 65535.

default

Enabling the The box is unchecked b
& Y Click Enable box to activate this rule.

rule default.
Save N/A Click Enable box to activate this rule then save the settings.
Undo N/A Click Undo to cancel the settings
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Chapter 6Administration

6.1Configure & Manage

M2M-loT
Gateway

N

Access & Control

Local Access & Control

: Linux Script  amit CLI

L/bin/sh

TRO69

@' SNMP;

Telnet / Console with CLI

Configure & Manage refers to enterprise-wide administration of distributed systems including (and commonly
in practice) computer systems. Centralized management has a time and effort trade-off that is related to the
size of the company, the expertise of the IT staff, and the amount of technology being used. This device
supports many system management protocols, such as Command Script, TR-069, SNMP, and Telnet with CLI.

You can setup those configurations in the "Configure & Manage" section.
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6.1.1Command Script

Command scriptconfiguration is the application that allows administrator to setup the pre-defined
configuration in plain text style and apply configuration on startup.

Go to Administration>Command Script>Configuration Tab.

Enable Command Script Configuration

Item Setting
» Command Script Enable
» Backup Script Via Web Ul
» Upload Script Via Web Ul
¥ Script Name
¥ Version
» Description

&

» Update time 2019-04-08T18:05:31

The box is unchecked by

Command Script
default

Check the Enable box to activate the Command Script function.

. Click the Via Web Ul or Via Storage button to backup the existed command
Backup Script N/A L . . L . .
script in a .txt file. You can specify the script file name in Script Name below.

. Click the Via Web Ul or Via Storage button to Upload the existed command
Upload Script N/A , . )
script from a specified .txt file.

Specify a script file name for script backup, or display the selected upload script
1.An Optional setting

Script Name o file name.

2.Any valid file name
Value Range:0 ~ 32 characters.

Version 1.An Optional setting Specify the version number for the applied Command script.

2.Any string Value Range:0 ~ 32 characters.
. 1.An Optional setting . . .

Description . Enter a short description for the applied Command script.
2.Any string

Update time N/A It records the upload time for last commad script upload.
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Edit/Backup Plain Text Command Script

* Command Script Editor

0765280

You can edit the plain text configuration settings in the configuration screen as above.
Plain Text Configuration

Item Value setting Description

Clean NA Clean text area. (You should click Save button to further clean the configuration
already saved in the system.)

Backup NA Backup and download configuration.

Save NA Save configuration

The supported plain text configuration items are shown in the following list. For the settings that can be
executed with standard Linux commands, you can put them in a script file, and apply to the system configure
with STARTUP command. For those configurations without corresponding Linux command set to configure,
you can configure them with proprietary command set.

Configuration Content

Key Value setting Description

OPENVPN_ENABLED 1:enable Enable or disable OpenVPN Client function.
0 : disable

OPENVPN_DESCRIPTION A Must filled Specify the tunnel name for the OpenVPN Client connection.
Setting

OPENVPN_PROTO udp Define the Protocol for the OpenVPN Client.
tcp e Select TCP or TCP /UDP

->The OpenVPN will use TCP protocol, and Port will be set as 443
automatically.

e Select UDP

->The OpenVPN will use UDP protocol, and Port will be set as 1194
automatically.

OPENVPN_PORT A Must filled Specify the Port for the OpenVPN Client to use.
Setting
OPENVPN_REMOTE_IPADDR IP or FQDN Specify the Remote IP/FQDN of the peer OpenVPN Server for this

OpenVPN Client tunnel.
Fill in the IP address or FQDN.
OPENVPN_PING_INTVL seconds Specify the time interval for OpenVPN keep-alive checking.
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OPENVPN_PING_TOUT
OPENVPN_COMP
OPENVPN_AUTH

OPENVPN_CA_CERT
OPENVPN_LOCAL_CERT
OPENVPN_LOCAL_KEY
OPENVPN_EXTRA_OPTS
IP_ADDR1

IP_NETM1
PPP_MONITORING

PPP_PING

PPP_PING_IPADDR

PPP_PING_INTVL

STARTUP

seconds
Adaptive
Static Key/TLS

A Must filled
Setting

A Must filled
Setting

A Must filled
Setting
Options

Ip

Net mask
1:enable

0 : disable

0 : DNS Query
1:ICMP Query

IP
seconds

Script file

Specify the timeout value for OpenVPN Client keep-alive checking.
Specify the LZO Compression algorithm for OpenVPN client.

Specify the authorization modefor the OpenVPN tunnel.

o TLS

->The OpenVPN will use TLS authorization mode, and the following
items CA Cert., Client Cert. and Client Key need to specify as well.
Specify the Trusted CA certificate for the OpenVPN client. It will go
through Base64 Conversion.

Specify the local certificate for OpenVPN client. It will go through
Base64 Conversion.

Specify the local key for the OpenVPN client. It will go through Base64
Conversion.

Specify the extra options setting for the OpenVPN client.

Ethernet LAN IP

Ethernet LAN MASK

When the Network Monitoring feature is enabled, the router will use
DNS Query or ICMP to periodically check Internet connection —
connected or disconnected.

With DNS Query, the system checks the connection by sending DNS
Query packets to the destination specified in PPP_PING_IPADDR.
With ICMP Query, the system will check connection by sending ICMP
request packets to the destination specified in PPP_PING_IPADDR.
Specify an IP address as the target for sending DNS query/ICMP
request.

Specify the time interval for between two DNS Query or ICMP
checking packets.

For the configurations that can be configured with standard Linux
commands, you can put them in a script file, and apply the script file
with STARTUP command.

For example,

STARTUP=#!/bin/sh

STARTUP=echo “startup done” > /tmp/demo

Plain Text System Configuration with Telnet

In addition to the web-style plain text configuration as mentioned above, the gateway system also allow the
configuration via Telnet CLI. Administrator can use the proprietary telnet command “txtConfig” and related
action items to perform the plain system configuration.

The command format is: txtConfig (action) [option]

clone Output file

Duplicate the configuration content from database and stored as a
configuration file.

(ex: txtConfig clone /tmp/config)

The contents in the configuration file are the same as the plain text commands
mentioned above. This action is exactly the same as performing the “Backup”
plain text configuration.
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commit

enable

disable
run_immediately

run_immediately

a existing file
NA
NA
NA

a existing file

Commit the configuration content to database.

(ex: txtConfig commit /tmp/config)

Enable plain text system config.

(ex: txtConfig enable)

Disable plain text system config.

(ex: txtConfig disable)

Apply the configuration content that has been committed in database.
(ex: txtConfig run_immediately)

Assign a configuration file to apply.

(ex: txtConfig run_immediately /tmp/config)
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6.1.2 TR-069

TR-069 (Technical Report 069) is a Broadband Forum technical specification entitled CPE WAN Management
Protocol (CWMP). It defines an application layer protocol for remote management of end-user devices, like this
gateway device. As a bidirectional SOAP/HTTP-based protocol, it provides the communication between
customer-premises equipment (CPE) and Auto Configuration Servers (ACS). The Security Gateway is such CPE.

TR-069 is a customized feature for ISP. It is not recommend that you change the configuration for this. If you
have any problem in using this feature for device management, please contact with your ISP or the ACS
provider for help. At the right upper corner of TR-069 Setting screen, one “[Help]” command let you see the
same message about that.

Scenario - Managing deployed gateways through an ACS Server

r Gatewayn
i\-.\g
Gateway 2
3
° Gateway 1
§ e — y
Global IP:
ACS 118.18.81.33
Server

Scenario Application Timing

When the enterprise data center wants to use an ACS server to manage remote gateways
geographically distributed elsewhere in the world, the gateways in all branch offices must have an
embedded TR-069 agent to communicate with the ACS server. So that the ACS server can configure,
FW upgrade and monitor these gateways and their corresponding Intranets.

Scenario Description
The ACS server can configure, upgrade with latest FW and monitor these gateways.
Remote gateways inquire the ACS server for jobs to do in each time period.

The ACS server can ask the gateways to execute some urgent jobs.
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Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "TR-069" enabling.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path [TR-069]-[Configuration]
TR-069 m Enable

ACS URL http://qa.acslite.com/cpe.php
ACS User Name ACSUserName

ACS Password ACSPassword
ConnectionRequest Port 8099

ConnectionRequest User Name ConnReqUserName
ConnectionRequest Password ConnReqPassword

Inform m Enable Interval 900

Scenario Operation Procedure

In above diagram, the ACS server can manage multiple gateways in the Internet. The "Gateway 1" is
one of them and has 118.18.81.33 IP address for its WAN-1 interface.

When all remote gateways have booted up, they will try to connect to the ACS server.

Once the connections are established successfully, the ACS server can configure, upgrade with latest
FW and monitor these gateways.

Remote gateways inquire the ACS server for jobs to do in each time period.

If the ACS server needs some urgent jobs to be done by the gateways, it will issue the "Connection
Request" command to those gateways. And those gateways make immediate connections in response
to the ACS server’s immediate connection request for executing the urgent jobs.
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TR-069 Setting

Go to Administration>Configure & Manage > TR-069 tab.

In "TR-069" page, there is only one configuration window for TR-069 function. In the window, you must
specify the related information for your security gateway to connect to the ACS.Drive the function to work by
specifying the URL of the ACS server, the account information to login the ACS server, the service port and the
account information for connection requesting from the ACS server, and the time interval for job inquiry.
Except the inquiry time, there are no activities between the ACS server and the gateways until the next inquiry
cycle. But if the ACS server has new jobs that are expected to do by the gateways urgently, it will ask these
gateways by using connection request related information for immediate connection for inquiring jobs and
executing.

Enable TR-069

= Configuration . %
Item Setting

» TR-069 Enable

¥ Interface

¢ Data model | ACS Cloud Data Model v |

» ACS URL |

b ACS UserName | |

» ACS Passwaord | |
¥ Connection Request Port 6099

b Connection Request UserMame | |

¥ Connection Request Password | |

v Inform #| Enable Interval

*  default

Select from Certificate List

Certificate:

» Certification Setup

Value setting Description
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TR-069

Interface

Data Model

ACS URL
ACS Username
ACS Password

ConnectionRequest
Port

ConnectionRequest
UserName

ConnectionRequest
Password

Inform

Certification Setup

Save
Undo

The box is unchecked by
default

WAN-1 is selected by
default.

ACS Cloud Data Model
is selected by default.

A Must filled setting
A Must filled setting
A Must filled setting

1. A Must filled setting.
2. By default 8099 is set.

A Must filled setting

A Must filled setting

1. The box is checked by

default.
2. The Interval value is
300 by default.

The default box is
selected by default

N/A
N/A

Check the Enable box to activate TR-069 function.

When you finish set basic network WAN-1~ WAN-n, you can choose WAN-1~
WAN-n

When you finish set Security>VPN> IPSec/OpenVPN/PPTP/L2TP/GRE, you can
choose IPSec/OpenVPN/PPTP/L2TP/GRE tunnel, the interface just like“IPSec
#1”

Select the TR-069 dat model for the remote management.

Standard : the ACS Server is a standard one, which is fully comply with TR-
069.

ACS Cloud Data Model : Select this data model if you intend to use Cloud ACS
Server to managing the deployed gateways.

You can ask ACS manager provide ACS URL and manually set

You can ask ACS manager provide ACS username and manually set

You can ask ACS manager provide ACS password and manually set

You can ask ACS manager provide ACS ConnectionRequest Port and manually
set

Value Range:0 ~ 65535.

You can ask ACS manager provide ACS ConnectionRequest Username and
manually set

You can ask ACS manager provide ACS ConnectionRequest Password and
manually set

When theEnable box is checked, the gateway (CPE)will periodicly send inform
message to ACS Server according to the Interval setting.
Value Range: 0 ~ 86400 for Inform Interval.

You can leave it as default or select an expected certificate and key from the
drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Click Save to save the settings.

Click Undo to cancel the modifications.

When you finish set ACS URL ACS Username ACS Password, your gateway (CPE, Client Premium Equipment)
can send inform to ACS Server.

When vyou finish

set

ConnectionRequest

PortConnectionRequest Username ConnectionRequest

Password,ACS Server can ask the gateway (CPE) to send inform to ACS Server.

Enable STUN Server
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« STUN Settings ' »

Item Setting

v STUN + Enable

F Server Address | |

¥ Server Port (1~-65535)
» Keep Alive Period 0 | (0~65535)second(s)

STUN Settings Configuration

Item Value setting Description

The box is checked b
STUN def Itx I y Check the Enable box to activate STUN function.
efau

1. String format: any

Server Address IPva address Specify the IP address for the expected STUN Server.

2. It is an optional item.

. . Specify the port number for the expected STUN Server.
1. An optional setting

2.3478 is set by default

Server Port
Value Range:1 ~ 65535.

. . Specify the keep alive time period for the connection with STUN Server.
1. An optional setting

Keep Alive Period
2.0 is set by default

Value Range:0 ~ 65535.
Save N/A Click Save to save the settings.
Undo N/A Click Undo to cancel the modifications.
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6.1.3 SNMP

In brief, SNMP, the Simple Network Management Protocol, is a protocol designed to give a user the capability
to remotely manage a computer network by polling and setting terminal values and monitoring network
events.

In typical SNMP uses, one or more administrative computers, called managers, have the task of monitoring or
managing a group of hosts or devices on a computer network. Each managed system executes, at all times, a
software component called an agent which reports information via SNMP to the manager.

SNMP agents expose management data on the managed systems as variables. The protocol also permits active
management tasks, such as modifying and applying a new configuration through remote modification of these
variables. The variables accessible via SNMP are organized in hierarchies. These hierarchies, and other
metadata (such as type and description of the variable), are described by Management Information Bases
(MIBs).

The device supports several public MIBs and one private MIB for the SNMP agent. The supported MIBs are as
follow:MIB-II (RFC 1213, Include IPv6), IF-MIB, IP-MIB, TCP-MIB, UDP-MIB, SMIv1l and SMIv2, SNMPv2-TM and
SNMPv2-MIB, and AMIB (a Proprietary MIB)

SNMP Management Scenario

Gatewayn

Remote NMS Gateway 2
118.18.81.22 X
8 @/ —H'M'PV Satewny
Remote NMS LAN IP:10.0.75.2
118.18.81.11 et:10.0.75.0/24
LN
@@} %@} %@} Ei

\ Intranet

10.0.75.100

Scenario Application Timing

There are two application scenarios of SNMP Network Management Systems (NMS). Local NMS is in
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the Intranet and manage all devices that support SNMP protocol in the Intranet. Another one is the
Remote NMS to manage some devices whose WAN interfaces are connected together by using a
switch or a router with UDP forwarding. If you want to manage some devices and they all have
supported SNMP protocol, use either one application scenario, especially the management of devices
in the Intranet. In managing devices in the Internet, the TR-069 is the better solution. Please refer to

last sub-section.

Scenario Description

The NMS server can monitor and configure the managed devices by using SNMP protocol, and those

devices are located at where UDP packets can reach from NMS.
The managed devices report urgent trap events to the NMS servers.
Use SNMPv3 version of protocol can protected the transmitting of SNMP commands and responses.

The remote NMS with privilege IP address can manage the devices, but other remote NMS can't.

Parameter Setup Example

Following tables list the parameter configuration as an example for the Gateway 1 in above diagram
with "SNMP" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the tables.

Configuration Path

[SNMP]-[Configuration]

SNMP Enable

m LAN m WAN

Supported Versions

mvl mv2c mv3

Get / Set Community

ReadCommunity / WriteCommunity

Trap Event Receiver 1

118.18.81.11

WAN Access IP Address

118.18.81.11

Configuration Path

[SNMP]-[User Privacy Definition]

ID 1 2 3

User Name UserNamel UserName2 UserName3
Password Password1 Password2 Disable
Authentication MD5 SHA-1 Disable
Encryption DES Disable Disable
Privacy Mode authPriv authNoPriv noAuthNoPriv
Privacy Key 12345678 Disable Disable
Authority Read/Write Read Read

Enable m Enable m Enable m Enable

Scenario Operation Procedure

In above diagram, the NMS server can manage multiple devices in the Intranet or a UDP-reachable
network. The "Gateway 1" is one of the managed devices, and it has the IP address of 10.0.75.2 for
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LAN interface and 118.18.81.33 for WAN-1 interface. It serves as a NAT router.

At first stage, the NMS manager prepares related information for all managed devices and records
them in the NMS system. Then NMS system gets the status of all managed devices by using SNMP get
commands.

When the manager wants to configure the managed devices, the NMS system allows him to do that by
using SNMP set commands. The "UserNamel" account is used if the manager uses SNMPv3 protocol
for configuring the "Gateway 1". Only the "UserNamel" account can let the "Gateway 1" accept the
configuration from the NMS since the authority of the account is "Read/Write".

Once a managed device has an urgent event to send, the device will issue a trap to the Trap Event
Receivers. The NMS itself could be one among them.

If you want to secure the transmitted SNMP commands and responses between the NMS and the
managed devices, use SNMPv3 version of protocol.

The remote NMS without privilege IP address can't manage the "Gateway 1", since "Gateway 1" allows
only the NMS with privilege IP address can manage it via its WAN interface.
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SNMP Setting

Go to Administration>Configure & Manage >SNMP tab.

The SNMP allows user to configure SNMP relevant setting which includes interface, version, access control

and trap receiver.

Enable SNMP

Item
» SNMP Enable
» WAN Interface
» Supported Versions
» SNMP Port

» Trap Period

» Limited Remote Access IP

SNMP Enable

WAN Interface

Supported Versions

SNMP Port

Setting

v/ LAN WAN

All WANs v

v vl ¥ v2c v3

161

10 (1~1440 minutes)

Specific IP Address v
(IP Address/FQDN) Enable
(IP Address/FQDN) Enable
(IP Address/FQDN) Enable
(IP Address/FQDN) Enable
(IP Address/FQDN) Enable

1.The boxesare
unchecked by default

1.A Must filled setting
2. ALL WANs is
selected by default

1.A Must filled setting
2.The boxes
areunchecked by
default

1. String format: any
port number
2. The default SNMP

Select the interface for the SNMP and enable SNMP functions.

When Check the LAN box, it will activate SNMP functions and you can access
SNMP from LAN side;

When Check the WAN boyx, it will activate SNMP functions and you can access
SNMP from WAN side.

Specify the WAN interface that a remote SNMP host can access to the device.
By default, All WANS is selected, and there is no limitation for the WAN
inferface.

Select the version for the SNMP

When Check the vibox.

It means you can access SNMP by version 1.

When Check the v2cbox.

It means you can access SNMP by version 2c.

When Check the v3box.

It means you can access SNMP by version 3.

Specify the SNMP Port.

You can fill in any port number. But you must ensure the port number is not to
be used.
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portis 161.

3. A Must filled setting
Specify the Remote Access IP for WAN and check the box to enable it as well.
Select Specific IP Address, and fill in a certain IP address. It means only this IP
address can access SNMP fromLAN/WAN side.

Value Range:1 ~ 65535.

1. String format: any

Limited Remote IPv4 address

Select IP Range, and fill in a range of IP addresses. It means the IP address

Aceess IP 2. It is an optional o . ;
it within specified range can access SNMP fromLAN/WAN side.
item.
If you left it as blank, it means any IP address can access SNMP fromWAN side.
Save N/A Click Save to save the settings
Undo N/A Click Undo to cancel the settings

Create/Edit Multiple Community

The SNMP allows you to custom your access control for version 1 and version 2 user. The router supports up to
a maximum of 10 community sets.

* Muitiple Community List [ZX2N

Community

Enable Actions

When Add button is applied,Multiple Community Rule Configuration screen will appear.

ltem Setting

'Read Only v |
[+ Enable

» Community

» Enable

Multiple Community Rule Configuration

Item Value setting
1. Read Only is

selected by default

Description

Specify this version 1 or version v2c user’s community that will be allowed Read
Only (GET and GETNEXT) or Read-Write(GET, GETNEXT and SET) access

Community 2. A Must filled setting .
. respectively.
3. String format: any . o
rext The maximum length of the community is 32.
ex
1.The box is checked
Enable Click Enable to enable this version 1 or version v2c user.
by default
Click the Save button to save the configuration. But it does not apply to SNMP
Save N/A functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Undo N/A Click theUndobutton to cancel the settings.
Back N/A Click the Back button to return to last page.

200



5G/LTE WAN Extender

Create/Edit User Privacy

The SNMP allows you to custom your access control for version 3 user. The router supports up to a maximum
of 128 User Privacy sets.

* User Privacy List [JXeh

Password | Authentication | Encryption

OID Filter
Prefix

Privacy
Key

Authority Enable| Actions

When Add button is applied,User Privacy Rule Configuration screen will appear.

# User Privacy Rule Configuration

ltem Setting

¥ User Mame

v Password

v Authentication Mone v

» Encryption Monge v

¥ Privacy Mode noAuthMoPriv v

¥ Privacy Key

v Authority Read v

=

» QID Filter Prefix

«
m
g
w
o
m

¥ Enahle A

User Privacy Rule Configuration

Item ] Value setting Description
User Name 1. A Must filled setting  Specify the User Name for this version 3 user.
2. String format: any Value Range: 1 ~ 32 characters.
text
Password 1. String format: any When your Privacy Mode is authNoPriv or authPriv, you mustspecify the
text Password for this version 3 user.
Value Range: 8 ~ 64 characters.
Authentication 1. None is selected by ~ When your Privacy Mode is authNoPriv or authPriv, you mustspecify the
default Authentication types for this version 3 user.
Selected the authentication types MD5/ SHA-1 to use.
Encryption 1. None is selected by ~ When your Privacy Mode is authPriv, you mustspecify the Encryption protocols
default for this version 3 user.
Selected the encryption protocols DES / AES to use.
Privacy Mode 1. noAuthNoPriv is Specify the Privacy Mode for this version 3 user.

201



5G/LTE WAN Extender

selected by default

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You mustspecify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

Privacy Key 1. String format: any When your Privacy Mode is authPriv, you mustspecify the Privacy Key(8 ~ 64
text characters)for this version 3 user.
Authority 1. Read is selected by Specify this version 3 user’sAuthority that will be allowed Read Only (GET and

OID Filter Prefix

default

1. The default value is
1

2. A Must filled setting
3. String format: any

GETNEXT) or Read-Write (GET, GETNEXT and SET) access respectively.
The OID Filter Prefix restricts access for this version 3 user to the sub-tree
rooted at the given OID.

Value Range:1 ~2080768.

legal OID
Enable 1.The box is checked Click Enable to enable this version 3 user.
by default
Save N/A Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Undo N/A Click theUndobutton to cancel the settings
Back N/A Click the X button to return the last page.

Create/Edit Trap Event Receiver

The SNMP allows you to custom your trap event receiver. The router supports up to a maximum of 4 Trap
Event Receiver sets.

- Add Delete
ID Selrpver Sggrf'- U‘?:;';‘; Cowam”l;l;lity hl.l-lasn%l; Password Fﬂ;g? Authentication | Encryption F‘r}i{x;fcy Enable |Actions

When Add button is applied,Trap Event Receiver Rule Configuration screen will appear. The default SNMP
Version is v1. The configuration screen will provide the version 1 must filled items.
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@ Trap Event Receiver Rule Configuration

ltem Setting
b Server IP | | (IP Address/FQDMN)
¥ Server Port 1162
¥ SNMP Version A
¥ Community Name | |
» Enable Enable

When you selected v2c,the configuration screen is exactly the same as that of v1, except the version.

When you selected v3,the configuration screen will provide more setting items for the version 3 Trap.

# Trap Event Receiver Rule Configuration

ltem Setting
» Server IP | | (IP Address/FQDN)
¥ Server Port 162
¥ SNMP Version vl v

¥ Community Name |

b User Name |

» Password |

¥ Privacy Mode

'noAuthNoPriv v |

b Authentication

Mone -

¥ Encryption

¥ Privacy Key

» Enable

| Enable

Trap Event Receiver Rule Configuration

Item

Value setting
1. A Must filled setting

Description

Specify the trap Server IPor FQDN.

Server IP 2. String format: any .
The DUT will send trap to the server IP/FQDN.
IPv4 address or FQDN
1. String format: an
& Y Specify thetrap Server Port.
port number s .
You can fill in any port number. But you must ensure the port number is not to
Server Port 2. The default SNMP
) be used.
trap port is 162 Value R 1~ 65535
alue Range:1~ .
3. A Must filled setting
SNMP Version 1. vl is selected by Select the version for the trap
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Community Name

User Name

Password

Privacy Mode

Authentication

Encryption

Privacy Key

Enable

Save

Undo
Back

default

1. Avl and v2c Must
filled setting

2. String format: any
text

1. A v3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. String format: any
text

1. Av3 Must filled
setting

2. noAuthNoPriv is
selected by default

1. A v3 Must filled
setting

2. None is selected by
default

1. Av3 Must filled
setting

2. None is selected by
default

1. A v3 Must filled
setting

2. String format: any
text

1.The box is checked
by default

N/A

N/A
N/A

Selected the v1.

The configuration screen will provide the version 1 must filled items.
Selected the v2c.

The configuration screen will provide the version 2c must filled items.
Selected the v3.

The configuration screen will provide the version 3 must filled items.

Specify the Community Name for this version 1 or version v2c trap.
Value Range: 1 ~ 32 characters.

Specify the User Name for this version 3 trap.
Value Range: 1 ~ 32 characters.

When your Privacy Mode is authNoPriv or authPriv, you mustspecify the
Password for this version 3 trap.
Value Range: 8 ~ 64 characters.

Specify the Privacy Mode for this version 3 trap.

Selected the noAuthNoPriv.

You do not use any authentication types and encryption protocols.

Selected the authNoPriv.

You mustspecify the Authentication and Password.

Selected the authPriv.

You must specify the Authentication, Password, Encryption and Privacy Key.

When your Privacy Mode is authNoPriv or authPriv, you mustspecify the
Authentication types for this version 3 trap.
Selected the authentication types MD5/ SHA-1 to use.

When your Privacy Mode is authPriv, you mustspecify the Encryption protocols
for this version 3 trap.
Selected the encryption protocols DES / AES to use.

When your Privacy Mode is authPriv, you mustspecify the Privacy Key(8 ~ 64
characters)for this version 3 trap.

Click Enable to enable this trap receiver.

Click the Save button to save the configuration. But it does not apply to SNMP
functions. When you return to the SNMP main page. It will show “Click on save
button to apply your changes” remind user to click main page Save button.
Click theUndobutton to cancel the settings.

Click the X button to return to last page.
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Specify SNMP MIB-2System

If required, you can also specify the required information for the MIB-2 System.

& SNMP MIB-2 System

Item

Setting

b sysContact

» sysLocation

SNMPMIB-2 System Configuration

Item
sysContact

Value setting

1. AnOptional filled

setting
2. String format: any
text

Description
Specify the contact information forMIB-2 system.
Value Range:0 ~ 64 characters.

sysLocation

1. AnOptional filled
setting

2. String format: any
text

Specify the location information forMIB-2 system.
Value Range:0 ~ 64 characters.

Edit SNMP Options

If you use some particular private MIB, you must fill the enterprise name, number and OID.

= Options

ltem

Setting

¥ Enterprise Name

¥ Enterprise Number

12823

¥ Enterprise QID

136.14.1.[12823449 |

Options
Item

EnterpriseName

Value setting
1. The default value is

Default

2. A Must filled setting
3. String format: any
text

Description

Specify the EnterpriseName for the particular private MIB.
Value Range: 1 ~ 10 characters, and only string with A~Z, a~z, 0~9, "=/, “_".

Enterprise Number

The default value is
12823
(Default Enterprise

Specify the EnterpriseNumber for the particular private MIB.
Value Range:1 ~2080768.
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Enterprise OID

Save

Undo

Number)

2. A Must filled setting
3. String format: any
number

1. The default value is
1.3.6.1.4.1.12823.4.4.9
(Default Enterprise OID)
2. A Must filled setting
3. String format: any
legal OID

N/A

N/A

Specify the EnterpriseOID for the particular private MIB.

The range of the each OID number is 1-2080768.

The maximum length of the enterpriseOID is 31.

The seventh number must be identical with the enterprise number.

Click the Save button to save the configuration and apply your changes to
SNMP functions.
Click theUndobutton to cancel the settings.
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6.1.4 Telnet & SSH

A command-line interface (CLI), also known as command-line user interface, and console user interfaceare
means of interacting with a computer program where the user (or client) issues commands to the program in
the form of successive lines of text (command lines). The interface is usually implemented with a command
line shell, which is a program that accepts commands as text input and converts commands to appropriate
operating system functions. Programs with command-line interfaces are generally easier to automate via
scripting. The device supports both Telnet and SSH (Secure Shell) CLI with default service port 23 and 22,

respectively.

Telnet & SSH Scenario

Network-A

Gateway

Global IP: 118.18.81.33
Local IP: 10.0.75.2

&3

"( - T SSFI' Encryption ~

Remote Admin
140.116.82.98

Scenario Application Timing

When the administrator of the gateway wants to manage it from remote site in the Intranet or
Internet, he may use "Telnet with CLI" function to do that by using "Telnet" or "SSH" utility.

Scenario Description

The Local Admin or the Remote Admin can manage the Gateway by using "Telnet" or "SSH" utility

Local Admin
10.0.75.100

with privileged user name and password.

The data packets between the Local Admin and the Gateway or between the Remote Admin and the
Gateway can be plain texts or encrypted texts. Suggest they are plain texts in the Intranet for Local
Admin to use "Telnet" utility, and encrypted texts in the Internet for Remote Admin to use "SSH"
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utility.

Parameter Setup Example

Following table lists the parameter configuration as an example for the Gateway in above diagram
with "Telnet with CLI" enabling at LAN and WAN interfaces.

Use default value for those parameters that are not mentioned in the table.

Configuration Path [Telnet & SSH]-[Configuration]

Telnet LAN:m Enable WAN:[1 Enable
Service Port:23

SSH LAN:m Enable WAN:m Enable
Service Port:22

Scenario Operation Procedure

In above diagram, "Local Admin" or "Remote Admin" can manage the "Gateway" in the Intranet or
Internet. The "Gateway" is the gateway of Network-A, and the subnet of its Intranet is 10.0.75.0/24.
It has the IP address of 10.0.75.2 for LAN interface and 118.18.81.33 for WAN-1 interface. It serves

as a NAT gateway.
The "Local Admin" in the Intranet uses "Telnet" utility with privileged account to login the Gateway.

Or the "Remote Admin" in the Internet uses "SSH" utility with privileged account to login the
Gateway.

The administrator of the gateway can control the device as like he is in front of the gateway.
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Telnet & SSHSetting

Go to Administration>Configure &Manage > Telnet & SSH tab.

The Telnet & SSH setting allows administrator to access this device through the traditional Telnet or SSH
Telnet program. Before you can telnet (login) to the device, please configure the related settings with care.

% Configuration ° n

Item Setting
LAN [ Enable
WAN (] Enable (WAN-1 | )
b Telnet ‘ . |
Service Port |23
LAN [ | Enable
WAN [ ] Enable (WAN-1 )

» SSH ‘

]

Service Port |22

Configuration

Value setting

The LAN Enable box is

checked by default.

2. By default Service
Port is 23.

Item
Telnet 1.

Description

Check the Enable box to activate the Telnet function for connecting from LAN or WAN
interfaces.

You can set which number of Service Port you want to provide for the corresponding
service.

Value Range: 1 ~65535.

The LAN Enable box is
checked by default.
4. By default Service

SSH 3.

Check the Enable box to activate the SSH Telnet function for connecting from LAN or
WAN interfaces.

You can set which number of Service Port you want to provide for the corresponding
service.

Port is 22.
Value Range: 1 ~65535.
Save N/A Click Save to save the settings
Undo N/A ClickUndo to cancel the settings

Note: The Telnet/SSH login password is the same one as the administrator’s login password for the device

web GUL.
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6.2 System Operation

System Operation allows the network administrator to manage system, settings such as web-based utility
access password change, system information, system time, system log, firmware/configuration backup &
restore, and reset & reboot.

6.2.1 Password & MMI

Go toAdministration> System Operation>Password & MMitab.

SetupHost Name

Host Name screen allows network administrator to setup / change the host name of the gateway. Click the
Modify button and provide the new username setting.

# Host Name ’ ®

ltem Setting

* Host Name |:|
Username Configuration
Item Value setting Description
Host N 1. AnOptional setting . he h fth

ost Name .

2. It is blanked by default nter the host name of the gateway

Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change UserName

Username screen allows network administrator to change the web-based MMI login account to access
gateway. Click the Modify button and provide the new username setting.

= Usemame ° ®

ltem Setting
» Username admin | Modify
» New Username I:l
» Password |:|
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Username Configuration

Item Value setting Description
1. The default Username

Username for web-based MMl is Display the current MMI login account (Username).
‘admin’.
New Username String: any text Enter new Username to replace the current setting.
. Enter current password to verify if you have the permission to change the
Password String: any text .
username setting.
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings

Change Password

Change password screen allows network administrator to change the web-based MMI login password to
access gateway.

= Password ’ ®
[tem Setting
» Old Password [ ]
(MOTE: The password must be at least 10 characters long,

b Mew Password |:| and must contain at least 1 English letter and 1 number.

The password cannot be the same as the login account.)
» Mew Password Confirmation |:|

Password Configuration

Item Value setting Description

1. String: any text
Old Password fzc.);r‘:ee:-et:‘::;tdp“:s;;\:v;rd Enter the current password to enable you unlock to change password.
‘admin’.
Enter new password
NOTE: There are some limitation on setting the new password for
New Password String: any text enhancing the security. The password length must be at least 10
characters, and there must be at least one English character and one
numeric character. Beside, the new password must be different to the
existing one.
New Password . . .
Confirmation String: any text Enter new password again to confirm
Save N/A Click Save button to save the settings
Undo N/A Click Undo button to cancel the settings
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Change MMI Setting for Accessing

This is the gateway’s web-based MMI access which allows administrator to access the gateway for
management. The gateway’s web-based MMIwill automatically logout when the idle time has elapsed. The
setting allows administrator to enable automatic logout and set the logout idle time. When the login timeout
is disabled, the system won’t logout the administrator automatically.

Item
r Login
¥ Login Timeout

» GUI Access Protocol

+ External Authentication

b HTTPs Certificate Setup

¥ HTTP Comprassion
» HTTP Binding

r System Boot Mode

Login

Login Timeout

GUI Access Protocol

HTTPs Certificate
Setup

Setting

Password-Guessing Attack & MAX: {times)
[ Enable (seconds)
hitp/hitps

[] Enable Type Primary Server Secondary Server

@ default

Select from Cerificate List

Certificate: Key:
[] gzip [] deflate
DHCP A

Mormal Mods »

Enter the login trial counting value.

Value Range: 3 ~ 10.

. . If someone tried to login the web GUI with incorrect password for more
3 times is set by default . . B . .
than the counting value, an warning message “Already reaching maximum
Password-Guessing times, please wait a few seconds!” will be displayed

and ignore the following login trials.

The Enable box is Check the Enable box to activate the auto logout function, and specify the
checked, and 300 is set maximum idle time as well.

by default. Value Range: 30 ~65535.

http/httpsis selected by  Select the protocol that will be used for GUI access. It can be http/https,
default. http only, or https only.

If the https Access Protocol is selected, the HTTPs Certificate Setup option

The default box is . . . .
will be available for further configuration.

selected by default
Y You can leave it as default or select a expected certificate and key from the
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HTTP Compression

HTTP Binding

System Boot Mode

Save
Undo

The box is unchecked by
default.

1. AnOptional setting

2. DHCP-1 is checked by
default

Normal Modeis selected
by default.

N/A
N/A

drop down list.

Refer to Object Definition > Certificate Section for the Certificate
configuration.

Check the box (gzip, or deflate) if any comprerssion method is preferred.

Select the DHCP Server to bind with http access.

Select the system boot mode that will be adopted to boot up the device.
Normal Mode: It takes longer boot up time, with complete firmware image
check during the device booting.

Fast Mode: It takes shorter boot up time, without checking the firmware
image during the device booting.

Click Save button to save the settings

Click Undo button to cancel the settings
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6.2.2System Information

System Information screen gives network administrator a quick look up on the deviceinformation for the
purchades gateway.

Go to Administration> System Operation> System Information tab.

# System Information

Item

Setting

» Model Name

IDG500-06501

» Device Serial Number

» Kernel Version

2.6.36

» FW Version

00009G0.MA1_aA1.0000_11251230

» System Time

Wed, 05 Jan 2022 07:04:17 +0000

» Device Up-Time

4day 7hr 4min 38sec

System Information

Item Value Setting Description

Model Name N/A It displays the model name of this product.

zi‘r’:‘c;efe"al N/A It displays the serial number of this product.

Kernel Version N/A It displays the Linux kernel version of the product

FW Version N/A It displays the firmware version of the product

Memory Usage N/A It displays the percentage of device memory utilization.

System Time N/A It displays the current system time that you browsed this web page.
Device Up-Time N/A It displays thestatistics for the device up-time since last boot up.
Refresh N/A Click theRefreshbutton to update the system Information immediately.
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6.2.3System Time

The gateway provides manually setup and auto-synchronized approaches for the administrator to setup the
system time for the gateway. The time supported synchronization methods can be Time Server, Manual, PC,
Cellular Module, or GPS Signal. Select the method first, and then configure rest settings.

Instead of manually configuring the system time for the gateway, there are two simple and quick solutions for
you to set the correct time information and set it as the system time for the gateway.

The first one is “Sync with Timer Server”.Based on your selection of time zone and time server in abovetime
information configuration window, system will communicate with time server by NTP Protocol to get system
date and time after you click on the Synchronize immediately button.

The second one is “Sync with my PC”. Select the method and the system will synchronize its date and time to
the time of the administration PC.

Go toAdministration> System Operation> System Timetab.

Synchronize with Time Server

Item Setting
» Synchronization method Time Server v
v Time Zone (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London
» Auto-synchronization Time Server.

Available Time Servers (RFC-368): | Auto v

» Daylight Saving Time Enable
¥ NTP Service Enable
¥ Synchronize immediately Active

Synchronization
method

Time Zone

Auto-
synchronization

1. A Must-filled item.
2. Time Server is Select the Time Serveras the synchronization method for the system time.
selected by default.

1. A Must-filled item.

2. GMT+00 :00 is Select a time zone where this device locates.

selected by default.

1. A Must-filled item. Enter the IP or FQDN for the NTP time server you expected, or leave it as auto
2. Auto is selected by mode so that the available server will be used for time synchronization one by
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Daylight Saving
Time

NTP Service

Synchronize
immediately

Save
Refresh

default.
1. It is an optional item.

2. Un-checked by default

1. It is an optional item.
2. Un-checked by default
N/A

N/A
N/A

one.
Check the Enable button to activate the daylight saving function.

When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.

Check the Enable button to activate the NTP Service function.

When you enabled this function, the gateway can provide NTP server service for
its local connected devices.

Click the Active button to synchronize the system time with specified time
server immediately.

Click theSave button to save the settings.

Click theRefreshbutton to update the system time immediately.

Note: Remember to select a correct time zone for the device, otherwise, you will just get the UTC
(Coordinated Universal Time) time, not the local time for the device.

Synchronize with Manually Setting

ltem

¥ Synchronization method

¥ Time Zone

¥ Daylight Saving Time

¥ Set Date & Time Manually

¥ NTP Service

Synchronization
method

Time Zone

Daylight Saving
Time

Set Date & Time
Manually

NTP Service

Manual

Setting

L

(GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London

Enable

2019 ~
16
Enable:

1. A Must-filled item.
2. Time Server is
selected by default.

1. A Must-filled item.
2. GMT+00 :00 is
selected by default.

1. It is an optional item.
2. Un-checked by default
1. It is an optional item.

1. Itis an optional item.

24 v

18 v | (Year/Month/Day)

{Hour:Minute:Second)

April v
27~

Select the Manualas the synchronization method for the system time. It means
administrator has to set the Date & Time manually.

Select a time zone where this device locates.

Check the Enable button to activate the daylight saving function.

When you enabled this function, you have to specify the start date and end date
for the daylight saving time duration.

Manually set the date (Year/Month/Day) and time (Hour:Minute:Second) as the
system time.

Check the Enable button to activate the NTP Service function.
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2. Un-checked by default ~When you enabled this function, the gateway can provide NTP server service for
its local connected devices.
Save N/A Click theSave button to save the settings.

Synchronize with PC

= System Time Configuration ° ®
ltem Setting

» Synchronization method |PC ]

» NTP Service [[] Enable

» Synchronize immediately

System Time Information

Item Value Setting Description
1. A Must-filled item.

Synchronization
method

Select PC as the synchronization method for the system time to let system
synchronize its date and time to the time of the administration PC.

2. Time Server is
selected by default.

. . . Check the Enable button to activate the NTP Service function.
. 1. Itis an optional item. . . . .
NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default | .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click theSave button to save the settings.

Refresh N/A Click theRefreshbutton to update the system time immediately.
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Synchronize with Cellular Time Service

# System Time Configuration ° %
Item Setting

» Synchronization method  Cellular Module |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London |

» NTP Service {J Enable

» Synchronize immediately

System Time Information

Item Value Setting Description

Select Cellular Module as the synchronization method for the system time to let
system synchronize its date and time to the time provided from the connected
method mobile ISP.

N 1. A Must-filled item.
Synchronization X .
2. Time Server is

selected by default.
Note: this option is only available for the product with Cellular WAN interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
1. Itis an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default | .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time
immediately N/A server immediately.

Save N/A Click theSave button to save the settings.

Refresh N/A Click theRefreshbutton to update the system time immediately.
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Synchronize with GPS Time Service

= System Time Configuration ° %
[tem Setting

» Synchronization method ' GPS Signal v |

» Time Zone | (GMT+00:00) Greenwich Mean Time: Dublin, Edinburgh, Lisbon, London |

» NTP Service {J Enable

» Synchronize immediately

System Time Information

Item Value Setting Description
Select GPS Signal as the synchronization method for the system time to let

Synchronization L A.Must-ﬁlled' item. system synchronize its date and time to the time provided from the GNSS
2. Time Server is

method _
selected by default. service.

Note: this option is only available for the product with GNSS interface.

1. A Must-filled item.
Time Zone 2. GMT+00 :00 is Select a time zone where this device locates.
selected by default.

. . . Check the Enable button to activate the NTP Service function.
1. Itis an optional item.

NTP Service When you enabled this function, the gateway can provide NTP server service for
2. Un-checked by default | .
its local connected devices.

Synchronize Click the Active button to synchronize the system time with specified time

. . N/A

immediately / server immediately.

Save N/A Click theSave button to save the settings.

Refresh N/A Click theRefreshbutton to update the system time immediately.
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6.2.4System Log

System Log screen contains various event log tools facilitating network administrator to perform local event
logging and remote reporting.

Go to Administration> System Operation> System Logtab.

S | Emaitow |

Item Setting

» Web Log Type Category System Attacks Drop Login message [ Debug
[) Enable

Server: Add Object

» Email Alert E-mail Addresses:

Subject: | |

Log type Category: [ System [ Attacks [ ) Drop [ Login message [ Debug

) Enable Server: Add Object

Log type Category: [ System [ Attacks [ ) Drop [ Login message [ Debug
Enable

Select Device: [ |nternal v

Log file name: |syslog |

» Syslogd

Split file: () Enable Size: | 200 KB ¥
| 2
Log to Storage Interval' [J Enable [1440 | ( 1 ~ 10080 Minutes)
Max Records: |3000 | (5~10000)

Download log file | clear logs ‘

Log type Category: System Attacks Drop Login message Debug

View & Email Log History

View button is provided for network administrator to view log history on the gateway. Email Now button
enables administrator to send instant Email for analysis.

View & Email Log History

Item Value setting Description

View button N/A Click the View button to view Log History in Web Log List Window.
Email Now . . . . -

button N/A Click the Email Now button to send Log History via Email instantly.
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R DRSS S Previous @ Nexi First || Last || Download || Clear

Time Log
Apr106:01:36 dnsmasg-dhcp[B016]: Ignoring domain amit.com tw for DHCP host name NB-msnb
Apr106:08:31 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr106:15:30 dnsmasg-dhcp[6016]: Ignoring domain amit.com tw for DHCPF host name NB-msnb
Apr106:22:06 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 10625842 dnsmasg-dhcp[6016]: Ignoring domain amit.com_tw for DHCPF host name NB-msnb
Apr106:35:42 dnsmasg-dhcp[B016]: Ignoring domain amit.com.tw for DHCP host name NB-msnb
Apr 1064220 dnsmasg-dhcp[6016]: Ignoring domain amit.com_tw for DHCPF host name NB-msnb

Web Log List Window

Item Value Setting Description
Time column N/A It displays event time stamps
Log column N/A It displays Log messages

Web Log List Button Description

Item Value setting Description
Previous N/A Click the Previous button to move to the previous page.
Next N/A Click the Next button to move to the next page.
First N/A Click the First button to jump to the first page.
Last N/A Click the Last button to jump to the last page.
Download N/A Click the Download button to download log to your PC in tar file format.
Clear N/A Click the Clear button to clear all log.
Back N/A Click the Back button to return to the previous page.
Web Log Type Category

Web Log Type Category screen allows network administrator to select the type of events to log and be
displayed in the Web Log List Window as described in the previous section. Click on the View button to view
Log History in the Web Log List window.

» Web Log Type Category System Attacks Drop Login message [J Debug

Web Log Type Category Setting Window

Item Value Setting Description

System Checked by default Check to log system events and to display in the Web Log List window.
Attacks Checked by default Check to log attack events and to display in the Web Log List window.

Drop Checked by default Check to log packet drop events and to display in the Web Log List window.
Login message Checked by default Check to log system login events and to display in the Web Log List window.
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Debug Un-checked by default Check to log debug events and to display in the Web Log List window.

Email Alert

Email Alert screen allows network administrator to select the type of event to log and be sent to the destined
Email account.
Enable
Server: |- Option — ¥ || Add Object

» Email Alert E-mail Addresses:

Subject

Log type Category: System Attacks Drop Login message Debug

Enable Un-checked by default Check Enabllebox. to enable s.ending event log messages to destined Email
account defined in the E-mail Addresses blank space.
Select one email server from the Server dropdown box to send Email. If none
has been available, click theAdd Object button to create an outgoing Email

Server N/A server.
You may also add an outgoing Email server from Object Definition > External
Server > External Servertab.

. . Enter the recipient’s Email address. Separate Email addresses with comma ‘, or

E-mail address String : email format semicolon * 7
Enter the Email address in the format of ‘myemail@domain.com’

Subject String : any text Enter an Email subject that is easy for you to identify on the Email client.
Select the type of events to log and be sent to the designated Email account.

Log type category  Default unchecked . .
Available events are System, Attacks, Drop, Login message, and Debug.
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Syslogd

Syslogd screen allows network administrator to select the type of event to log and be sent to the designated

Syslog server.

» Syslogd

() Enable Server: Add Object

Log type Category: (] System [) Attacks [J Drop [J Login message [ Debug

Syslogd Setting Window

Item Value Setting

Description

Enable Un-checked by default Check Enable box to activate the Syslogd function, and send event logs to a syslog server

Select one syslog server from the Server dropdown box to sent event log to.
If none has been available, click theAdd Object button to create a system log server.

Server N/A . .
You may also add an system log server from the Object Definition > External Server >
External Server tab.
Log type Select the type of event to log and be sent to the destined syslog server. Available
Un-checked by default .
category events are System, Attacks, Drop, Login message, and Debug.

Log to Storage

Log to Storage screen allows network administrator to select the type of events to log and be stored at an
internal or an external storage.

» Log to Storage

[# Enable

Select Device: [ |ntemal v

Log file name: |5y5log |

Split file: [J Enable Size: 200 KB v
Interval: (] Enable |1440 (1~ 10080 Minutes)
Max Records: |3{}[}[:| | {5~10000})

| Download log file | clear logs |
Log type Category: [# System |« Attacks [ Drop ¥ Login message [ Debug

Log to Storage Setting Window

Item Value Setting Description
Enable Un-checked by default Check to enable sending log to storage.
. Internal is selected by .
Select Device Select internal or external storage.
default
Log file name Un-checked by default Enter log file name to save logs in designated storage.
Split file Enable Un-checked by default Check enablebox to split file whenever log file reaching the specifiedlimit.
. Enter the file size limit for each split log file.
Split file Size 200 KB is set by default P 8
Value Range: 10 ~1000.
Interval Enable Un-checked by default Check enablebox toenable the log interval setting.
. Enter the log interval setting.
Log Interval 1440 is set by default .
Value Range: 1 ~10080 Minute.
Enter the maximum number of records to be stored in the log storage.
Max Records 3000 is set by default & 8
Value Range:5 ~10000.
Log type category  Un-checked by default Check which type of logs to send: System, Attacks, Drop, Login message, Debug

223



5G/LTE WAN Extender

Log to Storage Button Description

Item Value setting Description

Download log N/A Click the Download log file button to download log files to a log.tar file.
file

Clear Logs N/A Click the Clear logs button to deletethe log files from the storage.
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6.2.5Backup & Restore

In the Backup & Restore window, you can upgrade the device firmware when new firmware is available and
also backup / restore the device configuration.

In addition to the factory default settings, you can also customize a special configuration setting as a
customized default value. With this customized default value, you can reset the device to the expected default

setting if needed.

Go to Administration> System Operation>Backup & Restoretab.

Item Setting
» FW Upgrade Via Web Ul v | | FW Upgrade
» Backup Configuration Settings | | Download v || Via Web UI
» Auto Restore Configuration Enable | Save Conf | Clean Conf. | Conf Info.
» Self-defined Logo Download ¥ || Via Web Ul || Reset
» Self-defined CSS Edit
Download v | | Via Web Ul || Reset

Via Web Ul is selected by

FW Upgrade
Pe default
Back.up . Download is selected by
Configuration
Settings default

The Enable box is
unchecked by default

Auto Restore
Configuration

If new firmware is available, click the FW Upgrade button to upgrade the device
firmware via Web Ul, or Via Storage.

After clicking on the “FW Upgrade” command button, you need to specify the
file name of new firmware by using “Browse” button, and then click “Upgrade”
button to start the FW upgrading process on this device. If you want to upgrade
a firmware which is from GPL policy, please check “Accept unofficial firmware”
You can backup or restore the device configuration settings by clicking the Via
Web Ul button.

Download: for backup the device configuration to a config.bin file.

Upload: for restore a designated configuration file to the device.

Via Web Ul: to retrieve the configuration file via Web GUI.

Chick the Enable button to activate the customized default setting function.
Once the function is activated, you can save the expected setting as a
customized default setting by clicking the Save Conf. button, or clicking the
Clean Conf. button to erase the stored customized configuration.
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6.2.6Reboot & Reset

For some special reason or situation, you may need to reboot the gateway or reset the device configuration to
its default value. In addition to perform these operations through the Power ON/OFF, or pressing the reset
button on the device panel, you can do it through the web GUI too.

Go toAdministration> System Operation>Reboot & Resettab.

In the Reboot & Reset window, you can reboot this device by clicking the “Reboot” button, and reset this
device to default settings by clicking the “Reset” button.

Item
» Reboot

» Reset to Default

Reboot

Reset to Default

Setting
Now v | | Reboot

Resst

Chick the Reboot button to reboot the gateway immediately or on a pre-defined
time schedule.

Now is selected by Now: Reboot immediately

default Time Schedule: Select a pre-defined auto-reboot time schedule rule to reboot
the auto device on a designated tim. To define a time schedule rule, go to
Object Definition > Scheduling > Configuration tab.

N/A Click the Reset button to reset the device configuration to its default value.
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6.3Diagnostic

This gateway supports simple network diagnosis tools for the administrator to troubleshoot and find the root
cause of the abnormal behavior or traffics passing through the gateway. There can be a Packet Analyzer to
help record the packets for a designated interface or specific source/destination host, and another Ping and
Tracert tools for testing the network connectivity issues.

6.3.1Diagnostic Tools

The Diagnostic Tools provide some frequently used network connectivity diagnostic tools (approaches) for the
network administrator to check the device connectivity.

Go to Administration>Diagnostic >Diagnostic Tools tab.

Item Setting

» Ping Test Host IP Outer Interface: |Auto v LAN Source:

Default * | | Ping

» Tracert Test Host IP nterface: |Auto v | (UDP v Tracert
» Speed Test Interface: |Auto ¥ mode: |DL+UL ¥ S5L | Test
¥ Wake on LAN Wake up

This allows you to specify an IP / FQDN, theOuter interface (auto, WAN, LAN,
. . . or VLAN), and LAN source (default, LAN, or VLAN) as well, so system will try
Ping Test Optional Setting . . . e S
to ping the specified device to test whether it is alive after clicking on the
Ping button. A test result window will appear beneath it.
Trace route (tracert)command is a network diagnostic tool for displaying the
route (path) and measuring transit delays of packets across an IP network.
Traceroute proceeds until all (three) sent packets are lost for more than
twice, then the connection is lost and the route cannot be evaluated.
First, you need to specify an IP / FQDN, the test interface (LAN, WAN, or
Auto) and the protocol (UDP or ICMP), and by default, it is UDP.
Then, system will try to trace the specified host to test whether it is alive

Tracert Test Optional setting

after clicking on Tracert button. A test result window will appear beneath it.
This allows you to do a quick speed test for verifying the connectivity on
Speed Test Optional setting . y g P ying y
specific interface.
WakeonLAN (WOL) is an Ethernet networking standard that allows a
computer to be turned on or awakened by a network message. You can
Wake on LAN Optional setting p y. 8
specify the MAC address of the computer, in your LAN network, to be

remotely turned on by clicking on the Wake up command button.
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| Save

N/A

Click the Save button to save the configuration.

6.3.2Ethernet Port setup

Between two communication devices, two-way data transmission is allowed, which can be subdivided into
half-duplex and full-duplex.
In order to efficiently utilize the maximum bandwidth, adjust the maximum network speed according to the
usage environment

Go to Administration>Diagnostic >Ethernet Port setup tab.

#) Ethernet Port Setup

Item

Setting

» Ethernet Port setup

(] Enable

Ethernet Port setup

Item
Ethernet Port
setup

Value setting
Un-checked by default

Description
Check to enable Ethernet port

Click the Edit button to edit the settings for Ethernet port.

# Ethernet Port Setup List

Ethernet Port setup List

Item

Value setting

ID Flow Control Speed Duplex Link Enable Action
1 Enable 10M Half Down ]
2 Enable 10M Half Down |

Description

Flow Control Enable by default Specify the flow control for the ethernet port.It can be enable/disabled
Select Enable to activate this flow control.
Select Disabled to disable flow control for this Ethernet interface.
Speed 10M by default Specify the flow speed.It can be 10M, 100M, or 1000M.
Value Range: 10M~1000M
Duplex Half by default SelectHalf/Fullto activateDuplex function.
Select Halfto activate this halfmode.
SelectFullto activate this full mode
Value Range:Half/Full
Link Down by default Select Linkdown/up to restart the ethernet interface, if required.
Enable Un-checked by default Check to enable Ethernet port rule..
Save N/A Click the Save button to save the configuration.
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Chapter7Service

7.1 Cellular Toolkit

(@m
A

Cellular
Tower

Mobile Network ()
Operator

Tower

(@
A

Cellular
Tower

section.

Cellular

Data Usage Monitoring

i 1. Statistics of data usage thru3G/LTE
2. SIMswitchor drop if reach quota limit |

SMS [Short Message Service)
1. Compose SMS5message on gateway
2. Receive SMSmessage from remote

SIM PIN Management
1. SIMcardPIM lock or PIN unlock
2. PIN code change or PUK unlock

Mobile Network Scan
1. Actively mobile network search
2. Manually select mobile network

USSD Communication
1. Instant communicationwith MNO
2. Subscriber inquiry or setting change

7.1.1Data Usage

AMIT M2M
Cellular Gateway

Besides cellular data connection, you may also
like to monitor data usage of cellular WAN,
sending text message through SMS, changing
PIN code of SIM card, communicating with
carrier/ISP by USSD command, or doing a
cellular network scan for diagnostic purpose.

In Cellular Toolkit section, it includes several
useful features that are related to cellular
configuration or application.You can configure
settings of Data Usage, SMS, SIM PIN, USSD,
and Network Scan here. Please note at least a
valid SIM card is required to be inserted to
device before you continue settings in this

Most of data plan for cellular connection is with a limited amount of data usage. If data usage has been over
limited quota, either you will get much lower data throughput that may affect your daily operation, or you will
get a ‘bill shock’ in the next month because carrier/ISP charges a lot for the over-quota data usage.

With help from Data Usage feature, device will monitor cellular data usage continuously and take actions. If
data usage reaches limited quota, device can be set to drop the cellular data connection right away. Otherwise,
if secondary SIM card is inserted, device will switch to secondary SIM and establish another cellular data
connection with secondary SIM automatically.

If Data Usage feature is enabled, all history of cellular data usage can be viewed at Status>Statistics&
Reports>Cellular Usage tab.
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o Add | Delete
1D SIM info Carrier Name Cycle Period Start Date
Cellular(5G/LTE) Thu Jan 05 2023
! SIM A ISP TMonthly  95.00:00 GMT+0800
5G/LTE Data Usage
SIM A

ISP A Bill Start: ewvery 20t {{ . })

h Data limit: 1Gb

SIM A Settings
-Cycle Period: monthly

-Start Date: 2017 [ Feb [ 20
-Data Limitation: 1Gb
-Connection Restrict: Enable

Connection

Data Limitation Enable Action

Restrict

OKB v Select

Edit

Data Usage feature enabling gateway device to
continuously monitor cellular data usage and take
actions. In the diagram, quota limit of SIM A is 1Gb
per month and bill start date is 20" of every
month. The device is smart to start a new
calculation of data usage on every 20™ of month.
Enable Connection Restrict will force gateway
device to drop cellular connection of SIM A when
data usage reaches quota limit (1Gb in this case). If
SIM failover feature is configured in Internet Setup,
then gateway will switch to SIM B and establish a
new cellular data connection automatically.
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Data Usage Setting

Go to Service>Cellular Toolkit>Data Usagetab.

Before finished settings for Data Usage, you need to know bill start date, bill period, and quota limit of data
usage according to your data plan. You can ask this information from your carrier or ISP.

Create / Edit CellularData Usage Profile

= Cellular Data Usage Profile List

Carrier

Connection

Data Limitation Action

Name Restrict

When Add button is applied,Cellular Data Usage Profile Configuration screen will appear. You can create up to
four data usage profiles, one profile for each SIM card used in the Gateway.

l

# Cellular Data Usage Profile Configuration

Item Setting
» SIM Select Cellular(5G/LTE) v | |SIMA v |
» Carrier Name ‘ |
» Cycle Period ‘Days v | |
» Start Date 2023 v/ |January v |/ |5 v|
» Data Limitation | KB v |
» Connection Restrict (] Enable
» Enable (¥ Enable

Save

Cellular Data Usage Profile Configuration

Item Setting  Value setting Description

SIM Select Cellular(5G/LTE) and Choose a cellular interface Cellular(5G/LTE), and a SIM cardbound to the selected
SIM A by default. cellular interface to configure its data usage profile.

Carrier Name It is an optional item. Fill in the Carrier Name for the selected SIM card for identification.

Cycle Period Days by default The first box has three types for cycle period. They are Days, Weekly and Monthly.

Days: For per Days cycle periods, you have to further specify the number of days in
the second box.
Value Range:1 ~ 90 days.
Weekly, Monthly: The cycle period is one week or one month.

Start Date N/A Specify the date tostart measure network traffic.
Please don’t select the day before now, otherwise, the traffic statistics will be
incorrect.
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Data Limitation N/A Specify the allowable data limitation for the defined cycle period.
Connection Un-Checked by default. Check the Enable box to activate the connection restriction function.
Restrict During the specified cycle period, if theactual data usage exceeds the allowable data
limitation, the cellular connection will be forced to disconnect.
Enable Checked by default. Check the Enable box to activate the data usage profile.
7.1.2 SMS

Short Message Service (SMS) is a text messaging service, which is used to be widely-used on mobile phones. It
uses standardized communications protocols to allow mobile phones or cellular devices to exchange short text
messages in an instant and convenient way.

SMS Setting

Go to Service>Cellular Toolkit>SMStab

With this gateway device, you can send SMS text messages or browse received SMS messages as you usually
do on a cellular phone.

Setup SMS Configuration

o SMS Setup || Managing Events Setup | Notifying Events Setup

Item Setting
» Physical Interface Cellular-1 v
» SMS #| Enable SIM Status: SIM_A
» SMS Storage SIM Card Only v
» SMS Space Enable & Keep Available Space (1-10)

Choose a cellular interface (Cellular-1 or Cellular-2)for the following SMS

Physical The box is Cellular-1 by . . .

function configuration.
Interface default

Note: Cellular-2 is only available for for the product with dual cellular module.
SMS The box is checked by This is the SMS switch. If the box checked that the SMS function enable, if the

default box unchecked that the SMS function disable.

SIM Status N/A Depend on currently SIM status. The possible value will be SIM_A or SIM_B.
SMS Storage The box is SIM Card This is the SMS storage location. Currently the option only SIM Card Only.
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Onlyby default

. Check the Enable box and specify a number (1-10) for message count to reserve
The box is unchecked by

SMS Space default some available storage space and prevent it from run out of storage.
efau
The oldest message(s) will be deleted when the SMS storage is going to full.
Save N/A Click theSavebutton to save the settings

SMS Summary

Show Unread SMS, Received SMS,Sent SMS,Remaining SMS, and edit SMS context to send, read SMS from
SIM card.
- New SMS | SMS Inbox | SMS Sent Folder

Item Setting
» Unread SMS 0
» Received SMS 6
» Sent SMS 0
» Remaining SMS 21

If SIM card insert to router first time, unread SMS value is zero. When received the
Unread SMS N/A i )
new SMS but didn’t read, this value plus one.

. This value record the existing SMS numbers from SIM card, When received the new
Received SMS N/A .
SMS, this value plus one.

Sent SMS N/A T:wis value record the number of out going SMS, When sent one SMS, this value
plus one.

.. This value is SMS capacity minus received SMS, When received the new SMS, this
Remaining SMS  N/A ]
value minus one.

Click New SMS button, a New SMS screen appears. User can set the SMS setting

New SMS N/A
from this screen. Refer to New SMS in the next page.
Click SMS Inbox button, a SMS Inbox List screen appears. User can read or delete
SMS Inbox N/A SMS, reply SMS or forward SMS from this screen. Refer to SMS Inbox List in the
next page.
Refresh N/A Click theRefreshbutton to update the SMS summary immediately.
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New SMS

You can set the SMS setting from this screen.

= New SMS .. . -

b Item Setting

(Use '+ for International Format and *;' to Compose Multiple Receivers)

» Receivers

» Text Message

Length of Current Input: 0

» Result
New SMS
Item Value setting Description
. Write the receivers to send SMS. User need to add the semicolon and compose
Receivers N/A

multiple receivers that can group send SMS.
Write the SMS context to send SMS. The router supports up to a maximum of
1023 character for SMS context length.

Text Message N/A

Send N/A Click theSend button, above text message will be sent as a SMS.
If SMS has been sent successfully, it will show Send OK, otherwise Send Failed
Result N/A . .
will be displayed.
SMS Inbox List

You can read or delete SMS, reply SMS or forward SMS from this screen.

& SMS Inbox List- | Delete | Close | Previous ' 1 v Next |
Refresh || Delete || Close || Previous || 1 v | Next

From Phone

Nlﬁaber

Timestamp SMS Text Preview Actions

SMS Inbox List

Item Value setting Description
ID N/A The number of SMS.
From Phone
N/A Sender List (Phone Number) for the received SMS
Number
Timestamp N/A What time the SMS is received
SMS Text . . . .
Preview N/A Preview the SMS text. Click the Detail button to read a certain message.
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Click theDetail button to read the SMS detail; Click theReply/Forward button to
The box is unchecked by reply/forward SMS.

Action default Besides, you can check the box(es), and then click theDelete button to delete
the checked SMS(s).
Refresh N/A Refresh the SMS Inbox List.
Delete N/A Delete the SMS for all checked box from Action.
Close N/A Close the Detail SMS Message screen.
SMS Sent Folder

You can read or delete SMS from this screen.

Delete Close || Previous @ | 0 v || Next

ID Receivers Timestamp SMS Text Preview Actions
ID N/A The number of SMS.
Receivers N/A Receiver list for the sent SMS.
Timestamp N/A What timethe SMS is sent
SMS Text . . .
Preview N/A Preview the SMS text. Click the Detail button to read a certain message.

. Click theDetail button to read the SMS detail
The box is unchecked by

Action default Besides, you can check the box(es), and then click theDelete button to delete
the checked record(s).

Refresh N/A Refresh the SMS Sent Folder.

Delete N/A Delete the SMS for all checked box from Action.

Close N/A Close the Detail SMS Message screen.

7.1.3 SIMPIN

With most cases in the world, users need to insert a SIM card (a.k.a. UICC) into end devices to get on cellular
network for voice service or data surfing. The SIM card is usually released by mobile operators or service
providers. Each SIM card has a unique number (so-called ICCID) for network owners or service providers to
identify each subscriber. As SIM card plays an important role between service providers and subscribers, some
security mechanisms are required on SIM card to prevent any unauthorized access.

Enabling a PIN code in SIM card is an easy and effective way of protecting cellular devices from unauthorized
access. This gateway device allows you to activate and manage PIN code on a SIM card through its web GUI.
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Activate PIN code on SIM Card

) This gateway device allows you to activate PIN code on SIM card. This
) < example shows how to activate PIN code on SIM-A for 3G/4G/5G-1
e sm with default PIN code “0000”.
MNO

SIM A Settings
-5IM Lock: Enable

-PIN Code: 0000

Change PIN code on SIM Card

This gateway device allows you to change PIN code on SIM card.
Following the example above, you need to type original PIN code
“0000”, and then type new PIN code with ‘1234’ if you like to set new
PIN code as ‘1234’. To confirm the new PIN code you type is what you
want, you need to type new PIN code ‘1234’ in Verified New PIN Code
again.

(&)
X

Qi
MNO SIMA &‘

= ! g -
with PIN Code ‘0000 Gateway

Change PIN Code Settings
-Current PIN Code: 0000
-New PIN Code: 1234
Verified New PIN Code: 1234

Unlock SIM card by PUK Code

If you entered incorrect PIN code at configuration page for

W a ‘@ 3G/4G/5G-1 WAN over three times, and then it will cause SIM card to

ag_ be locked by PUK code. Then you have to call service number to get a

MNO i;":ﬁ.:fﬁé’ coteway PUK code to unlockSIM card. In the diagram, the PUK code is
12345678’ “12345678” and new PIN code is “5678".

PUK Unlock Settings
-PUK Code: 12345678

-New PIN Code: 5678

SIM PIN Setting

Go to Service>Cellular Toolkit>SIM PIN Tab

With the SIM PIN Function window, it allows you to enable or disable SIM lock (which means protected by PIN
code), or change PIN code. You can also see the information of remaining times of failure trials as we
mentioned earlier. If you run out of these failure trials, you need to get a PUK code to unlock SIM card.

Select a SIM Card
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= Configuration ’ x
Item Setting

¥ Physical Interface

k SIM Status SIM-A Ready

 5IM Selection SIM-A ~ || Switch

Configuration Window

Item Value setting Description
Physical The box is Cellular-1 by Choose a cellular interface (Cellular-1 or Cellular-2) to change the SIM PIN
Interface default setting for the selected SIM Card.

Note: Cellular-2 is only available for for the product with dual cellular module.
SIM Status N/A Indication for the selected SIM card and the SIM card status.

The status could be Ready, Not Insert, or SIM PIN.
Ready -- SIM card is inserted and ready to use. It can be a SIM card without PIN
protection or that SIM card is already unlocked by correct PIN code.
Not Insert -- No SIM card is inserted in that SIM slot.
SIM PIN -- SIM card is protected by PIN code, and it’s not unlocked by a correct
PIN code yet. That SIM card is still at locked status.

SIM Selection N/A Select the SIM card for further SIM PIN configuration.
Press the Switch button, then the Gateway will switch SIM card to another one.
After that, you can configure the SIM card.

Enable / Change PIN Code

Enable or Disable PIN code (password) function, and even change PIN code function.

Item Setting

» PIN Lock () Enable PINCode: | | (4~8 digits)

» Remaining times 3

SIM function Window

Item Setting Value setting Description

PIN lock Depend on SIM card Click the Enable button to activate the PIN lock function.
For the first time you want to enable the PIN lock function, you have to
fill in the PIN code as well, and then click Save button to apply the setting.

Remaining times Depend on SIM card Represent the remaining trial times for the SIM PIN unlocking.
Save N/A Click the Save button to apply the setting.
Change PIN Code N/A Click the Change PIN code button to change the PIN code (password).

If the SIM Lock function is not enabled, the Change PIN code button is
disabled. In the case, if you still want to change the PIN code, you have to
enable the SIM Lock function first, fill in the PIN code, and then click the Save
button to enable. After that, You can click the Change PIN code button to
change the PIN code.
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When Change PIN Code button is clicked, the following screen will appear.

ftem Setting

» Current PIM Code {4~8 digits)

F Mew PIN Code (4-a digits)

v Wertified Mew FIN Code {4~8 digits)

Apply | Cancel

Current PIN A Must filled setting Fill in the current (old) PIN code of the SIM card.
Code
New PIN Code A Must filled setting Fill in the new PIN Code you want to change.
Verified New A Must filled setting Confirm the new PIN Code again.
PIN Code
Apply N/A Click the Apply button to change the PIN code with specified new PIN code.
Cancel N/A Click the Cancel button to cancel the changes and keep current PIN code.

Note: If you changed the PIN code for a certain SIM card, you must also change the corresponding PIN code
specified in the Basic Network>WAN& Uplink>Internet Setup>Connection with SIM Card page. Otherwise, it
may result in wrong SIM PIN trials with invalid (old) PIN code.

Unlock with a PUK Code

The PUK Function window is only available for configuration if that SIM card is locked by PUK code. It means
that SIM card is locked and needs additional PUK code to unlock. Usually it happens after too many trials of
incorrect PIN code, and the remaining times in SIM Function table turns to 0. In this situation, you need to
contact your service provider and request a PUK code for your SIM card, and try to unlock the locked SIM card
with the provided PUK code. After unlocking a SIM card by PUK code successfully, the SIM lock function will be
activated automatically.

Save
Item Setting
» PUK status PUK unlock.
» Remaining times 10
» PUK Code (8 digits)
» New PIN Code (4~8 digits)
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PUK status

Remaining times

PUK Code
New PIN Code

Save

PUK Unlock
/ PUK Lock

Depend on SIM card

A Must filled setting

A Must filled setting

N/A

Indication for the PUK status.

The status could be PUK Lock or PUK Unlock. As mentioned earlier, the SIM card
will be locked by PUK code after too many trials of failure PIN code. In this case,
the PUK Status will turns to PUK Lock. In a normal situation, it will display PUK
Unlock.

Represent the remaining trial times for the PUK unlocking.

Note : DO NOT make the remaining times down to zero, it will damage the SIM
card FOREVER ! Call for your ISP’s help to get a correct PUK and unlock the SIM if
you don’t have the PUK code.

Fill in the PUK code (8 digits) that can unlock the SIM card in PUK unlock status.
Fill in the New PIN Code (4~8 digits) for the SIM card.

You have to determine your new PIN code to replace the old, forgotten one.
Keep the PIN code (password) in mind with care.

Click the Save button to apply the setting.

Note: If you changed the PUK code and PIN code for a certain SIM card, you must also change the
corresponding PIN code specified in the Basic Network>WAN& Uplink>Internet Setup>Connection with SIM
Card page. Otherwise, it may result in wrong SIM PIN trials with invalid (old) PIN code.

7.1.4 USSD

Unstructured Supplementary Service Data (USSD) is a protocol used by GSM cellular telephones to
communicate with the service provider's computers. USSD can be used for WAP browsing, prepaid callback
service, mobile-money services, location-based content services, menu-based information services, and as
part of configuring the phone on the network.

An USSD messageis up to 182 alphanumeric characters in length. Unlike Short Message Service (SMS)
messages, USSD messages create a real-time connection during an USSD session. The connection remains
open, allowing a two-way exchange of a sequence of data. This makes USSD more responsive than services

that use SMS.

Item

k Physical Interface

Item

+ USSD Profile
U350 Command

Setting

Cellular-1 w| SIM Status: SIM_A

Profile Name

| Send || Clear | | Cancel |

USSD Command Comments Actions

Setting
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USSD Scenario

Gateway USSD allows you to have an instant bi-directional
it i S communication with carrier/ISP. In the diagram, the USSD
4 4G Cellular %5 - Global IP: 118.18.81.33
JQSe yussT R 1358,

e 1082 command ‘*135#’ is referred to data roaming services.
% 3 y After sending that USSD command to carrier, you can get
tonen roami rvice. J

a response at window USSD Response. Please note the

~the information you enquired @ USSD command varies for different carriers/ISP.
USSD Server :
@ Service Provider
Local Administrator

10.0.75.100

USSD Setting

Go toService>Cellular Toolkit>USSDtab.

In "USSD" page, there are four windows for the USSD function. The "Configuration" window can let you specify
which 3G/4G/5Gmodule (physical interface) is used for the USSD function, and system will show which SIM
card in the module is the current used one. The second window is the "USSD Profile List" and it shows all your
defined USSD profiles that store pre-commands for activating an USSD session. An "Add" button in the window
can let you add one new USSD profile and define the command for the profile in the third window, the "USSD
Profile Configuration". When you want to start the activation of an USSD connection session to the USSD
server, select the USSD profile or type in the correct pre-command, and then click on the "Send" button for the
session. The responses from the USSD server will be displayed beneath the "USSD Command" line. When
commands typed in the "USSD Command" field are sent, received responses will be displayed in the "USSD
Response" blank space. User can communicate with the USSD server by sending USSD commands and getting
USSD responses via the gateway.

USSD Configuration

= Configuration

Item Setting

» Physical Interface Cellular-1 ~| SIM Stafus: SIM_A
Configuration

Value setting Description
Choose a cellular interface (Cellular-1 or Cellular-2)to configure the USSD

The box is Cellular-1 by

Physical Interface
default.

setting for the connected cellular service (identified with SIM_A or SIM_B).
Note: Cellular-2 is only available for for the product with dual cellular module.
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‘ SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).

Create / EditUSSD Profile

The cellular gateway allows you to custom your USSD profile. It supports up to a maximum of 35 USSD profiles.

=) USSD Profile List X0 IR

Profile Name

USSD Command

When Add button is applied,USSD Profile Configuration screen will appear.

5 ussoreases: ET 2 220

Item Setting

¥ USSD Command |

USSD Profile Configuration

Item Value setting Description
Profile Name N/A Enter a name for the USSD profile.

Enter the USSD command defined for the profile.

USSD Command N/A Normally, it is a command string cor'nposed with numeric keypad ”0"“9", orn
and “#”. The USSD commands are highly related to the cellular service, please
check with your service provider for the details.

Comments N/A Enter a brief comment for the profile.

Send USSD Request

When send the USSD command, the USSD Response screen will appear.
When click the Clear button, the USSD Response will disappear.

- usso e 21 20 220

Item Setting

» USSD Command | |

USSD Request

Item  Valuesetting  Description ...
USSD Profile N/A Select a USSD profile name from the dropdown list.
USSD Command  N/A The USSD Command string of the selected profile will be shown here.
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Click the Sendbutton to send the USSD command, and theUSSD
USSD Response  N/A Responsescreen will appear. You will see the response message of the
corresponding service, receive the service SMS.

7.2SMS &Event

SMS &Event handling is the application that allows administrator to setup the pre-defined events, handlers, or
response behavior with individual profiles. With properly configuring the event handling function,
administrator can easily and remotelyobtain the status and information via the purchased gateway.

The supported events are categorized into two groups: the managing events and notifying events.

The managing events are the events that are used to manage the gateway or change the setting / status of the
specific functionality of the gateway. On receiving the managing event, the gateway will take action to change
the functionality,and collect the required status for administration simultaneously.

The notifying events are the events that some related objects have beentriggered and take corresponding
actions on the occurrence of the events. It could be an event for alerting the administrator something
happened with SMS message, Email, and SNMP Trap, etc...

For ease of configuration, administrator can create and edit the common pre-definedmanaging/notifying event
profiles for taking instant reaction on a certain event or managing the devices for some advanced useful
purposes.For example, sending/receiving remote managing SMS for the gateway’s routine maintaining, and so
on. All of such management and notification function can be realizedeffectivelyviathe Event Handling feature.

The following is the summary lists for the provided profiles, and events:

® Profiles (Rules):
* SMS Configuration and Accounts
* Email Accounts
* Remote Host profiles
® Managing Events:
* Trigger Type: SMS, SNMP Trap
* Actions: Get the Network Status; or Configure the LAN/VLAN behavior, WIFI behavior, NAT
behavior, Firewall behavior, VPN behavior, System Management, Administration, and Remote
Host.
® Notifying Events:
* Trigger Type: Connection Change (WAN, LAN & VLAN, WiFi, DDNS), Administration,Data Usage.
* Actions:Notify the administrator with SMS, Syslog, SNMP Trap orEmail Alert; Sending collected
information to Remote Host.

To use the event handling function, First of all, you have to enable the event management setting and
configure the event details with the provided profile settings. You can create or edit pre-defined profiles for
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individual managing / notifying events. The profile settings are separated into several items; they are the SMS
Account Definition, Email Service Definition, and Remote Host Configuration.Then, you have to configure each
managing / notifying event with identifying the event’s trigger condition, and the corresponding actions
(reaction for the event) for the event. For each event, more than one action can be activated simultaneously.

7.2.1 Configuration

Go to Service>SMS & Event>Configuration Tab.

Event handling is the service that allows administrator to setup the pre-defined events, handlers, or response
behavior with individual profiles.

Enable Event Management

% Configuration . u

Item Setting

» Event Management () Enable

Configuration

Item \ Value setting Description
Event The box is unchecked by Check the Enable box to activate the Event Management function.
Management default

Enable SMS Management

To use the SMS management function, you have to configure some important settings first.

&1 SMS Configuration . %
Item Settin
[ d
» Message Prefix [ Enable | |
» Physical Interface Cellular-1 »| SIM Status: SIM_A
¥ Delete Managed SMS after [ Enable
Processing

SMS Configuration

Item \ Value setting Description

243



5G/LTE WAN Extender

Message Prefix The box is unchecked Click the Enable box to enable the SMS prefix for validating the received SMS.
by default Once the function is enabled, you have to enter the prefix behind the checkbox.
The received managing events SMS must have the designated prefix as an initial
identifier, then corresponding handlers will become effective for further
processing.
Physical Interface _ Choose a cellular interface (Cellular-1 or Cellular-2)to configure the SMS
The box is Cellular-1 by .
default. management setting.
Note: Cellular-2 is only available for for the product with dual cellular module.
SIM Status N/A Show the connected cellular service (identified with SIM_A or SIM_B).
Delete Managed The box is unchecked Check the Enable box to delete the received managing event SMS after it has
SMS after by default been processed.
Processing

Create / Edit SMS Account

Setup the SMS Account for managing the gateway through the SMS. It supports up to a maximum of 5
accounts.

% sms AccountList X1 [T

Phone Number

Send confirmed
SMS

Phone Description Application Enable Actions

You can click the Add / Edit button to configure the SMS account.

% SMS Account Configuration ®

Item Setting

» Phone Number  Specific Number v | | \

¥ Phone Description ‘ |

» Application ) Event Trigger [] Notify Handle
¥ Send confirmed SMS [J Enable
» Enable Enable

Save

SMS Account Configuration

Item Value setting Description
Phone 1. Mobile phone number Select the Phone number policy from the drop list, and specify a mobile phone
Number format number as the SMS account identifier if required.

2. A Must filled setting It can be Specific Number, or Allow Any. If Specific Number is selected, you

have to specify the phone number as the SMS account identifier.
Value Range:-1 ~ 32 digits.

Phone 1. Any text Specify a brief description for the SMS account.

Description 2. AnOptional setting
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Application A Must filled setting Specify the application type. It could be Event Trigger, Notify Handle, or both.
If the Phone Number policy is Allow Any, the Noftify Handle will be unavailable.

Send 1. An Optional setting Click Enable box to active the SMS response function.

confirmed 2. The box is unchecked by The gateway will send a confirmed message back to the sender whenever it

SMS default. received a SMS managing event. The confirmed message is similar to following
format: “Device received a SMS with command xxxxx.”

Enable The box is unchecked by Click Enable box to activate this account.

default.
Save NA Click the Save button to save the configuration.

Create / Edit Email Service Account

Setup the Email Service Account for event notification. It supports up to a maximum of 5 accounts.

« Email Service List [ R

Email Server

Email Addresses Enable Actions

You can click the Add / Edit button to configure the Email account.

%1 Email Service Configuration ®

Item Setting

, Email Server

¥ Email Addresses | ‘

*» Enable Enable

Email Service Configuration

Item Value setting Description
Email Server --- Option --- Select an Email Server profile from External Server setting for the email account
setting.
Email 1. Internet E-mail address Specify the Destination Email Addresses.
Addresses format
2. A Must filled setting
Enable The box is unchecked by Click Enable box to activate this account.
default.
Save NA Click the Save button to save the configuration

Create / Edit Remote Host Profile

Setup theRemote Host Profile. It supports up to a maximum of 10 profiles.
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ID | Host Name

Protocol
Type

Host IP

Number

Port

Prefix Message Suffix Message Enable Actions

You can click the Add / Edit button to configure the profile.

% Remote Host Configuration ®

Item

Setting

» Host Name

» Host IP

¥ Pratocol Type

¥ Port Number

» Prefix Message

» Suffix Message

» Enable

Remote Host Configuration

Item

Value setting

Description

Host Name 1. String format Specify the Remote Host profile name.
2. A Must filled setting Value Range:-1 ~ 64 characters.
Host IP 1. A Must filled setting Specify the IP address for the Remote Host. IPv4 Format.

2.IP Address format.

Protocol Type

1. A Must filled setting
2. TCPis selected by default

Specify the protocol to access the Remote Host. It could be TCP or UDP.

Port Number

1. A Must filled setting

Specify the Port number for accessing the Remote Host.
Value Range:1 ~ 65535.

Prefix 1. String format Specify the Prefix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting ~ remote host, if required.
Value Range:-1 ~ 64 characters.
Suffix 1. String format Specify the Suffix Message string as pre-defined identification for accessing the
Message 2. An Optional filled setting ~ remote host, if required.
Value Range:-1 ~ 64 characters.
Enable The box is unchecked by Click Enable box to activate this profile setting.
default.
Save NA Click the Save button to save the configuration
Undo NA Click the Undo button to restore what you just configured back to the previous

setting.

7.2.2 Managing Events

Managing Events allow administrator to define the relationship (rule) among event trigger, handlers and

246




5G/LTE WAN Extender

response.

Go to Service>SMS & Event>Managing Events Tab.

Enable Managing Events

% Configuration . X

Item Setting

» Managing Events () Enable

Configuration

Item Value setting Description

Managing The box is unchecked by Check the Enable box to activate the Managing Events function.
Events default

Create / Edit Managing Event Rules

Setup the Managing Event rules. It supports up to a maximum of 128 rules.

Event Name Trigger Type Description

When Add or Edit button is applied, the Managing Event Configuration screen will appear.
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% Managing Event Configuration

Item Setting

» Event Name ‘ l

' None v |
Bt and
and | None v |

» Trigger Type | | Period v |

» Interval D (0~BB400 seconds)

» Description

[ Network Status

[ WWAN

[ LANENVLAN

[ NAT

[ Firewall

O vPN

[ GRE

[ ] Systern Manage
[ Administration
[ Remaote Host

» Action

» Managing @ Enable
Event

Save

Managing Event Configuration

Item Value setting Description

Event None by default Specify the Event type (SMS, orSNMP Trap) and an event identifier / profile. Up
to 3 event conditions can be specified for defining an event, and the event will
be triggered when all the conditions hold simutaneously (AND relation).

The supported Event types could be:

SMS: Select SMS and fill the message in the textbox to as the trigger condition
for the event;

SNMP: Select SNMP Trap and fill the message in the textbox to specify SNMP
Trap Event;

Note: The available Event Type could be different for the purchased product.
Trigger Type Period is selected by default ~ Specify the type of event trigger, either Period or Once.
Period: Select Period and specify a time interval, the event will be repeatedly
triggered on every time interval when the specified event condition holds.
Once: Select Once and the event will be just triggered just one time when the
specified event condition holds.
Interval 0 is set by default Specify the repeatedly event trigger time interval.

Value Range:0 ~86400 seconds.

Description String format : any text. Enter a brief description for the Managing Event.
Action All box is unchecked by Specify Network Status, or at least one rest action to take when the expected
default. event is triggered.
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Network Status: Select Network Status Checkbox to get the network status as
the action for the event;

LAN&VLAN: Select LAN&VLAN Checkbox and the interested sub-items (Port link
On/Off), the gateway will change the settings as the action for the event;

NAT: Select NAT Checkbox and the interested sub-items (Virtual Server Rule
On/Off, DMZ On/Off), the gateway will change the settings as the action for the
event;

Firewall: Select Firewall Checkbox and the interested sub-items (Remote
Administrator Host ID On/Off), the gateway will change the settings as the
action for the event;

VPN: Select VPN Checkbox and the interested sub-items (IPSec Tunnel ON/Off,
PPTP Client On/Off, L2TP Client On/Off, OpenVPN Client On/Off), the gateway
will change the settings as the action for the event;

GRE: Select GRE Checkbox and the interested sub-items (GRE Tunnel On/Off),
the gateway will change the settings as the action for the event;

System Manage: Select System Manage Checkbox and the interested sub-items
(WAN SSH Service On/Off, TR-069 On/Off), the gateway will change the settings
as the action for the event;

Administration: Select Administration Checkbox and the interested sub-items
(Backup Config, Restore Config, Reboot, Save Current Setting as Default), the
gateway will change the settings as the action for the event;

Remote Host: Select Remote Hostcheckbox and a Remote Host profile you
defined as the action for the event;

Note: The available Event Type could be different for the purchased product.

Managing The box is unchecked by Click Enable box to activate this Managing Event setting.

Event default.

Save NA Click the Save button to save the configuration

Undo NA Click the Undo button to restore what you just configured back to the previous
setting.

7.2.3 Notifying Events

Go to Service>SMS & Event >Notifying Events Tab.

Notifying Events Setting allows administrator to define the relationship (rule) between event trigger and
handlers.

Enable Notifying Events

Item Setting

» Notifying Events ¢ Enable
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Value setting \ Description
Notifying Events The box is unchecked by Check the Enable box to activate the Notifying Events function.
default

Create / Edit Notifying Event Rules

Setup your Notifying Event rules. It supports up to a maximum of 128 rules.

Description Enable | Actions

Schedule

When Addor Editbutton is applied, the Notifying Event Configuration screen will appear.

= Notifying Event Configuration
Item Setting
¥ Event | |
Mame
| None v
» Event and | None v
and | Mone v |
¥ Trigger Period *
Type
» Interval D (0~36400 seconds)
¥ Description |

+ Delay to 0~3600 seconds
b e )

[] 8MS

[C] Syslog

] SNMP Trap (Only Support 1 and v2c)
[] Email Alert

] Remote Host

] System

> Time
Schedule (0) Always

* Nofifying | @) Enable
Events

+ Action

Notifying Event Configuration

Item Value setting Description
Event Name Blank by default Specify a name or identifier for this notifying event rule.
Value Range:0 ~ 64 characters.
Event None by default Specify the Event type and corresponding event configuration. Up to 3 event

conditions can be specified for defining an event, and the event will be
triggered when all the conditions hold simutaneously (AND relation).
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Trigger Type

Interval

Description
Delay to Send

Action

Time Schedule

Notifying
Events
Save
Undo

Period is selected by default

0 is set by default

String format : any text.
Blank by default

All box is unchecked by
default.

(0) Always is selected by
default

The box is unchecked by
default.

NA

NA

The supported Event Type could be:

Power Change: Select Power Change and a trigger condition to specify the
event on a certain power source.

WAN: Select WAN and a trigger condition to specify acertain WAN Event;
LAN&VLAN: Select LAN&VLAN and a trigger condition to specify acertain
LAN&VLAN Event;

DDNS: Select DDNS and a trigger condition to specify acertain DDNS Event;
Administration: Select Administration and a trigger condition to specify
acertain Administration Event;

Data Usage: Select Data Usage, the SIM Card (Cellular Service) and a trigger
condition to specify acertain Data Usage Event;

Note: The available Event Type could be different for the purchased product.
Specify the type of event trigger, either Period or Once.

Period: Select Period and specify a time interval, the event will be repeatedly
triggered on every time interval when the specified event condition holds.
Once: Select Once and the event will be just triggered just one time when the
specified event condition holds.

Specify the repeatedly event trigger time interval.

Value Range:0 ~86400 seconds.

Enter a brief description for the Notifying Event.

Specify a delay time, if required, to send out the notifying event once it had
been triggered.

Value Range:0 ~3600 seconds.

Specify at least one action to take when the expected event is triggered.
SMS: Select SMS,and the gateway will send out a SMS to all the defined SMS
accounts as the action for the event;

Syslog: Select Syslog and select/unselect the Enable Checkbox to as the action
for the event;

SNMP Trap: Select SNMP Trap, andthe gateway will send out SNMP Trap to
the defined SNMP Event Receivers as the action for the event;

Email Alert: Select Email Alert, andthe gateway will send out anEmail to the
defined Email accounts as the action for the event;

Remote Host: Select Remote Hostcheckbox and a Remote Host profile you
defined as the action for the event;

System: Select Reboot after 30 sec.checkbox as the action for the event;

Note: The available Event Type could be different for the purchased product.
Select a time scheduling rule for the Notifying Event.

Click Enable box to activate this Notifying Event setting.
Click the Save button to save the configuration

Click the Undo button to restore what you just configured back to the previous
setting.
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Chapter 8Status

8.1Dashboard

| () Status

—

= Device Up-Time:  3day Ohr 22min 32sec Sec v
- Security p y

CPU: 8% 100%
- Administration "
Memory: s 59%
- Statistics & Reports

| Basic Network |

| @ Object Definition |

Connection Sessions: 0%

= Network Interface Status aa

Current
Download
Traffic

eth2 | Ethernet 190 (MB) 311 (MB) 3 (KB) 2 (KB)

. Download Current
Device| Type | Upload Traffic Traffic Upload Traffic
'@ Field Communication |

{/

N, fanmnsss ___r"mm L LU
' Security | eth2.1 | Ethernet 24 (MB) 49 (KB) 18 (Bytes) 0 (Bytes) WA T

eth2.2 | Ethernet| 147 (MB) 273 (MB) 3(KB) 2 (KB) e e e N EN

10:04:40 100450 10:05:00 10:0510 10:05:20 10:05:30

\ /

Administration
' 9 I brd | Ethernet 19 (MB) 30 (MB) 0 (Bytes) 0 (Bytes)

8.1.1Device Dashboard

The Device Dashboard window shows the current status in graph or tables for quickly understanding the
operation status for the gateway. They are the System Information, System Information History, and Network
Interface Status. The display will be refreshed once per second.

From the menu on the left, select Status >Dashboard >Device Dashboard tab.

System Information Status
The System Information screen shows the device Up-time and the resource utilization for the CPU, Memory,
and Connection Sessions.

% System Information . x

Device Up-Time: J3day 1hr 21min 48sec

CPU: @ 10%
Memory: s 59%
Connection Sessions: 0%
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System InformationHistory
The System Information History screen shows the statistic graphs for the CPU and memory.

~ o . Sec v
Sec v 250 MB
Memory
il 225 MB
- CPU1
: CPU2 200 MB
80% Hl CPU 3 175 MB
v
70% Il CPU 4
60%
i 125 MB
50%
0 100 MB
S 75 MB
20%| aninl 50 MB
10% D D 25 MB
0% L= 0 MB
10440 110450 110500 11050 10520 1t 11:05:20 1:05:30 11:05:40 11:05:50 11:06:00 11:06:10

Network Interface Status

The Network Interface Status screen shows the statistic information for each network interface of the
gateway. The statistic information includes the Interface Type, Upload Traffic, Download Traffic, and Current
Upload / Download Traffic.

- - »

Upload | Download Current = Current

Device, Type : - Upload | Download
Traffic Traffic Traffic Traffic
eth2 | Ethernet| 211 (MB) | 321 (MB) 3 (KB) 3 (KB)

eth21 Ethernet| 24 (MB) | 71(KB) | 64 (Bytes) O (Bytes)

eth2.2 Ethemnet 168 (MB) | 283 (MB) 3 (KB) 3 (KB)

br0 | Ethemet 19(MB) | 31(MB) | 42 (Bytes) | O (Bytes)

Wireless

ra0 LAN 1 (MB) 1{MB) 0 (Bytes) 0 (Bytes)
: Wireless ,
rai0 LAN 21 (MB) 42 (MB) 0 (Bytes) 0 (Bytes)

ral W[ﬁfﬁss 0(Bytes) | O(Byles) | O (Bytes) | O (Bytes)

Wireless 362

rail LAN (Bytes) 4 (KB) 0 (Bytes) 0 (Bytes)

tund | Ethemnet| O (Bytes) | O (Bytes) | 0 (Bytes) | O (Bytes)
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8.2Basic Network

8.2.1WAN & Uplink Status

Go toStatus >Basic Network> WAN & Uplink tab.

The WAN & Uplink Status window shows the current status for different network type, including network
configuration, connecting information, modem status and traffic statistics. The display will be refreshed on

every five seconds.

WAN interface IPv4 Network Status

WAN interface IPv4 Network Status screenshows status information for IPv4 network.

1D Interface | WAN Type Network Type IP Addr. Subnet Mask Gateway DNS MAC Address Conn. Status Action
WAN-T | Cellular(5G/LTE) | Cellular NAT 0.0.00 0.0.0.0 0.0.00 8 gg g‘ 73 Commectng... Edit
WAN-2 Disable Edit
ID N/A It displays corresponding WAN interface WAN IDs.
It displays the type of WAN physical interface.
Interface N/A Depending on the model purchased, it can be Ethernet, 3G/4G/5G, or WiFi
Uplink.
It displays the method which public IP address is obtained from your ISP.
WAN Type N/A Depending on the model purchased, it can be Static IP, Dynamic IP, PPPoE,
PPTP, L2TP, 3G/4G/5G.
It displays the network type for the WAN interface(s).
Network Type N/A Depending on the model purchased, it can be NAT, Routing, Bridge, or IP Pass-
through.
1P Addr. N/A It displa\./s the public IP adc.:Jress obtéined from yc.'ur ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.
Subnet Mask N/A It displays the Su.bnet Mask for pub.lic IP add.ress obtained. from your ISP for
Internet connection. Default value is 0.0.0.0 if left unconfigured.
It displays the Gateway IP address obtained from your ISP for Internet
Gateway N/A . . . .
connection. Default value is 0.0.0.0 if left unconfigured.
DNS N/A It displays the IP address of DNS server obtained from your ISP for Internet
connection. Default value is 0.0.0.0 if left unconfigured.
It displays the MAC Add f ISP to all for Int t . Note:
MAC Address N/A isplays the ' re'ss .or your o allow you for Internet access. Note
Not all ISP may require this field.
Conn. Status N/A It displays the connection status of the device to your ISP.

Status are Connected or disconnected.

254



5G/LTE WAN Extender

This area provides functional buttons.

Renewbutton allows user to force the device to request an IP address from
the DHCP server. Note: Renew button is available when DHCP WAN Type is
used and WAN connection is disconnected.

Release button allows user to force the device to clear its IP address setting to
disconnect from DHCP server. Note: Release button is available when DHCP
WAN Type is used and WAN connection is connected.

Action N/A
Connect button allows user to manually connect the device to the Internet.
Note: Connect button is available when Connection Control in WAN Type
setting is set to Connect Manually (Refer to Edit button in Basic Network >
WANG& Uplink> Internet Setup) and WAN connection status is disconnected.

Disconnect button allows user to manually disconnect the device from the
Internet. Note: Connect button is available when Connection Control in WAN
Type setting is set to Connect Manually (Refer to Edit button in Basic Network
> WAN& Uplink> Internet Setup) and WAN connection status is connected.

WAN interface IPv6 Network Status

WAN interface IPv6 Network Status screen shows status information for IPv6 network.

ID Interface | WAN Type Link-local IP Address Global IP Address Conn. Status Action

WAN-1 | Celuler(5G/LTE) 1Py 164 Disconnacted Edit

ID N/A It displays corresponding WAN interface WAN IDs.
Interface N/A It dlspla.ys the type of WAN physical |'nterface.

Depending on the model purchased, it can be Ethernet, 3G/4G/5G, etc...
WAN Type N/A It displays the method which public IP address is obtained from your ISP. WAN

type setting can be changed from Basic Network > IPv6 > Configuration.
Link-local IP Address N/A It displays the LAN IPv6 Link-Local address.
Global IP Address N/A It displays the IPv6 global IP address assigned by your ISP for your Internet
connection.
It displays the connection status. The status can be connected, disconnected
Conn. Status N/A )
and connecting.
This area provides functional buttons.
Action N/A Edit Button when pressed, web-based utility will take you to the IPv6

configuration page. (Basic Network > IPv6 > Configuration.)

255



5G/LTE WAN Extender

LAN InterfaceNetwork Status

LAN InterfaceNetwork Status screen shows IPv4 and IPv6 information of LAN network.

# LAN Interface Network Status ’ ®

IPv4 Address IPv4 Subnet Mask IPv6 Link-local Address IPv6 Global Address MAC Address Action

192.165.66.1 255.255.254.0 fe80::250: 181 fe3a 4asf 164 00:50:18:3A4A5F ‘ Edit IPv4 | Edit IPvE ‘

LAN Interface Network Status
Item Value setting Description
It displays the current IPv4 IP Address of the gateway

IPv4 Address N/A . .
This is also the IP Address user use to access Router’s Web-based Utility.
IPv4 Subnet Mask N/A It displays the current mask of the subnet.
IPv6 Link-local N/A It displays the current LAN IPv6 Link-Local address.
Address This is also the IPv6 IP Address user use to access Router’s Web-based Utility.

IPV6 Global Address  N/A It displays the cu.rrent IPv6 global IP address assigned by your ISP for your
Internet connection.
MAC Address N/A It displays the LANMAC Address of the gateway
This area provides functional buttons.
Edit IPv4 Button when press, web-based utility will take you to the Ethernet
Action N/A LAN configuration page. (Basic Network > LAN & VLAN > Ethernet LAN tab).

Edit IPv6 Button when press, web-based utility will take you to the IPv6

configuration page. (Basic Network > IPv6 > Configuration.)

5G/LTE Modem Status

5G/LTE Modem Status List screen shows status information for 4G/5GWAN network(s).

% Cellular Modem Status List

Interface Card Information Link Status Signal Strength Network Name Action
Collular(5G/TE) RMBZ0N-GL Disconnected N7 MR

Cellular Modem Status List

Item Value setting Description

Physical It displays the type of WAN physical interface.

Interface N/A Note: Some device model may support two 3G/4G/5G modules. Their physical
interface name will be Cellular

::naf::'mation N/A It displays the vendor’s 5G/LTE modem model name.
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Link Status

Signal
Strength
Network
Name

Refresh

Action

N/A

N/A

N/A

N/A

N/A

It displays the 5G/LTE connection status. The status can be Connecting, Connected,
Disconnecting, and Disconnected.

It displays the 5G/LTEwireless signal level.

It displays the name of the service network carrier.

Click the Refresh button to renew the information.

This area provides functional buttons.

Detail Button when press, windows of detail information will appear. They are the
Modem Information, SIM Status, and Service Information. Refer to next page for
more.

When theDetail buttonis pressed, 3G/4G/5G modem information windows such as Modem Information, SIM
Status, Service Information, Signal Strength / Quality, and Error Message will appear.

Interface Traffic Statistics

Interface Traffic Statisticsscreen displays the Interface’s total transmitted packets.

D Interface

WAN-1 | Cellular(5G/ATE)

WAN-2

ID

Interface

Received Packets

(Mb)

Transmitted Packets

(Mb)

N/A

N/A

N/A

N/A

Received Packets(Mb) Transmitted Packets(Mb) Action

0 0 Reset

It displays corresponding WAN interface WAN IDs.

It displays the type of WAN physical interface.

Depending on the model purchased, it can be Ethernet, 5G/LTE, etc...

It displays the downstream packets (Mb). It is reset when the device is
rebooted.

It displays the upstream packets (Mb). It is reset when the device is rebooted.

8.2.2LAN & VLAN Status

Go to Status>Basic Network >LAN & VLANtab.

Client List
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The Client List shows you the LAN Interface, IP address, Host Name, MAC Address, and Remaining Lease Time
of each device that is connected to this gateway.

_

LAN Interface IP Address Host Name MAC Address Remaining Lease Time

Ethermet Dynamic / 192.168.66.100 amit25613572 00-13-3B-0E-3B-1D 00:15:00

LAN Client List

Item Value setting Description
A

LAN Interface N/ Client record of LAN Interface. String Format.

1P Address N/A Client record of IP Address Type and the IP Address. Type is String Format and
the IP Address is IPv4 Format.

Host Name N/A Client record of Host Name. String Format.

MAC Address N/A Client record of MAC Address. MAC Address Format.

Remaining Lease . . . .

Time N/A Client record of Remaining Lease Time. Time Format.
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8.2.3WiFi Status (not supported)

Not supported feature for the purchased product, leave it as blank.
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8.2.4 DDNS Status

Go to Status>Basic Network >DDNS tab.

The DDNS Status window shows the current DDNS service in use, the last update status, and the last update
time to the DDNS service server.

DDNS Status

Host Name Provider Effective IP Last Update Status Last Update Time

DDNS Status

Item Value Setting Description \
Host Name N/A It displays the name you entered to identify DDNS service provider

Provider N/A It displays the DDNS server of DDNS service provider

Effective IP N/A It displays the public IP address of the device updated to the DDNS server

Last Update N/A It displays whether the last update of the device public IP address to the DDNS
Status server has been successful (Ok) or failed (Fail).

Last Update Time N/A It displays time stamp of the last update of public IP address to the DDNS server.
Refresh N/A The refresh button allows user to force the display to refresh information.
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8.3Security

. Widget

[ @. Status VPN Firewall

- Dashboard

- Basic Network # IPSec Tunnel Status m ° n
M D Tunnel Name Tunnel Scenario Local Subnets Remote IP/FQDN Remote Subnets Conn. Time Status

- Administration .

= OpenVPN Server Status m ° °
- Statistics & Reports
ID User Name Remote IP/FQDN Virtual IP/Mac Conn. Time Status

| . Basic Network

= openveN ciient status [T IREET
| @ Object Definition D OpenVPN Client Name Interface Remote IP/FQDN Remote Subnet Virtual IP Conn. Time Conn. Status

| Security
| Administration

| @ Service

= L2TP Server Status m ° °

[s] User Name Remote IP Remote Virtual IP Remote Call ID Conn. Time Status

= L2TP Client Status m

ID L2TP Client Name Interface Virtual IP Remote IP/FQDN Default Gateway/Remote Subnet, Conn.Time  Status

8.3.1 VPN Status

Go to Status>Security>VPN tab.

The VPN Status widow shows the overall VPN tunnel status. The display will be refreshed on every five
seconds.

IPSec Tunnel Status

IPSec TunnelStatuswindows show the configuration for establishing IPSec VPN connection and current
connection status.

| Edit |

%] IPSec Tunnel Status

Tunnel Name Tunnel Scenario Local Subnets Remote IP/IFQDN Remote Subnets Conn. Time

IPSec Tunnel Status

Item Value setting Description

Tunnel Name N/A It displays the tunnel name you have entered to identify.
Tunnel Scenario N/A It displays the Tunnel Scenario specified.

Local Subnets N/A It displays the Local Subnets specified.

Remote IP/FQDN N/A It displays the Remote IP/FQDN specified.

Remote Subnets N/A It displays the Remote Subnets specified.

Conn. Time N/A It displays the connection time for the IPSec tunnel.
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Status N/A It displays the Status of the VPN connection. The status displays are
Connected, Disconnected, Wait for traffic, and Connecting.
li EditB h IP i - ili ill tak
Edit Button N/A Click on Edit utt.on to'c ange IPSec se'ftmg, web-based utility will take you
to the IPSec configuration page. (Security> VPN > IPSec tab)

OpenVPN Server Status

According to OpenVPN configuration, the OpenVPN Server/Client Status shows the status and statistics for
the OpenVPN connection from the server side or client side.

% OpenVPN Server Slalus--

Conn. Time

Virtual IP/Mac

User Name Remote IP/FQDN

OpenVPN Server Status

Item | Value setting Description

User Name N/A It displays the Client name you have entered for identification.

Remote N/A It displays the public IP address (the WAN IP address) of the connected

IP/FQDN OpenVPN Client

Virtual IP/MAC N/A It displays the virtual IP/MAC address assigned to the connected OpenVPN
client.

Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.

Status N/A It displays the connection status of the corresponding OpenVPNtunnel.
The status can be Connected, or Disconnected.

OpenVPN Client Status

= OpenVPN Client Status[[ZTI Il

OpenVPN Client Name

OpenVPN Client Status
Item Value setting Description

Interface Remote IP/IFQDN Remote Subnet Virtual IP Conn. Time Conn. Status

OpenVPN Client N/A It displays the Client name you have entered for identification.

Name

Interface N/A It displays the WAN interface specified for the OpenVPN client connection.
Remote N/A It displays the peerOpenVPNServer’s Public IP address (the WAN IP address) or
IP/FQDN FQDN.

Remote Subnet N/A It displays the Remote Subnet specified.

TUN/TAP N/A It displays the TUN/TAP Read Bytes of OpenVPN Client.

Read(bytes)

TUN/TAP N/A It displays the TUN/TAP Write Bytes of OpenVPN Client.

Write(bytes)

TCP/UDP N/A It displays the TCP/UDP Read Bytes of OpenVPN Client.

Read(bytes)

TCP/UDP N/A It displays the TCP/UDP Write Bytes of OpenVPN Client.

Write(bytes) Connection

Conn. Time N/A It displays the connection time for the corresponding OpenVPN tunnel.
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Conn. Status N/A It displays the connection status of the corresponding OpenVPNtunnel.
The status can be Connected, or Disconnected.
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L2TP Server/Client Status

LT2TP Server/Client Status shows the configuration for establishing LT2TP tunnel and current connection
status.

Remote Virtual IP Remote Call ID Conn. Time

Remote IP

L2TP Server Status

Item Value setting Description

User Name N/A It displays the login name of the user used for the connection.

Remote IP N/A It displays the public IP address (the WAN IP address) of the connected L2TP
client.

Remote Virtual IP N/A It displays the IP address assigned to the connected L2TP client.

Remote Call ID N/A It displays the L2TP client Call ID.

Conn. Time N/A It displays the connection time for the L2TP tunnel.

Status N/A It displays the Status of each of the L2TP client connection. The status
displays Connected, Disconnect, Connecting

Edit N/A Click on Edit Button to change L2TP server setting, web-based utility will
take you to the L2TP server page. (Security> VPN > L2TP tab)

= L2TP Client Status "

Virtual IP

L2TP Client Name

Interface Remeote IP/FQDN Default Gateway/Remote Subnet Conn. Time | Status

L2TP Client Status

Item Value setting Description

Client Name N/A It displays Name for the L2TP Client specified.

Interface N/A It displays the WAN interface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.

Virtual IP N/A It displays the IP address assigned by Virtual IP server of L2TP server.
It displ he L2TP ’s Public IP he WAN IP

Remote IP/FQDN N/A t displays the Server’s Public IP address (the address) or
FQDN.

Defaul It displays the specified IP address of the gateway device used to connect to

efault the internet to connect to the L2TP server —the default gateway. Or other

Gateway/Remote N/A i ] )

Subnet specified subnet if the default gateway is not used to connect to the L2TP
server —the remote subnet.

Conn. Time N/A It displays the connection time for the L2TP tunnel.
It displays the Status of the VPN connection. The status displays Connected,

Status N/A . .
Disconnect, and Connecting.

Edit N/A Click on Edit Button to change L2TP client setting, web-based utility will take
you to the L2TP client page. (Security> VPN > L2TP tab)
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PPTP Client Status

PPTP Client Status shows the configuration for establishing PPTP tunnel and current connection status.

ID| PPTP Client Name

Client Name
Interface

Virtual IP
Remote IP/FQDN
Default

Gateway/Remote
Subnet

Conn. Time

Status

Edit Button

Edit

Interface

N/A
N/A
N/A

N/A

N/A

N/A

N/A

N/A

8.3.2 Firewall Status

Go to Status >Security > Firewall Status Tab.

Remote IP/FQDN Default Gateway/Remote Subnet| Conn. Time Status

It displays Name for the PPTP Client specified.

It displays the WAN interface with which the gateway will use to request
PPTP tunneling connection to the PPTP server.

It displays the IP address assigned by Virtual IP server of PPTP server.

It displays the PPTP Server’s Public IP address (the WAN IP address) or
FQDN.

It displays the specified IP address of the gateway device used to connect to
the internet to connect to the PPTP server —the default gateway. Or other
specified subnet if the default gateway is not used to connect to the PPTP
server —the remote subnet.

It displays the connection time for the PPTP tunnel.

It displays the Status of the VPN connection. The status displays Connected,
Disconnect, and Connecting.

Click on Edit Button to change PPTP client setting, web-based utility will
take you to the PPTP server page. (Security> VPN > PPTP tab)

The Firewall Status provides user a quick view of the firewall status and current firewall settings. It also keeps
the log history of the dropped packets by the firewall rule policies, and includes the administrator remote
login settings specified in the Firewall Options. The display will be refreshed on every five seconds.

By clicking the icon [+], the status table will be expanded to display log history. Clicking the Edit button the
screen will be switched to the configuration page.

Packet Filter Status

Activated Filter Rule

Edit

Detected Contents IP Time
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Packet Filter Status

Item Value setting Description
Activated Filter o .
Rule N/A This is the Packet Filter Rule name.
This is the logged packet information, including the source IP, destination IP,
Detected N/A protocol, and destination port —the TCP or UDP.
Contents String format:
Source IP to Destination IP : Destination Protocol (TCP or UDP)
P N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure Packet Filter Log Alert is enabled.
Refer to Security> Firewall > Packet Filter tab. Check Log Alert and save the setting.

MACControl Status

Blocked MAC Addresses

Activated Control Rule

MAC Control Status

Item Value setting Description
Activated o
N/A This is the MAC Control Rule name.
Control Rule
Blocked MAC -
Addresses N/A This is the MAC address of the logged packet.
P N/A The Source IP (IPv4) of the logged packet.
Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure MAC Control Log Alert is enabled.
Refer to Security> Firewall > MAC Control tab. Check Log Alert and save the setting.

Application Filters Status

Filtered Application Category Filtered Application Name

Application Filters Status

Item Value setting Description
Filtered Application L .
Category N/A The name of the Application Category being blocked.
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;I::::d Application N/A The name of the Application being blocked.

P N/A The Source IP (IPv4) of the logged packet.

Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month"
"Day" "Hours":"Minutes":"Seconds")

Note: Ensure Application Filter Log Alert is enabled.
Refer to Security> Firewall > Application Filter tab. Check Log Alert and save the setting.

IPS Status

Detected Intrusion

IPS Firewall Status

Item Value setting Description

Detected L . . .

Intrusion N/A This is the intrusion type of the packets being blocked.
IP N/A The Source IP (IPv4) of the logged packet.

Time N/A The Date and Time stamp of the logged packet. Date & time format. ("Month" "Day

"Hours":"Minutes":"Seconds")
Note: Ensure IPS Log Alert is enabled.
Refer to Security> Firewall > IPS tab. Check Log Alert and save the setting.

Firewall Options Status

| Edit | x

= Options

Stealth Mode SPI Discard Ping from WAN Remote Administrator Management

Disable Disable Disable IP: 192.1656.121.54, User Name: admin, Time: Apr 1 11:14:54

Firewall Options Status

Item Value setting Description
Enable or Disable setting status of Stealth Mode on Firewall Options.
String Format: Disable or Enable

Stealth Mode N/A

SPI N/A Enable or Disable setting status of SPI on Firewall Options.
String Format : Disable or Enable

Enable or Disable setting status of Discard Ping from WAN on Firewall

Discard Ping from .
N/A Options.

WAN
String Format: Disable or Enable
Remote Enable or Disable setting status of Remote Administrator.
Administrator N/A If Remote Administrator is enabled, it shows the currently logged in
Management administrator’s source IP address and login user name and the login time.
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Format:
IP: "Source IP", User Name: "Login User Name", Time: "Date time"
Example:
IP: 192.168.127.39, User Name: admin, Time: Mar 3 01:34:13
Note: Ensure Firewall Options Log Alert is enabled.
Refer to Security> Firewall > Options tab. Check Log Alert and save the setting.

8.4Administration

8.4.1Configure & Manage Status

Go to Status >Administration> Configure & Managetab.

The Configure & Manage Status window shows the status for managing remote network devices. The type of
management available in your device is depended on the device model purchased. The commonly used ones
are the SNMP, TR-069, and UPnP. The display will be refreshed on every five seconds.

SNMP Linking Status

SNMP Link Status screen shows the status of current active SNMP connections.

.|

User Name IP Address Port Community Auth. Mode Privacy Mode SNMP Version

It displays the user name for authentication. This is only available for SNMP

User Name N/A ]
version 3.
IP Address N/A It displays the IP address of SNMP manager.
It displays the port number used to maintain connection with the SNMP
Port N/A
manager.
Community N/A It displays the community for SNMP version 1 or version 2c only.
Auth. Mode N/A It displays the authentication method for SNMP version 3 only.
Privacy Mode N/A It displays the privacy mode for version 3 only.
SNMP Version N/A It displays the SNMP Version employed.

SNMP Trap Information

SNMP Trap Information screen shows the status of current received SNMP traps.
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= SNMP Trap Information

Trap Event

Trap Level

SNMP Trap Information

Item Value setting Description

Trap Level N/A It displays the trap level.

Time N/A It displays the timestamp of trap event.

Trap Event N/A It displays the IP address of the trap sender and event type.

TR-069 Status

TR-069 Statusscreen shows the current connection status with the TR-068 server.

= TR-069 Status ' ®

Link Status

Off

TR-069 Status

Item Value setting Description
It displays the current connection status with the TR-068 server. The connection
Link Status N/A status is either On when the device is connected with the TR-068 server or Off

when disconnected.

8.4.2Log Storage Status
Go to Status >Administration> Log Storagetab.

The Log Storage Statusscreen shows the status for selected device storage.

Log Storage Status

Log Storage Status screen shows the status of current the selected device storage. The status includes Device
Description, Usage, File System, Speed, and status.

= Storage Information

File System

Device Description
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8.5Statistics & Report

8.5.1Connection Session

Go to Status >Statistics& Reports>Connection Session tab.

Internet Surfing Statistic shows the connection tracks on this router.

# Internet Surfing List (14 entries) W&z} [+115 Last || Export (xml) | Export (.csv)
Reftesh
User Name Protocol Internal IP & Port MAC External IP & Port Duration Time
UDP 192.168.127.58:3847 58.198.95.100:1194 2019/04/01 12:09~
UDP 192.168.127.58:4486 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:2899 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:1251 192.168.123.10:53 2019/04/01 12:09~
UDP 192.168.127.58:3145 192.168.123.10:53 2019/04/01 12:09~

Internet Surfing Statistic

Item H Value setting \ Description

Previous N/A Click the Previous button; you will see the previous page of track list.
Next N/A Click the Next button; you will see the next page of track list.

First N/A Click the First button; you will see the first page of track list.

Last N/A Click the Last button; you will see the last page of track list.

Export (.xml) N/A Click the Export (.xml) button to export the list to xml file.

Export (.csv) N/A Click the Export (.csv) button to export the list to csv file.

Refresh N/A Click the Refresh button to refresh the list.
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8.5.2Network Traffic

Go to Status >Statistics& Reports>Network Traffic tab.

Network Traffic Statisticsscreen shows the historical graph for the selected network interface.

You can change the interface drop list and select the interface and sampling time interval you want to monitor.

WAN v seconds ¥ || \yaNT v

5Mb
WAN 1 Inbound
H WAN 1 Cutbound

4Mb
IMb
2Mb
1.9Mb
1.4Mb
1Mb
0.5Mb
oMb

12:11:00 12:11:10 12:11:20 12:11:30 12:11:40 12:11:50 1212

nooune: (1S e 5[0 o TG
» WAN 1 Out Bound: 164 Kbits/sec Average: 51 Kbits/sec Peak. 2431.7 Kbits/sec

(2.0 KBytes/sec)

(6.4 KBytes/sec)

{304.0 KBytes/sec)
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8.5.3Login Statistics

Go to Status >Statistics& Reports>Login Statistics

Login Statistics shows the login information.

# Device Manager Login Statistics 82 =lY0TE i Export {.csv)

User Name Protocol Type IP Address Info Duration Time
admin HTTP 192.168.123.190 Admin 2018/01/01 00:00~
admin HTTP 192 168.123.190 Admin 2018/01/01 00:02~
admin HTTP 192.168.123.190 Login Fail 2019/06/05 16:30~
admin HTTP 192 168.123.190 Admin 2019/06/05 16:30~

Device Manager Login Statistic

Item Value setting Description

Previous N/A Click the Previous button; you will see the previous page of login statistics.
Next N/A Click the Next button; you will see the next page of login statistics.

First N/A Click the First button; you will see the first page of login statistics.

Last N/A Click the Last button; you will see the last page of login statistics.

Export (.xml) N/A Click the Export (.xml) button to export the login statistics to xml file.
Export (.csv) N/A Click the Export (.csv) button to export the login statistics to csv file.
Refresh N/A Click the Refresh button to refresh the login statistics.
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8.5.4Cellular Usage

Go to Status >Statistics& Reports>Cellular Usage tab.

Cellular Usagescreen shows data usage statistics for the selected cellular interface. The cellular data usage can
be accumulated per hour or per day.

Data Usage Records
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Appendix A GPL WRITTEN OFFER

This product incorporates open source software components covered by the terms of third party copyright notices
and license agreements contained below.

GPSBabel

Version 1.4.4

Copyright (C) 2002-2005 Robert Lipe<robertlipe@usa.net>
GPL License: https://www.gpsbabel.org/

Curl

Version 7.19.6

Copyright (c) 1996-2009, Daniel Stenberg, <daniel@haxx.se>.
MIT/X derivate License: https://curl.haxx.se/

OpenSSL

Version 1.0.2m

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
GPL License: https://www.openssl.org/

brctl - ethernet bridge administration

Stephen Hemminger <shemminger@osdl.org>
Lennert Buytenhek <buytenh@gnu.org>

version 1.1

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

tc - show / manipulate traffic control settings
Stephen Hemminger<shemminger@osdl.org>
Alexey Kuznetsov<kuznet@ms?2.inr.ac.ru>

version iproute2-ss050330

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

dhcp-fwd — starts the DHCP forwarding agent

Enrico Scholz <enrico.scholz@informatik.tu-chemnitz.de>
version 0.7

GNU GENERAL PUBLIC LICENSE Version 2, June 1991

Iftp - Sophisticated file transfer program

Alexander V. Lukyanov <lav@yars.free.net>

version:4.5.x

Copyright (c) 1996-2014 by Alexander V. Lukyanov (lav@vyars.free.net)

dnsmasq - A lightweight DHCP and caching DNS server.
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Simon Kelley <simon@thekelleys.org.uk>
version:2.72
dnsmasq is Copyright (c) 2000-2014 Simon Kelley

socat - Multipurpose relay

Version: 2.0.0-b8

GPLv2
http://www.dest-unreach.org/socat/

LibModbus

Version: 3.0.3

LGPL v2
http://libmodbus.org/news/

LiblIEC60870

GPLv2

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

https://sourceforge.net/projects/mrts/

Openswan

Version: v2.6.38GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

https://www.openswan.org/

Opennhrp

Version: v0.14.1

OpenNHRP is an NHRP implementation for Linux. It has most of the RFC2332
and Cisco 10S extensions.

Project homepage: http://sourceforge.net/projects/opennhrp

Git repository: git://opennhrp.git.sourceforge.net/gitroot/opennhrp
LICENSE

OpenNHRP is licensed under the MIT License. See MIT-LICENSE.txt for
additional details.

OpenNHRP embeds libev. libev is dual licensed with 2-clause BSD and
GPLv2+ licenses. See libev/LICENSE for additional details.

OpenNHRP links to c-ares. c-ares is licensed under the MIT License.
https://sourceforge.net/projects/opennhrp/

IPSec-tools
Version: v0.8
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No GPL be written
http://ipsec-tools.sourceforge.net/

PPTP

Version: pptp-1.7.1

GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://pptpclient.sourceforge.net/

PPTPServ

Version: 1.3.4

GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 675 Mass Ave, Cambridge, MA 02139, USA
Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.http://poptop.sourceforge.net/

L2TP

Version: 0.4

CopyingAll software included in this package is Copyright 2002 Roaring
Penguin Software Inc. You may distribute it under the terms of the
GNU General Public License (the "GPL"), Version 2, or (at your option)
any later version.

http://www.roaringpenguin.com/

L2TPServ

Version: v 1.3.1GNU GENERAL PUBLIC LICENSEVersion 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.59 Temple Place, Suite 330, Boston, MA 02111-
1307 USA

Everyone is permitted to copy and distribute verbatim copies

of this license document, but changing it is not allowed.

http://www.xelerance.com/software/xI2tpd/

Mpstat: from sysstat, system performance tools for Linux
Version: 10.1.6
Copyright: (C) 1999-2013 by Sebastien Godard (sysstat <at> orange.fr)

SSHD: dropbear, a SSH2 server
Version: 0.53.1
Copyright: (c) 2002-2008 Matt Johnston

Libncurses: The ncurses (new curses) library is a free software emulation of curses in System V Release 4.0
(SVr4), and more.
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Version: 5.9
Copyright: (c) 1998,2000,2004,2005,2006,2008,2011,2015 Free Software Foundation, Inc., 51 Franklin Street,
Boston, MA 02110-1301, USA

MiniUPnP: The miniUPnP daemon is an UPnP IGD (internet gateway device) which provide NAT traversal
services to any UPnP enabled client on the network.

Version: 1.7

Copyright: (c) 2006-2011, Thomas BERNARD

CoovacChilli is an open-source software access controller for captive portal (UAM) and 802.1X access
provisioning.

Version: 1.3.0

Copyright: (C) 2007-2012 David Bird (Coova Technologies) <support@coova.com>

Krb5: Kerberos is a network authentication protocol. It is designed to provide strong authentication for
client/server applications by using secret-key cryptography.

Version: 1.11.3

Copyright: (C) 1985-2013 by the Massachusetts Institute of Technology and its contributors

OpenlLDAP: a suite of the Lightweight Directory Access Protocol (v3) servers, clients, utilities, and development
tools.

Version: 2.4

Copyright: 1998-2014 The OpenLDAP Foundation

Samba3311: the free SMB and CIFS client and server for UNIX and other operating systems
Version: 3.3.11
Copyright: (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

NTPClient: an NTP (RFC-1305, RFC-4330) client for unix-alike computers
Version: 2007_365
Copyright: 1997, 1999, 2000, 2003, 2006, 2007 Larry Doolittle

exFAT: FUSE-based exFAT implementation
Version: 0.9.8
Copyright: (C) 2010-2012 Andrew Nayenko

ONTFS_3G: The NTFS-3G driver is an open source, freely available read/write NTFS driver for Linux, FreeBSD,
Mac OS X, NetBSD, Solaris and Haiku.

Version: 2009.4.4

Copyright: (C) 1989, 1991 Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA

mysql-5_1 72: a release of MySQL, a dual-license SQL database server
Version: 5.1.72
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Copyright: (c) 2000, 2013, Oracle and/or its affiliates

FreeRadius: a high performance and highly configurable RADIUS server
Version: 2.1.12

Copyright: (C) 1999-2011 The FreeRADIUS server project and contributors

Linux IPv6 Router Advertisement Daemon — radvd

Version: V 1.15

Copyright (c) 1996,1997 by Lars Fenneberg<If@elemental.net>
BSD License: http://www.litech.org/radvd/

WIDE-DHCPv6

Dynamic Host Configuration Protocol for IPv6 (DHCPv6) clients, servers, and relay agents.

Version: 20080615
Copyright (C) 1998-2004 WIDE Project.
BSD License: https://sourceforge.net/projects/wide-dhcpvé/

Python version 2.7.12

This Python distribution contains no GNU General Public Licensed
(GPLed) code so it may be used in proprietary projects just like prior
Python distributions. There are interfaces to some GNU code but these
are entirely optional

OpenPAM Radula

This software was developed for the FreeBSD Project by ThinkSec AS and
Network Associates Laboratories, the Security Research Division of

Network Associates, Inc. under DARPA/SPAWAR contract N66001-01-C-8035
("CBOSS"), as part of the DARPA CHATS research program.

ISC DHCPVersion 4.3.5
Copyright (c) 2004-2016 by Internet Systems Consortium, Inc. ("ISC")
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